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Thank you for purchasing the SF4500 SeriesÑthe multifunction office
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SF4500 Series will provide all you need in one machine.

The SF4500 Series combines these office machines:
- Color inkjet printer
- Scanner
- Plain paper fax
- PC fax
- Copier

Enjoy your new SF4500 Serise !



i

Contents

Set Up Your Machine __________________________________ 1.2
Unpacking ____________________________________________ 1.2
Control Locations and Functions ________________________ 1.3

Front View _________________________________________ 1.3
Rear View _________________________________________ 1.3

Choosing a Location ___________________________________ 1.4
Setting Up Your Machine _______________________________ 1.4
Installing Print Cartridge _______________________________ 1.8

Storing a Print Cartridge in the Storage Unit ____________ 1.10
Loading Paper ________________________________________ 1.11
Running Self Test ______________________________________ 1.12
System Setup _________________________________________ 1.13

Adjusting Ringer Volume _____________________________ 1.13
Setting Home Positions for Resolution and Contrast _____ 1.13

Adjusting Speaker Volume ______________________________ 1.14
Setting Date and Time __________________________________ 1.15
Setting System ID (Your Number and Name) _____________ 1.16

Installing SMART SOFT _______________________________ 1.17
SF4500 Series Printer Driver __________________________ 1.17
SF4500 Series Scanner Driver _________________________ 1.18
Presto! PageManager ________________________________ 1.18
Presto! PhotoAlbum _________________________________ 1.18
SF4500 Series Manager ______________________________ 1.19
SmartFAX RCP Utility _______________________________ 1.19

System Requirement ___________________________________ 1.20
Installation Procedure __________________________________ 1.21

Printer Driver in Windows 95 ________________________ 1.21
Printer Driver in Windows 3.x ________________________ 1.22
Scanner Driver, Manager, SmartFAX, Presto! PageManager, 
Presto! PhotoAlbum _________________________________ 1.24

Uninstalling __________________________________________ 1.25
In Windows 95 _____________________________________ 1.25
In Windows 3.x _____________________________________ 1.25

Chapter 1 Getting Started



ii

Control Panel _________________________________________ 2.2
Number Keypad ______________________________________ 2.4

Letters and Special Characters ________________________ 2.4
Numbers ___________________________________________ 2.6
Editing Numbers or Names ___________________________ 2.6
Inserting a Pause ____________________________________ 2.6

Sending a Fax ________________________________________ 2.7
Preparing Documents for Faxing or Copying ______________ 2.7
Setting Document Resolution and Contrast _______________ 2.8

Resolution __________________________________________ 2.8
Contrast ____________________________________________ 2.8

EXPRESS Mode ________________________________________ 2.9
Carrier Sheet (SF4500C only) ____________________________ 2.9
Loading Document ____________________________________ 2.10
Sending a Fax Automatically ____________________________ 2.11
Sending a Fax After Talking _____________________________ 2.11

Canceling Transmission ______________________________ 2.12
Confirming Transmission _____________________________ 2.12
Automatic Redial ____________________________________ 2.12

Voice Request _________________________________________ 2.13
Sending a Voice Request _____________________________ 2.13
Answering a Voice Request ___________________________ 2.13

Delayed Transmission __________________________________ 2.13
Memory Transmission (Broadcasting) ____________________ 2.15
Priority Transmission __________________________________ 2.16
Polling Transmission ___________________________________ 2.17
What is Polling ________________________________________ 2.17
Being Polled By a Remote Machine ______________________ 2.17
Adding Documents To a Standby Operation ______________ 2.18
Canceling a Standby Operation __________________________ 2.18

1
G

e
ttin

g
 S

ta
rte

d
2

O
p
e
ra

tio
n

3
Tro

u
b
le

s
h

o
o
tin

g
A

p
p
e
n

d
ix

Chapter 2 Operation



iii

Receiving a Fax _______________________________________ 2.19
Receiving Automatically in Fax Mode ____________________ 2.20
Receiving Automatically in Tel/Fax Mode ________________ 2.20
Receiving Automatically in Ans/Fax Mode _______________ 2.21
Receiving Manually in Tel Mode ________________________ 2.21
Receiving Using an Extension Telephone _________________ 2.22
Polling Reception ______________________________________ 2.23

Polling a Remote Machine ____________________________ 2.23
Continuous Polling __________________________________ 2.24

Making a Copy _______________________________________ 2.26

Printing ______________________________________________ 2.27
Printer Settings ________________________________________ 2.28

Accessing Print Settings _____________________________ 2.28
Paper Tab __________________________________________ 2.29
Document/Quality Tab ______________________________ 2.29
Advanced Tab ______________________________________ 2.30
Specifying Your Printing Options _____________________ 2.30

Paper Handling _______________________________________ 2.31
Selecting Paper Types _______________________________ 2.31
Special Paper Guidelines ____________________________ 2.32

Loading Envelopes ____________________________________ 2.33
Printing Speed Versus Color ____________________________ 2.34

Quick Color Printing ________________________________ 2.34
High Quality Color Printing __________________________ 2.35
Monochrome Printing _______________________________ 2.35

Setting Other Utilities Using the SF4500 Series 
Control Program ______________________________________ 2.35

Starting the SF4500 Series Control Program ____________ 2.36
SF4500 Series Control Program Window _______________ 2.37
Status Tab __________________________________________ 2.37
Options Tab ________________________________________ 2.38
Cartridge Tab ______________________________________ 2.38

Chapter 2 Operation  (Continued)



Scanning _____________________________________________ 2.39
Overview _____________________________________________ 2.39
Scanning a Document or Photograph ____________________ 2.40

Automatic Dialing ____________________________________ 2.44
One-Touch Dialing _____________________________________ 2.44

Storing a Number for One-Touch Dialing ______________ 2.44
Dialing a One-Touch Number ________________________ 2.45
Using Address Label ________________________________ 2.45

Speed Dialing _________________________________________ 2.46
Storing a Number for Speed Dialing __________________ 2.46
Dialing a Speed Number _____________________________ 2.46

Group Dialing (for Multi-Address Transmission) __________ 2.47
Storing One-Touch or Speed Dial Numbers for 
Group Dialing ______________________________________ 2.47
Using Group Dialing (Multi-address transmission) ______ 2.48

Searching for a Number in Memory ______________________ 2.48
Searching Sequentially through Memory _______________ 2.48
Searching for a Particular First Letter __________________ 2.49

Other Functions ______________________________________ 2.50
Function Buttons ______________________________________ 2.50

Redial _____________________________________________ 2.50
Tone ______________________________________________ 2.51
Flash ______________________________________________ 2.51
Dual ______________________________________________ 2.51

Printing Reports _______________________________________ 2.52
User Options __________________________________________ 2.53

Setting an Option ___________________________________ 2.53
Selectable Options __________________________________ 2.53

iv



Specifications _________________________________________ 4.2
Index ________________________________________________ 4.6

Troubleshooting ______________________________________ 3.2
Clearing Jams _________________________________________ 3.2

Document Jams While Sending a Fax __________________ 3.2
Paper Jams While the Machine is Printing ______________ 3.3

Error Messages ________________________________________ 3.5
Fixing Problems _______________________________________ 3.7

Fax Problems _______________________________________ 3.7
Print Quality Problems ______________________________ 3.9
Printing Problems ___________________________________ 3.11
Paper Feeding Problems _____________________________ 3.12
Scanning Problems __________________________________ 3.14

Maintenance _________________________________________ 3.16
Clearing Memory ______________________________________ 3.16
Cleaning the Document Scanner _________________________ 3.17
Print Cartridge Maintenance ____________________________ 3.19
Print Cartridge Nozzle Test _____________________________ 3.19

Wiping the Print Cartridge Nozzles and Contacts _______ 3.21
Cleaning Cartridge Carrier Contacts and Deflector ______ 3.22

Replacing the Print Cartridge ___________________________ 3.24
Cartridge Alignment ___________________________________ 3.27

Chapter 3 Troubleshooting

Appendix

v



Getting Started
1

1.1



1.2 Set Up Your Machine

Machine
Handset Carrier Sheet

(SF4500C only)
Handset Cradle

Document Exit Tray
Print cartridge (black, color)
* Color: SF4500C only

¥Smart Soft CD-ROM
¥WinFax LITE diskettes

01 02 03 04 05

06 07 08 09 10

11 12 13 14 15

16 17 18 19 20

One-Touch Label

AC power cord

Telephone line cord

¥Setup and Operation UserÕs Guide
¥Presto! PageManager/MyScan/Presto!

PhotoAlbum/SmartFAX UserÕs Guide
¥WinFax LITE UserÕs Guide

Unpacking

Set Up Your
Machine

If you are experiencing problems with the software contained on this CD-ROM, or if you donÕt have a
CD-ROM drive and require the software on 3.5Ó diskette, please call service.

The shape of power and telephone line cord plugs may differ, depending on your country.



1.3Set Up Your Machine

Locations and Functions

Take a moment to familiarize yourself with the main components and
understand their functions.

Front View

Rear View

Document Tray

Document Guide

Paper Extension

Control Panel
Paper Bin

Document Exit Tray
Cartridge Storage Unit

Handset Cradle

PC Connector 

000000000000000000000000000000000000000000000000000000000
00000

0000
00

AC Power
Socket

EXT Jack

LINE Jack

Print Cartridge

Your machine may look slightly different from the illustration.

Handset 
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1.4 Set Up Your Machine

Choosing a Location

To help guarantee trouble-free operation of your machine, place it on a flat,
stable surface near your workstation. Leave enough space to allow for easy
paper loading, paper exit and opening the front cover.

Do not place your machine:

- In direct sunlight.
- Near heat sources or air conditioners.
- In dusty or dirty environments.

Setting Up Your Machine

Handset and Handset Cradle
1.  Plug one end of the coiled cord into the jack on the handset.

2.  Plug the cradleÕs modular cords into the modular jacks on the left side
of your machine.

Attach the handset cradle to the main body. Insert the two tabs of the
cradle into the slots on the left side of the main body as shown, and
push it up.

Cradle Handset 

White cord

Route the excess cord so that it could be inserted into the cradle.



1.5Set Up Your Machine

Document Tray
3.  Pull the document tray upward. Fold out the extender on the document

tray, if necessary.

Document Exit Tray
4.  Insert the two tabs on the document exit tray into the slots on the front

of your machine. Fold out the extender, if necessary.

If you want to remove the handset, slide it down, then take it out.

¥ Without handset, the machine does not ring when a call comes in, so you
cannot receive a fax.

Document exit tray Extender
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1.6 Set Up Your Machine

Connection Diagram

000000000000000000000000000000000000000000000000000000000
00000

0000
00

Extension phone

Phone line cord

Parallel printer cable

AC power cord 

PC

Telephone Line
5. Plug one end of the telephone line cord into the LINE jack and the

other end into a standard phone wall jack.

00000000
0000

0000
00

00000
00000

Extension Phone
6. If you want to use a regular phone or answering machine with your

SF4500 Series machine, connect the phone into the EXT jack.

Plug the cord of your extension phone or answering machine into the
socket marked EXT on the left side of the machine. 

00000000
0000

0000
00

00000
00000



1.7Set Up Your Machine

Printer Cable
7.  Connect a bidirectional parallel printer cable to the 36 pin printer jack

on your machine. Fasten the metal clips to the parallel cable.

It is recommended to use the parallel cable that supports IEEE-1284
bidirectional communications. 

8.  Connect the other end of the parallel cable to your computer.

00000000
0000

0000
00

00000
00000

Printer cable

PC

AC Power Cord
9. Plug one end of the cord into the back of the machine and the other

end into a standard, grounded 3-pin AC socket (220~240V, 60Hz). 

The machine turns on. All lamps on the control panel light up and the
display shows ÔPOWER INITIAL !! PLEASE WAITÕ. If there is no cartrige
installed, or no paper, the display shows ÔNO CARTRIDGEÕ or ÔNO
PAPERÕ.

If you want to turn the machine off, unplug the power cord.

00000000
0000

0000
00

00000
00000
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1.8 Set Up Your Machine

Installing Print Cartridge

When the machine is powered up without the print cartridge installed, the
display shows ÔNO CARTRIDGE Õ.

1. Press the Cartridge button to move the cartridge carrier to the install
position.

2. Lift the control panel ➀ with your hand and open the cartridge
compartment cover ➁.

Control panel

Cartridge
compartment cover

➀

➁

3.  Remove the new print cartridge from its packaging. Hold the print
cartridge by the black areas or colored top only. Do not touch the
copper area.

Carefully remove the tape covering the printhead. Be sure to remove all
the tape.

4.  Insert the print cartridge into the carrier.

copper area



1.9Set Up Your Machine

5.  Push the cartridge firmly in the direction of the arrow until it clicks
into place.

6.  After installing the print cartridge, close the cover and replace the
control panel.

7. The display shows ÔTHE CARTRIDGE IS  1.NEW 2.USEDÕ. Choose
ÔNEWÕ by pressing the 1 button, or by using the Ã or ¨ button, and
pressing Enter.

The display shows briefly ÔMONO INSTALLEDÕ.

If you install an optional color cartridge to print a file from your PC, it is
recommended to use ÔInstall CartridgeÕ tab in the SF4500 Series Control
Program on your PC instead of the Cartridge button on the control panel.
To start SF4500 Series Control Program, See page 2.36.
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1.10 Set Up Your Machine

Storing a Print Cartridge in the Storage Unit

The print cartridge storage unit provides a convenient place to store an
extra black or color (option) print cartridge, and prevents an opened
cartridge from drying out.

To store a print cartridge in the storage unit : 

Insert the print cartridge into the storage unit, and slightly push it down.

When switching between the color and black print cartridges, keep the
unused one in the print cartridge storage unit. The storage unit prevents
the print cartridge from drying out while providing easy access to it.

To remove a print cartridge from the storage unit : 

Push the cartridge slightly down and pull it outward.

Storage unit

Cartridge



1.11Set Up Your Machine

2.   Fan and insert the paper, with the print side facing you.

3.  Squeeze the left paper guide and move it to the right, to match the
width of the paper.

Loading Paper

The display shows ÔNO PAPERÕ when paper is not loaded. You can load
approximately 130 sheets of paper.

1.  Pull the paper extension on the paper bin all the way up.

Paper extension

Paper Guide
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1.12 Set Up Your Machine

Running Self Test

Each time you install a new print cartridge, run the self test to check if the
printer mechanism is functioning properly. 

1. Press Menu, then press Self Test on the One-Touch keypad. The
machine prints out a test pattern.

2. Examine the test pattern and look for a break in the diagonal line.

A broken line shows any clogged nozzles. Run the nozzle test.
See page 3.19.

If the diagonal lines are not broken, and the black (or color) bars are clear,
the printer mechanism is functioning properly. See the sample pattern
below. 

Sample Test Pattern

Black cartridge

Color cartridge



1.13Set Up Your Machine

System Setup 

In this mode, you can adjust the ringer volume, and set the home position
of the contrast and resolution. 

Adjusting Ringer Volume 

You can adjust the volume of the ringer to the desired volume:

1. Press Menu, then press System Setup on the One-Touch keypad. The
display shows ÔRINGER VOLUME.?Õ 

2. Press Enter, then use   or ¹ to choose the desired volume of the
ringer.

The ringer sounds and the display shows the selected volume: HIGH;
MED; LOW; OFF.

Choosing OFF turns the ringer off. The machine will work normally even
if the ringer is set to off.

3. Press Enter when the desired volume level is selected. The display
shows the next setup menu ÔHOME SETTING ?.Õ For details on ÔHome
SettingÕ menu, see below:

4. To return to Standby Mode, press Stop. 

Setting Home Positions for Resolution and Contrast 

The contrast and resolution lamps on the control panel can be set to their
most frequently used positions. Whenever a document is loaded in your
machine, the home contrast and resolution lamps will turn on. Contrast and
resolution can be changed for individual operations by pressing the
Contrast and Resolution buttons until the desired mode lamp is lit. 

1. Press Menu, then press System Setup on the One-Touch keypad. The
display shows ÔRINGER VOLUME.?Õ 

2. Press   or ¹ until you find ÔHOME SETTING?Õ.  

RINGER VOLUME
LEVEL [ LOW ]
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1.14 Set Up Your Machine

3.  Press Enter. The display asks you to choose the resolution or contrast.

4. Press 1 to choose ÔRESOLUTION.Õ 2 for ÔCONTRASTÕ. You can also
choose the mode by pressing   or ¹ and Enter. The display shows the
current mode.

5. Press Ã or ¨ repeatedly until you find the desired mode.

HOME RESOLUTION
¥STANDARD Ð use with most documents.
¥FINE Ð default resolution settings and should be used for documents

with fine detail, or small print.
¥SUPER FINE Ð originals with extremely fine detail.

HOME CONTRAST
¥NORMAL Ð use with documents of average or normal contrast.
¥DARKEN Ð use with documents with low contrast or light images.
¥LIGHTEN Ð use with documents with high contrast or dark images.
¥PHOTO Ð for obtaining maximum image quality with documents that

contain pictures or photographs with shades of grey.

6. Press Enter. The display asks you to choose RESOLUTION or
CONTRAST.

7. If necessary, repeats steps 4 and 5. To return to Standby Mode
press Stop.

Adjusting Speaker Volume 

1. Press OHD to adjust the speaker volume. If you cannot hear dial tone,
check the phone line connection.

2. Press  or ¹ repeatedly until you find the desired loudness. The
display shows the current volume level.

3. After choosing the desired volume level, press OHD.

1.RESOLUTION
2.CONTRAST



1.15Set Up Your Machine

Setting the Date and Time

The current date and time are shown in the display when the machine is on
and ready for use (Standby Mode). The date and time are printed on all
faxes you send.

1. Press Menu, then press Date & Time on the One-Touch keypad. The
display asks you to choose a date format. 

2. Choose the desired date format by pressing 1 for EUROPE, or 2 for USA.
You can also choose the format by pressing Ã or ¨, then Enter. 

If you select USA, the date format will be displayed as MMDDYY. The
EUROPE. will be displayed as DDMMYY. 

The display shows the current set date and time. 

3. Change the date and time by pressing Ã or ¨ to move the blinking
cursor under the number you want to change, and enter the correct
number using the number keypad. 

DD (Day) = 01~31
MM (Month) = 01~12
YY (Year) = two digits 
HH (Hour) = 00~23
MM (Minute) = 00~59

4. When the date and time are correct, press Enter. 

If you enter an invalid number, the machine beeps and doesnÕt proceed
to the next step. If this happens, just reenter the correct number. 

The display shows the date and time you have set, then returns to
Standby Mode. 

SET DATE FORMAT
1.EUROPE  2.USA

DD-MM-YY HH:MM
12-05-98 10:30
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1.16 Set Up Your Machine

Setting the System ID 
(Your Number and Name)

The System ID will be printed at the top of each page sent from your
machine. 

1. Press Menu, then press System ID on the One-Touch keypad. The
display asks you to enter the telephone number. 

If there is a number previously registered, the number appears. 

2. Enter the telephone number (up to 20 digits) to which your machine is
connected. You can enter alphanumeric characters using the number
keypad, and include special symbols such as +, -, by pressing 0
repeatedly.

For details on how to use the number keypad to enter a number or letter,
see page 2.4.

If you want to enter the same number or letter in succession (e.g. 55, 777,
AA), press one digit, then move the cursor by pressing ¨, and enter the
next digit.

If you make a mistake, press Ã or ¨ to move the cursor under the
wrong digit. Then enter the correct number to change or press Delete to
delete the number.

To insert a space, you can also use ¨ to move the cursor to skip the
position.

3. Press Enter when the number in the display is correct. The display then
asks you to enter your ID (name). 

4. Enter your ID name (up to 40 characters) as described above to enter a
number, then press Enter. 



1.17Installing Smart Soft

Installing SMARTSOFT

You must install the SMARTSOFT CD-ROM for PC printing, PC faxing, and
PC scanning. Smart Soft includes the following drivers:

¥ Printer Driver

¥ Scanner Driver

¥ Presto! PageManager

¥ Presto! PhotoAlbum

¥ Fax Driver

¥ Fax RCP Driver

For details on the drivers, refer to each driverÕs description.

Installing 
SMARTSOFT

If you are experiencing problems with the software contained on this CD-ROM,
or if you donÕt have a CD-ROM drive and require the software on 3.5Ó diskette,
please call service.



1.18 Installing Smart Soft

Printer Driver

Before you can use any printer with your computer, you must install a
printer driver. The printer driver tells the computer what kind of a printer
you are using, and also controls the various settings, such as print quality
and paper type. You define these settings within the printer driver, which
then communicates the settings to both the computer and the printer.

To use the machine as your printer, you must install the Printer Driver in
your computer. After installing the printer driver, make sure the SF4500
Series is selected as the default printer to use the machine as your printer.

Scanner Driver

Scanner driver allows you to scan images from any graphics or OCR
(Optical Character Recognition) applications program that supports the
TWAIN standard (e.g. Presto! PageManager, Adobe Photoshop). To use
your machine as your scanner, you must install the Scanner Driver in your
computer.

For information on how to use scan options, refer to SF4500 Series
application manual.  

Presto! PageManager

With Presto! PageManager, you can easily scan documents and photographs
into your computer and maintain them as electronic documents. You can
also use Presto! PageManager to quickly transmit scanned documents by fax
or electronic mail, or to print a copy on your printer.

To use Presto! PageManager as your scanning application, you must install
the Presto! PageManager in your computer. For information on how to use
Presto! PageManager, refer to SF4500 Series application manual.

Presto! PhotoAlbum

Presto! PhotoAlbum helps you create personalized photo albums that
organize and preserve your photos forever... electronically. Add your
favorite photos from digital cameras, scanners or the internet. Decorate
them with frames, shadows, ornaments, captions and background textures.
Photos can be shared with family and friends via the internet, create
desktop wallpaper or slide shows. 

If you want to use Presto! PhotoAlbum, you must install the Presto!
PhotoAlbum in your computer. For information on how to use Presto!
PhotoAlbum, refer to SF4500 Series application manual.
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It is recommended not to set automatic receiving mode through a PC-FAX
application like WinFax LITE, because it occupies the LPT port all the time
and you cannot use your machine for printing, scanning, or any other job.
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Fax Driver

The SF4500 Series Manager allows you to use a Class-2 compatible PC-FAX
application such as WinFax LITE 4.0. The SF4500 Series Manager is a
Windows program which runs in the background all the time. You can
open the SF4500 Series Manager display by clicking on itÕs icon in the
Control Panel menu. You can also terminate the Manager at any time, if
necessary.

When you exit the SF4500 Series Manager, it will offer you two options.
One option is to terminate the SF4500 Series Manager, and the other option
is to keep the Manager running in the background. If you decide to
terminate the Manager, all current and future SF4500 Series usage will be
terminated until you restart the SF4500 Series Manager or restart Windows.
You can also restart the SF4500 Series Manager from the Control Panel
menu at any time.

For information on how to use SF4500 Series Manager, refer to your
WinFAX LITE manual. 

You can change SF4500 Series Manager COM port, which should match the
COM port used by PC-FAX application. Its default COM port is COM3.

Fax RCP Driver

If you install the Fax RCP Driver, you can use SmartFAX utility that enables
you to set up phonebook numbers and download them into the SF4500
Series machine. This utility also allows you to use fax operation on
SmartFAX window on your computer screen.

For information on how to use SmartFAX, refer to SF4500 Serise application
manual.
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System Requirement

Before you start, make sure you have the following minimum computer
setup:

Printer Driver

¥ IBM or compatible, with 486SX 33MHz or higher processor
¥ Free disk space of at least 3Mb
¥ 8Mb or higher RAM
¥ Windows 3.x; Windows 95
¥ CD-ROM drive

Scanner Driver

¥ IBM or compatible, with 486SX 33MHz or higher processor
¥ Free disk space of at least 3Mb
¥ 8Mb or higher RAM
¥ Windows 3.x; Windows 95 
¥ CD-ROM drive

Presto! PageManager

¥ IBM or compatible, with 486SX 33MHz or higher processor
¥ Free disk space of at least 8Mb (Windows 3.x) or 20Mb (Windows 95)
¥ 8Mb or higher RAM
¥ Windows 3.x; Windows 95
¥ CD-ROM drive

Presto! PhotoAlbum

¥ IBM or compatible, with 486SX 33MHz or higher processor
¥ Free disk space of at least 95Mb
¥ 8Mb or higher RAM
¥ Windows 95
¥ CD-ROM drive

Fax Driver

¥ IBM or compatible, with 486SX 33MHz or higher processor
¥ Free disk space of at least 4Mb
¥ 8Mb or higher RAM
¥ Windows 3.x; Windows 95
¥ CD-ROM drive

Fax RCP Driver

¥ IBM or compatible, with 486SX 33MHz or higher processor
¥ Free disk space of at least 1Mb
¥ 8Mb or higher RAM
¥ Windows 3.x; Windows 95
¥ CD-ROM drive
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Installation Procedure

Before you start, make sure your computer meets or exceeds the system
requirement for the driver and application program you want to install.

Printer Driver in Windows 95

1. Make sure the machine is plugged in and connected to your computer.
Turn on your machine and the computer.

2. Start Windows. You see a screen similar to this:

3. Insert SmartSoft CD-ROM into your CD-ROM drive.

4. Make sure Driver from disk provided by hardware manufacturer is
selected, and click OK. You see this screen:

5. In the commend line, type d:\Uniutil\Prtdrv (if you are using CD-ROM
drive D) or e:\Uniutil\prtdrv (if you are using CD-ROM drive E), then
click OK. The Add Printer Wizard dialog appears.
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1.22 Installing Smart Soft

6. To use your machine as the default printer, select Yes, and click Finish.
The setup file is copied into your computer.

7. When installation is complete, the Install New Cartridge dialog box
appears. Make sure that cartridge is installed, then Click Cartridge
Installed.

8. Follow the instructions on the screen.

If Windows 95 does not recognize the printer:
1. Insert the Smartsoft CD-ROM into the CD-ROM drive.

2.Select Printers in Settings under Start menu. The Print window
appears.

3. Double click Add Printer. The Add Printer Wizard dialog box appears.

4. Click OK. Follow the instructions on the screen.

Printer Driver in Windows 3.x

1. Make sure the machine is plugged in and connected to your computer.
Turn on your machine and the computer.

2. Start your Windows.

3. Insert the Smart Soft CD-ROM into your CD-ROM drive.

4. From the Program Manager, select Run from the File menu. The Run
dialog box appears.



1.23Installing Smart Soft

5. Type d:(or e:)\start on the command line, then click OK. The CD-ROM
starts and the initial screen appears.

6. From the SF4500 Series install screen, select Printer Driver. The
Continue dialog box appears.

7. Click Yes and follow the instructions on the screen.
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1.24 Installing Smart Soft

Scanner Driver, Fax Driver, Fax RCP Driver, Presto!
PageManager, Presto! PhotoAlbum 

1. Lets begin from the SMARTSOFT CD-ROM initial screen.

If not turned on, start Windows and insert the Smart Soft CD-ROM.
Windows 95 users will see the initial screen.

Windows 3.x users should select Run from the File menu under the
Program Manager. When the Run dialog box appears, type d:(or
e:)\start on the command line, then click OK. The CD-ROM starts and
the initial screen appears.

2. From the initial screen, select the desired driver or application. 

3. The selected software install dialog box appears. Click Start and follow
the instructions on the screen.

Presto! PhotoAlbum

Presto! PageManager
SF4500 Series Manager

SF4500 Series Scanner Driver
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Uninstalling

Uninstall is only required if you are upgrading from an older SF4500 Series
software, or if your installation fails.

In Windows 95

1. Start Windows if not already started.

2. Click the Start button and choose Programs.

3. Choose the driver or application you want to remove (SAMSUNG
SF4500 Series Printer, SAMSUNG SF4500 Series Scanner, SAMSUNG
SF4500 Series Manager, SmartFAX, Presto! PageManager, or Presto!
PhotoAlbum).

4. Choose Uninstall. The Uninstall dialog box appears. Follow the
instructions on the screen to complete uninstallation.

In Windows 3.x

1. Start Windows if not already started.

2. From the Program Manager, double click the driver or application icon
you want to remove (SAMSUNG SF4500 Series Printer, SAMSUNG
SF4500 Series Scanner, SAMSUNG SF4500 Series Manager, SmartFAX,
Presto! PageManager, or Presto! PhotoAlbum).

3. In the selected software windows, double click the Uninstall icon. The
selected software Uninstall dialog box appears.

4. Follow the instructions on the screen to complete uninstallation.
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Operation
2

2.1



2.2

01

System Data System ID Date & Time System Setup Memory Clear

02 03 04 05

06 07 08 09 10

Delay TX Memory TX Priority TX Polling

11 12 13 14 15

Add/Cancel Group Dial Self Test Journal Help List

16 17 18 19 20

TX Confirm Schedule Job Phone Book System List

Volume

Search/
Delete

Cartridge
Form Feed

AlarmBusy

Menu

S

C

S
En

Busy Lamp
Flickers while receiving print data

from the computer or uploading
scanned data to the computer.  

Alarm Lamp
Lights when something is wrong. 

Cartridge
Use when replace the print cartridge.

The button permits you to position the
print cartridge carrier so that you may

easily remove or replace the print
cartridge. 

Form Feed
Eject paper from the printer if the

paper is not fed out after printing is
completed. Also, use to load paper in

place when the paper has run out
while PC printing. 

Search/Delete
Search for numbers in memory (for

details, see page 2.48). Or use to delete
digits in the edit mode. 

One-Touch Dial and 
Special Function Buttons

Call most frequently used numbers
with one button (See page 2.44 for

information on how to store numbers).
Also, use these buttons with the Menu

button to set up special functions or
print lists. 

LCD Display
The display shows the current status of
your machine and guides you through
various tasks using a menu system for

each operation.

  and ¹ (Volume)
Display the next or last menu item. Also, use

to adjust speaker volume.  

Menu
Choose special functions.  

Ã and ¨
Move cursor left or right 

through the display. 

Control Panel



2.3

Rcv. Mode

Fax

Tel/Fax
Ans/Fax

Fine
Express
S.Fine

Darken

Lighten
Photo

Resolution
Contrast

ABC DEF

JKLGHI MNO

TUV

 Speed

PQRS WXYZ

Redial/Pause

OHD/V.Req.

Flash/Dual

0

87 9

54 6

21 3

Stop¥

Copy¥

¥
Start/
Enter

Stop
Stop an operation at any time. 

Copy
Copy a document.

Start/Enter
Start a job. Also use to activate the selection shown in
the display. 

Rcv.Mode (Receive Mode) and Lamps
Choose the receive mode you want to
use. See page 2.19. The lamps will light
to show which setting you have chosen.
When both lamps light, you are in
Ans/Fax mode. When no lamps are
showing, you are in Tel mode. 

Resolution Button and Lamps
Choose the resolution.  
Fine is preset at factory.
See page 2.8. The lamps will light to
show which setting you have chosen.
When both lamps light, you are in
EXPRESS mode. 

Contrast Button and Lamps
Choose the contrast when sending or
copying documents. See page 2.8. The
lamps will light to show which setting
you have chosen. When both lamps
light, you are in Photo mode. 

EXPRESS
Use to quick scan documents to copy or send. See page 2.9.

Redial/Pause
Redial any one of the last 10 phone numbers called. See page 2.50. You can also
use it to add a pause when storing a number in memory. See page 2.6.

Flash/Dual
Use to transfer a call in a PABX (Private Automatic Branch Exchange).
Also use to switch the LCD while performing dual jobs. See page 2.51.

OHD (On-Hook Dial) and V.Req. (Voice Request)
Dial numbers without picking up the handset. Also use it 
to make a voice call after sending or receiving a fax. See page 2.13.

Number Keypad
Use to dial numbers manually or to
enter letters. See page 2.4.

Speed
Dial calls and send fax documents by
entering a 2-digit number. See page 2.46 for
information on how to store numbers.
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2.4

Using the Number Keypad

As you perform various tasks, you will need to enter names and numbers.
For example, when you set up your machine you enter your name (or your
companyÕs name) and telephone number. When you use the One-Touch
dial or Speed Dial, you enter names and telephone numbers.

When the display asks you to enter a name, the LCD reads:

You can then use the procedures described below to enter up to 20 letters
and special characters, numerals, or spaces.

Entering Letters and Special Characters

You can include special characters (space, plus sign, etc.) in the name by using
the zero key. See `KEYPAD CHARACTER ASSIGNMENTSÕ on page 2.5.

1. Locate the button labeled with the letter you want Ð then press the
button repeatedly until the correct letter appears in the display. 

For example, to enter an O, press 6 (labeled MNO). Each time you press
6, the display shows a different letter Ð first M, then N, and O, and
finally 6. 

The letter appears in the display. 

NAME:_

NAME:O

ABC DEF

JKLGHI MNO

TUVPQRS WXYZ

Redial/Pause

OHD/V.Req.

Flash/Dual

0

87 9

54 6

21 3

Speed



2.5

2. When the letter you want appears in the display, press another number
key labeled with the next letter you want. 

If the next letter is printed on the same number button, move the cursor
by pressing ¨, then press the button. 

The blinking cursor moves right and the next letter appears in the
display. 

3. Select additional letters in the same way. When youÕre finished
entering letters, press Enter. 

KEYPAD CHARACTER ASSIGNMENTS 

NAME:OP

Key

1

2

3

4

5

6

7

8

9

0

Space 1

A B C 2

D E F 3

G    H I 4

J K L 5

M N    O 6

P Q    R S 7

T U V 8

W X Y Z 9

+ - , . Ô / #    & 0 

Assigned numbers, letters, or characters
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2.6

Entering Numbers

You can enter the number of the remote fax machine manually by using the
number keypad. The number you press appears in the display.

When the display asks you to enter a number, you can also use a One-Touch
dial button (including Group dial) and 2-digit Speed Dial number. To enter
a Speed number, press Speed, the 2-digit Speed Dial number, then Enter.

Your machine lets you send the same document to more than one location.
When you enter a fax number, the display reads ÔANOTHER FAX NO?Õ. To
enter another fax number, enter the number manually, or use One-Touch or
2-digit Speed Dial number. Note that you can not use a Group dial button
for ANOTHER FAX NO.

Editing Numbers or Names

If you make a mistake while entering a number or name, move the cursor
under the wrong digit by using Ã or ¨. Then press the correct number to
change, or press Delete to delete the number.

Inserting a Pause

With some private telephone systems, you must dial an access code (9, for
example) and listen for a second dial tone before dialing an outside
number. Insert a pause in a number when you are setting up a One-Touch
or Speed Dial number, or when you dial a number without lifting the
handset.

To insert a pause, press Pause while entering the number.

When you dial a number, the dialing process pauses for a few seconds at the
point where you pressed Pause.

If you require a longer pause time, press Pause twice.

TEL:95551212_



2.7Sending a Fax

Sending a Fax

Preparing Documents for Faxing or Copying

You can use the machine to fax or copy documents that are printed on
standard letter, legal, or A4 size paper. Follow these guidelines to prepare
your documents:

¥ Do not attempt to feed the following types of documents into the
machine. Instead, make copies and insert the copies into the document
tray.

- wrinkled or creased paper
- curled or rolled paper
- torn paper
- carbon-paper or carbon-backed paper
- coated paper
- onion skin or thin paper

¥ Remove all staples, paper clips, and the like before feeding the document.

¥ Make sure any glue, ink, or correction fluid on the paper is completely
dry before feeding the document.

¥ Do not feed documents with pages that are of different sizes or thicknesses.
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2.8 Sending a Fax

Setting Document Resolution and Contrast 

We recommend sending documents printed using a typewriter, felt tip pen,
black ink, or laserwriter. The paper should be white or very light, and of
normal weight - not cardboard. Blue lines on a ruled pad donÕt fax well. 

When you send normal documents, you need not adjust the resolution and
the contrast.

If you send documents with unusual contrast characteristics, including
photographs, you can adjust the resolution and contrast to send a high-
quality transmission of the documents. 

Resolution

Press the Resolution button to increase sharpness and clarity. Resolution
is preset to Fine at factory, but if you press the Resolution button
repeatedly after loading a document you can switch between Standard,
Fine, and Super Fine modes. 

Fine is good for documents containing small characters or thin lines, or
print from a dot-matrix printer. When Fine is selected, the Fine lamp lights.

Super Fine works well for documents containing extremely fine detail.
When Super Fine is selected, the S.Fine lamp lights. Super Fine works only
if the remote machine also has the Super Fine feature. 

Contrast

Press the Contrast button to compensate for the brightness or darkness
of your faxed document. By pressing the Contrast button repeatedly after
loading a document, you can choose between Normal, Darken, Lighten, or
Photo. 

Darken works with light print or faint pencil markings. When Darken is
selected, the Darken lamp lights.

Lighten works with dark print on a dark background. When Lighten is
selected, the Lighten lamp lights. 

Photo is used when faxing photographs or other documents containing
color or shades of grey. Although your machine wonÕt transmit color, it will
print and send up to 256 shades of grey. When Photo is selected, both
Darken and Lighten lamps light.  

You can set the resolution and contrast home position. The lamp of the
selected mode will light when a document is loaded. For details on how to
set the home position for resolution and contrast, see page 1.13.



2.9Sending a Fax

EXPRESS Mode 

If you want to copy or send a document quickly, you can activate EXPRESS
mode. In EXPRESS mode, it quickly scans the document to be sent or
copied.

Press the EXPRESS button after loading documents. Fine and S.Fine
resolution lamps light to indicate the EXPRESS mode.

If EXPRESS mode is activated, Fine or S.Fine resolution mode will be
disabled. The maximum scan length is limited to A4 size. 2
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Using Carrier Sheet (SF4500C only)

You may want to use the carrier sheet provided to protect fragile or
damaged original documents or photos for faxing and scanning.

1. Insert the document.

2. Insert the carrier sheet facing down into the document tray until it is
gripped by the machine.



2.10 Sending a Fax

Loading Document 

1. Turn the page face down. 

2. Adjust the document guides to match the width of the document. 

3. Slide the sheet down into the document tray, until itÕs gripped by the
machine. 

The automatic document feeder seizes and pulls in the page. The display
shows ÔDOCUMENT READYÕ.

You can insert up to 30 sheets at a time. If you insert more than one sheet,
make sure the bottom sheet enters first. Stagger the leading edges of the
sheets slightly, and insert the sheets with a slight push to ensure smooth
feeding. 

To add pages while the fax is sending, insert them into the loading slot
on top of the already loaded sheets. 

If youÕre loading pages that are unusually thick or thin, feed one sheet at
a time.

4. The resolution and contrast lamps are lit up according to the home
position mode. For information on how to set the home position for
resolution and contrast, see page 1.13.

If necessary, use the Resolution and Contrast button: See page 2.8.

5. If you want to activate EXPRESS mode to scan quickly, press
EXPRESS. Fine or S.Fine resolution mode will be disabled.

document guide



2.11Sending a Fax

Sending a Fax Automatically

1. After loading a document, enter the number of the remote fax machine
using the number keypad. 

You can store One-Touch or Speed Dial numbers so that you can dial your
most frequently used numbers with one touch of a button or a 2-digit
Speed Dial number. For information on storing and using numbers in
memory, see page 2.44.

If you make a mistake while entering a number, move the cursor under
the wrong digit by using Ã or ¨, and correct the number, or press
Delete.

2. Press Start when the number appears correctly in the display. The
machine dials the number and begins to transmit.

Sending a Fax After Talking 

1. After loading a document, pick up the handset or, press OHD for hands-
off operation. The displays shows ÔPHONE.Õ 

2. Using the number keypad, enter the number of the remote fax
machine. The display shows the number you are dialing. 

3. Press Start when you hear a fax tone. The machine begins to transmit.

4. Replace the handset.
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2.12 Sending a Fax

Canceling Transmission

Press Stop any time during transmission.

Confirming Transmission  

When the last page of your document has been sent successfully, the
machine beeps and returns to Standby Mode. 

If something went wrong during your fax transmission, an error message
appears in the display. For a listing of error messages and their meanings,
see page 3.5. 

If you receive an error message, press Stop to clear the message and try to
send the document again. 

You can set your machine to print out a confirmation report automatically
each time sending is completed. 
For more information, see `User OptionsÕ on 2.53.  

Automatic Redial

When you send a fax, if the number you have dialed is busy or there is no
answer, the machine hangs up, waits for the specified retry term and redials
the number. If, after the specified number of retry attempts (retry count),
the machine fails to connect, the machine returns to Standby Mode. 

While the machine is redialing, the display shows ÔRETRY REDIAL?.Õ If you
want to redial the number immediately, press Start. To stop redialing, press
Stop. 

You can select the number of retries and the retry time between each redial
attempt. See ÔUser OptionsÕ on page 2.53.



2.13Sending a Fax

Voice Request

If youÕre sending or receiving a document and need to speak to the other
person during the same phone call, use Voice Request to alert the person at
the remote site. You can also respond to a Voice Request made by the
person at the remote end. 

Sending a Voice Request

1. Press V.Req while a document is being sent or received. Voice Request
signal is stored and then sent to the remote fax machine after the
document has been sent or received. 

2. When the phone rings, pick up the handset and answer it. 

You can cancel a Voice Request  by pressing V.Req again while you are
sending or receiving a document. 

Answering a Voice Request

When the phone rings after sending or receiving a fax, pick up the
handset and answer it. 

If you donÕt answer the Voice Request, the machine prints out the number
that made the Voice Request, and the time and date the request was made.

Delayed Transmission

You can set your machine to send a fax at a later time when you will not be
present. A maximum of 10 transmission jobs can be reserved in your
machine.

1. Load the document face down. If necessary, use Resolution, Contrast,
or EXPRESS button. For details, see page 2.8.

2. Press Menu, then press Delay TX on the One-Touch keypad.

3. Enter the number of the remote machine, then press Enter. 

To enter the number, you can also press a One-Touch button, including a
Group dial button. Otherwise, press Speed, enter a 2-digit Speed Dial
number, then press Enter. The stored number (and name) appears in the
display. Press Enter to confirm the number.
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2.14 Sending a Fax

4. The display asks you to enter another fax number, to send the document
to another location. 

5. If you want to send to more than one location, press 1 and enter
another fax number using the number keypad, One-Touch dial, or 2-
digit Speed Dial number. Note that you cannot use a Group dial number
for ANOTHER FAX NO.

OR

To send to one location or when you complete the last fax number
setting, press 2.

6. The display asks you to enter a name. If you want to assign a name to
the transmission, enter the name. If not, skip over this step.

For details on how to enter letters using the number keypad, see page 2.4. 

7. Press Enter. The display shows the current time on the upper line and
asks you to enter the time in the bottom line when the fax is to be sent. 

8. Enter the time by using the number keypad, then press Enter.

Enter the time in 24-hour format. For example, enter 2230 for 10:30 P.M. If
you set a time earlier than the current time, the document will be sent at
that time on the following day. 

9. The machine returns to Standby mode and the display shows a reminder
that a Delayed Transmission is set. 

If you want to cancel the Delayed Transmission, see ÔCanceling a Standby
OperationÕ on page 2.18.

ANOTHER FAX NO.?
1.YES  2.NO

CURRENT [12:30]
START [12:30]
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Memory Transmission (Broadcasting)

With Memory Transmission, documents are automatically stored in
memory and sent to a remote station. Use this feature to send your
documents to multiple locations. After sending, the documents are
automatically erased from memory. 

1. Load the document face down. If necessary, use Resolution, Contrast,
or the EXPRESS button. For details, see page 2.8.

2. Press Menu, then Memory TX on the One-Touch keypad.

3. Enter the number of the remote machine, then press Enter.

To enter the number, you can also press a One-Touch button, including a
group dial button. Otherwise, press Speed, enter a 2-digit Speed Dial
number, then press Enter. The stored number (and name) appears in the
display. Press Enter to confirm the number.

4. The display asks you to enter another fax number to send the document
to another location.

5. If you want to send to more than one location, press 1 and enter
another fax number using the number keypad, One-Touch dial, or 2-
digit Speed Dial number. Note that you cannot use a Group dial number
for ANOTHER FAX NO.

OR

To send to one location, or when you complete the last fax number
setting, press 2.

6. The document will be scanned into memory before transmission. The
display shows the memory capacity and the number of pages, then the
machine begins sending the document.

ANOTHER FAX NO.?
1.YES  2.NO
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2.16 Sending a Fax

Priority Transmission

When priority transmission is enabled, a high priority document can be
transmitted ahead of reserved operations. The document is scanned into
memory, then transmitted when the current operation concludes. In
addition, a priority transmission will interrupt a broadcast operation
between stations (i.e., when transmission to station A ends, before
transmission to station B begins) or between redial attempts.

1. Load the document face down. If necessary, use Resolution, Contrast,
or the EXPRESS button. For details, see page 2.8.

2. Press Menu, then Priority TX on the One-Touch keypad. 

3. Enter the number of the remote machine, then press Enter. 

To enter the number you can also press a One-Touch button. Otherwise,
press Speed, enter a 2-digit Speed Dial number, then press Enter. The
stored number (and name) appears in the display. Press Enter to confirm
the number. Note that you can not use a Group dial button.

4. The display asks you to enter a name. If you want to assign a name to
the transmission, enter the name. If not, skip this step.

For details on how to enter letters using the number keypad.
see page 2.4.

5. Press Enter. The display shows the number being dialed, 2nd the
machine begins sending the document.



2.17Sending a Fax

Polling Transmission

What is Polling?

Polling is used when one fax machine requests another to send a document.
This is useful when the person with the original document to be sent is not
in the office. The person who wants to receive the document calls the
machine holding the original and requests that the document be sent. In
other words, it ÒpollsÓ the machine holding the original. 

Being Polled By a Remote Machine 

You can program your fax machine to send documents in your absence
when polled by a remote fax machine. It is possible to use a Poll Code to
prevent unauthorized polling of your fax machine. When you secure your
machine in this manner, only those who know the Poll Code can poll your
machine.

1. Load the document face down. If necessary, use Resolution, Contrast,
or the EXPRESS button. For details, see page 2.8.

2. Press Menu, then Polling on the One-Touch keypad.  The display asks
you to choose the polling options; TX (Transmission Polling) and CONT
(Continuous Polling).

3. Press Enter to confirm Ô1.TX.Õ The display asks you to enter a 4-digit Poll
Code. The Poll Code is preset to 0000 at the factory, which represents no
Poll Code. 

4. If you want to use a Poll Code, enter the desired 4-digit code (except
for 0000), then press Enter.
Or
If you do not want to secure the transmission with a Poll Code, press
Enter when the display shows 0000 for TX-POLL CODE.

5. The machine stores the document in memory. The display counts the
number of pages being stored in memory and the memory capacity
remaining. 

The machine returns to Standby Mode and the display shows a reminder
that a Polling Transmission is set. The machine automatically switches to
Fax mode (automatic receiving) when set to be polled. 

SELECT POLLING
1.TX  2.CONT.

POLL CODE
[0000]
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Adding Documents To a Standby Operation

You can add documents to a Delayed or Polling Transmission previously
reserved in your machineÕs memory.

1. Load the document face down. If necessary, use Resolution, Contrast,
or the EXPRESS button. For details, see page 2.8.

2. Press Menu, then Add/Cancel on the One-Touch keypad. The display
asks you to select ÔADDÕ or ÔCANCELÕ.

3. Press Enter to confirm ÔADDÕ. The display shows operations currently
reserved in memory.

4. Press   or ¹ repeatedly until you find the operation to which you
want to add documents, then press Enter.

The machine automatically stores the documents in memory, and
displays the number of total pages and added pages, then returns to
Standby Mode. 

2.18 Sending a Fax

OPERATION
1.ADD 2.CANCEL

22:00 DELAY TX
SAMSUNG

(e.g. Delay transmission is
scheduled to be sent at 10:00 PM.)

Canceling a Standby Operation

1. Press Menu, then Add/Cancel on the One-Touch keypad. The display
asks you to select ÔADDÕ or ÔCANCELÕ.

2. Press 2 to choose ÔCANCELÕ. The display shows the operations currently
reserved in memory.

3. Press   or ¹ repeatedly until you find the operation you want to
cancel, then press Enter when you find the operation.



2.19Receiving a Fax

Receiving a Fax 

Your multi-function machine has four reception modes:

¥ In Fax mode, the machine answers an incoming call and immediately
goes into receive mode, waiting for a fax to be sent. 

¥ In Tel/Fax mode, the machine answers an incoming call expecting to
receive a fax. If the machine does not sense a fax signal, it will continue to
sound the ringing tone to tell you it is a phone call. If you do not lift the
handset during the ringing, the machine will switch to automatic fax
reception mode. 

¥ In Ans/Fax mode, the answering machine answers an incoming call, and
the caller can leave a message on the answering machine. If the fax
machine senses a fax tone on the line, the call automatically switches over
to the fax machine. To use Ans/Fax mode, you should attach an
answering machine (TAD) to the EXT socket on your fax machine (see
page 1.6). 

¥ In Tel mode, automatic fax reception is turned off. You can receive a fax
only by manually picking up the handset and pressing Start. 

The lamps located above the Rcv. Mode button indicate the selected
reception mode. 

If you seldom use the fax line for voice conversations, set the fax machine
to receive a fax automatically by selecting either Fax or Tel/Fax mode. 

¥ While you print a PC file, an incoming fax will be received and stored
in memory. If you have a lot of pages to print, we recommend stopping
PC printing to prevent memory from becoming full. 

Receiving a Fax
2
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2.20 Receiving a Fax

Receiving Automatically in Fax Mode 

1. Press Rcv.Mode until the Fax lamp lights.

2. When you get a call, the machine answers the call on the second ring
and receives a fax automatically. You can change the number of rings.
See ÔANSWER ON RINGÕ on page 2.56.

To adjust the Ringer Volume, press Menu, System Setup on the One-
Touch keypad, Start to access Ringer Volume mode, then use ¹ or  to
choose the desired loudness.

Receiving Automatically in Tel/Fax Mode 

1. Press Rcv.Mode until the Tel/Fax lamp lights.

2. When you get a call, the machine answers the call on the second ring.
You can change the number of rings. See page 2.56.

3. If a fax is being sent, the machine goes into receives a fax automatically.
If the machine does not sense a fax signal, it will give another ringing
tone to tell you it is a phone call.

4. Lift the handset to answer the call. If you do not pick up the handset
within a specified time, the machine will switch back to automatic fax
reception mode. 



2.21

¥If you have set your machine to Ans/Fax and your answering machine is
switched off, or no answering machine is connected to your fax machine, your
machine will automatically go into fax receive mode after several rings. 

¥If your answering machine has a Ôuser-selectable ring counterÕ, set the
machine to answer incoming calls within 1 ring. 

¥If you are in Tel mode (manual reception) when the answering machine is
connected to your machine, you must switch off the answering machine, or
the outgoing message from the answering machine will interrupt your phone
conversation. 

Receiving a Fax

Receiving Manually in Tel Mode 

1. Press Rcv.Mode until both Fax and Tel/Fax lamps are off.

2. When the telephone rings, pick up the handset and answer it.

3. If you hear a fax tone, or if the person on the other end asks you to
receive a document, press Start. 

4. Replace the handset. The machine begins receiving and returns to
Standby Mode when reception is complete. 

Receiving Automatically in Ans/Fax Mode

To use this mode, you must attach an answering machine (TAD) to the EXT
jack on your fax machine (see page 1.6). 

1. Press Rcv.Mode until both Fax and Tel/Fax lamps light. 

2. When you get a call, the answering machine answers it. If the caller
leaves a message, the answering machine stores the message normally. 

If your machine hears a fax tone on the line, fax receive mode is
activated.
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Receiving Using an Extension Telephone 

This feature is available only when you use an extension telephone
connected to the EXT jack on the back of the machine. See page 1.6. You can
receive a fax from someone you are talking to on the extension telephone
without having to go to the fax machine. 

1. If you receive a call on the extension phone and hear fax tones, press
the buttons Ô     9     Õ (star-nine-star) on the extension telephone. 

Press the buttons slowly in sequence. If you still hear the fax tone from
the remote machine, try pressing Ô      9      Ô again. 

Ô      9      Ô is the remote receive start code preset at the factory. The first
and the last asterisks are fixed, but you can change the middle character
to whatever you choose. For more information, see page 2.54. 

2. The machine receives the document. Replace the handset of the
extension telephone.

2.22 Receiving a Fax

If Your Machine Is Out of Paper When it Receives a Fax - Receiving
into Memory

If your machine is set to receive a fax automatically and the recording
paper has run out, a paper jam has occurred, the top cover has been
opened, or you are making a copy or printing, the incoming documents are
automatically stored in the fax machineÕs memory. After receiving
documents, the machine displays ÔMEMORY RECEIVEDÕ and the cause,
ÔNO PAPERÕ, for example.

You must clear the problem by loading new paper, closing the cover, or
clearing the jam. Your machine will then automatically print the fax stored
in memory.

If you clear the problem while the machine is receiving documents into
memory, it will print the stored document immediately.
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Polling Reception

Your machine has the capability to Poll for documents which may be stored
in a remote fax machine. Polling reception allows the machine to call a
remote fax machine that is set up for polling, and retrieve documents from
it. You may want to talk with the remote operator to make sure the remote
fax machine is prepared to be polled before performing this procedure.

Polling a Remote Machine

Your machine polls a remote fax machine and retrieves a document, which
it stores in memory and then prints. This method lets you perform polling
reception when telephone-line rates are at their lowest.

1. Lift the handset or press OHD, and enter the number of the remote
machine.

2. When you hear a fax tone from the remote machine, press Menu, then
press Polling on the One-Touch keypad.

The display asks you to enter a 4-digit Poll Code. Poll Code is preset to
0000 at factory. 0000 represents no code.

3. If the remote machine is secured with a Poll Code, you must enter the
correct code, then press Enter.

OR

If the remote machine is not secured with a Poll Code, just press Enter
to accept [0000], which represents no code.

Your machine starts to receive the document from the remote machine.

POLL CODE
[0000]
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Continuous Polling

You can set your fax machine to automatically poll one or more unattended
remote fax machines daily, as many times a day as you like, at regular
intervals.

1. Press Menu, then Polling on the One-Touch keypad. The display shows
the polling options; TX (Transmission Polling) and CONT (Continuous
Polling).

2. Press 2 to choose ÔCONT.Õ. You can also press Ã or ¨ to choose, then
press Enter. 

3. Enter the number of the remote fax machine, then press Enter.

You can press a One-Touch button, including a Group dial button.
Otherwise, press Speed, enter a 2-digit Speed Dial number, then Enter.
The stored number (and name) appears in the display. You can use only
one Group number for the polling job. Press Enter when the number
appears correctly in the display.

4. The display asks you to enter another fax number to receive documents
from another location. 

To poll more than one location, press 1 to choose ÔYESÕ and repeat steps
3-4.

OR

To poll one location, or when you enter all locations, press 2. 

5. The display asks you to enter a 4-digit code. Poll code Ô0000Õ represents
no code.

2.24 Receiving a Fax

ANOTHER FAX NO.?
1.YES   2.NO

POLL CODE
[0000]

SELECT POLLING
1.TX  2.CONT.
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If the remote machine is secured with a Poll Code, you must enter the
correct code, and press Enter. 

OR

If the remote machine is not secured with a Poll Code, press Enter to
accept [0000] which represents no code.

6. The display asks you to enter the START and END times. Enter the time
your machine starts and ends polling everyday. Enter the time in 24-
hour format. For example, enter 2030 for 8:30 PM. 

Your machine will poll the remote machine(s) regularly, between the start
and end times, at the interval you specified in step 8. 

7. Press Enter when the time appears correctly in the display. The display
asks you to enter the length of time to wait before attempting the next
polling. 

8. Enter the time interval, then press Enter. For example, to set your
machine to poll the remote machine at 30-minute intervals, enter 0030. 

9. The machine returns to Standby Mode and the display shows a reminder
that Continuous Polling is set.

After Continuous Polling ends, a multi-communication report will be
printed to show the result, if you had enabled this feature in ÔUser
Options.Õ See page 2.53.

[START   [END]
20:30   23:30

→

→

INTERVAL TIME
[00:30]
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2.26 Making a Copy

Making a Copy

Making a Copy 

The resolution is automatically set to ÔS.FineÕ when copying begins. If you
want to make a copy quickly with normal resolution, you can use the
EXPRESS button. You can reduce or expand the image size by 1%
increments from 25% to 200%.

1. Load a document with the print side facing down. If necessary, use the
Contrast button to change the contrast. For details on Contrast, see page
2.8.

2. If you want to make a copy quickly with normal resolution, press
EXPRESS. Both FINE and S.FINE lamps light.

3. Press Copy. The display asks you to enter the number of copies (1 to 99). 

4. If you need two or more copies, enter the desired number using the
dial keypad, then press Enter. The display shows the next option: copy
rate menu.

5. The number in the right corner of the bottom line shows the status you
choose. To reduce or expand the size of the document, enter the desired
copy rate, then press Enter. The machine scans the document into
memory, and printing will begin.

¥ If you turn the ÔDIRECT COPYÕ feature on (see page 2.54), the machine
makes only a single copy at 1:1 copy rate. The ÔCOPY PAGESÕ and ÔCOPY
RATEÕ options will not appear.

¥ If you activate EXPRESS mode, The ÔCOPY RATEÕ option will not appear.

COPY  PAGES
[01-99]  <01>

COPY RATE
[25-200]% <100>
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Printing a Document

This procedure describes the general steps required for printing from
various Windows applications. The exact steps for printing a document
may vary depending on the application program you are using. Refer to
your software applicationÕs documentation for the exact printing
procedure.

1. Start a program and create a document, or open a document you want
to print.

2. Choose Print or Print Setup from the File menu. Make sure the SF4500
Series printer is selected as your default printer.

3. Click on the Properties or Setup button if you want to make any
adjustments that are appropriate for printing your document.
(See ÔPrinter SettingsÕ on page 2.28.)

4. Select OK to close the Properties dialogue box.

5. After making any necessary changes to the printing parameters, select
OK to start the print job.

Printing
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Printer Settings

You can use your machine with all your Windows 3.x or Windows 95
applications. Be sure to set the SF4500 Series as the default printer for all
your Windows operations.

Most Windows software applications allow you to make changes to the
printer settings. This includes settings that determine how a print job looks,
such as page size, paper orientation, and margins. Settings changed in the
software application will usually override settings made in the printer
driver.

The printer driver includes many of the settings mentioned above (in case
your software application does not include them). It also includes all
settings that determine how your printer will operate.

Accessing Print Settings

In Windows 95

¥ From any Windows application, you can select the Print or Print Setup
command.

¥ From the Printers folder, select the printer and then select the Properties
command from the File menu.

¥ From the Printers folder, select the printer, click the right mouse button,
and then select Properties from the drop-down list.

In Windows 3.x

Access the printing options from the Printers dialogue box in the Control
Panel, or select the Print Setup option available from the File menu of
most applications that run under Windows.
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Selects the paper
size loaded.

Paper Tab

This tab allows you to specify paper size, number of copies, page collation,
sequence of the pages, and page orientation.

Document/Quality Tab

This tab allows you to specify the document type, paper type, and print
quality. For more information on paper types, refer to ÔSelecting Paper
TypesÕ on page 2.31

Selects the document type to use:
Automatic

Prints using currently installed
cartridge.

Vivid Color
Produces enhanced color printing.

Natural Color
Produces photo-realistic natural color
printing.

Black Only
Optimizes B&W  printing.

Color Sort
Sorts color and B&W pages, then
prints either one according to the
type of cartridge installed, and prints
the other after you change the
cartridge.

Restores factory default
settings.

Click to activate a delay
between pages to allow inks
to dry.

For details on paper types,
see page 2.31.

Displays the copyright and
version information.
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2.30 Printing

Advanced Tab

This tab allows you to specify the halftone type, and adjust the image
brightness, shadow, and color.

Selects the style of halftoning to use.

Line Art Screen
Generally the best choice for
printed text or pen-and- ink
drawings.

Fine Screen
Produces fine quality printing.

Air Brush
Produces air brush image printing.

What is Halftone?
Gray-scale objects (such as
photographs) whose gray dots have
been converted to a pattern of
groups of black dots. These groups,
which are of various sizes, along
with the white dots (pixels turned
off), create the illusion of gray
shadings: larger groups make the
image appear black or dark gray,
while smaller groups make the
image appear light gray.

Specifying Your Printing Options

Be sure to use on-line help to find out about the settings available for each
printing option.

¥ To move between the Windows tabs, click on any of the tabs.

¥ To select the settings and exit, click the OK button.

¥ To cancel your setting selection on a tab, click the Cancel button.

¥ To access the Help file, click the Help button.

¥ When you move the mouse cursor over one of the printing options, a
help message appears below the mouse pointer.
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Paper Handling

One of the most important things you can do to assure the best possible
printing performance of your machine is to select the correct paper. Your
machine produces letter quality print on most plain bond papers, including
cotton bond and photocopying papers; it does not require special ink jet
papers. However, the print quality varies with different paper types. Be
sure to test a type of paper before you purchase a large quantity.

Selecting Paper Types

Plain Paper
The machine supports paper sizes of letter, legal, and A4 in portrait
orientation. You can use regular copier paper, cotton bond papers, and
typical letterhead. Always use paper without curls, folds, staples, or
damaged edges.

Coated Paper
Coated paper has been developed for high quality printing with minimal or
no smearing or running when placed in contact with water or damp
surfaces, making it a good choice for damp or rainy environments.

Glossy/Photo Paper
Glossy/photo paper is a high gloss, thicker paper that produces the look
and feel of a photograph. Use this paper to produce photo-realistic prints
from your printer.

Transparency
The transparencies produce excellent contrast, sharpness, and color.

Iron-on Transfer
Use T-shirt transfers to create and personalize T-shirts, sweatshirts, aprons,
tablecloths, napkins, tote bags, and anything else your imagination allows!
Use on any cotton or cotton/poly blend fabric. The image is printed in
mirror image, so when you iron it onto the T-shirt, the image is viewed
correctly.
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Special Paper Guidelines

¥ Be sure to read any instructions that come with special paper. These
instructions provide important information regarding how to achieve the
highest print quality.

¥ It is recommended to feed one sheet at a time for special paper types,
especially for T-shirt transfer.

¥ For transparency film and glossy photo paper, follow these guidelines:

- Let the printed sheets of film or paper dry completely before storing
them.

- When a sheet of film has dried completely, cover its printed side with a
sheet of plain (not coated) paper before storing it; this is recommended
even if you place the sheets of film in a clear file or plastic holder.

- Do not leave the film in the paper tray for long periods of time. Dust
and dirt may accumulate on the film, resulting in spotty printing.

- To avoid smudging caused by fingerprints, use a pair of thin cotton
gloves while loading and handling the film.

- To avoid fading, do not expose the printed film to prolonged direct
sunlight.

- Store unused papers and films flat. Do not remove papers from their
protective packaging until ready to use them.

- Store unused film at temperatures between 59OF to 86OF (15OC to 30OC).
The relative humidity should be between 10% and 70%.

¥ If the print density of your page is very high, light paper stock may curl
slightly due to the large amount of ink. If you need to print dense
graphics, try printing on heavier stock.

¥ Do not use paper that is thicker than the specifications for this machine.
Printing with a paper that is thick enough to come in contact with the
print head nozzles may damage the cartridge.
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Loading Envelopes

To print on envelopes, use the envelope guide when loading envelopes in
the paper bin.

The following envelopes are not recommended because they may cause
jams, smears, or may damage your printer:

¥ Envelopes with windows, holes, perforations, cutouts, and double flaps.

¥ Envelopes made with special coated or deeply embossed paper.

¥ Envelopes using peel-off sealing strips.

¥ Envelopes in which letters have been enclosed.

When you are ready to print on an envelope, follow these steps:

1. Turn the envelope guide upright.

Envelope Guide

2. Load the envelope with the address side facing you, and the stamp
edge down and to the far right ①. Then push it slightly down ②. The
right edge of the envelope must align with the raised edge of the
envelope guide.

①
②
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Printing Speed Versus Color

The SF4500 Series Printer Driver for Windows can interpret and translate
the full spectrum of colors, up to 16.7 million. When printing in color, there
is a significant increase in the amount of information that the driver has to
interpret and translate. When printing black ink only, the driver has only
one color to interpret.

By decreasing the amount of colors that the printer driver has to interpret,
you can significantly decrease the time needed to translate the information.
This will speed up the overall printing process.

Your machine supplies a monochrome cartridge as a standard. For color
printing, you must purchase an optional color cartridge.

Quick Color Printing

In the SF4500 Series Printer Driver for Windows, choose the following
options to allow the printer driver to interpret and translate 256 colors,
which will increase your printing speed. However, your print quality will
not be optimized.

¥ Paper Type - Plain Paper
¥ Print Quality - Fast Draft

2.34 Printing

3. Squeeze the left paper guide and move it to the right to match the
width of the envelope.

Paper guide

You must change the Paper Size in the Print Settings menu. 
See page 2.29.
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High Quality Color Printing

Select the print options shown below to allow the printer driver to interpret
and translate up to 16.7 million colors. Keep in mind that your print speed
will be slower than with other setting combinations.

¥ Paper Type - Glossy/Photo Paper
¥ Print Quality - High

Monochrome Printing

Use the black cartridge to optimize the printerÕs performance when you are
printing black text and graphics only.

In the printer driver, choose the following print options to tell your
machine to print using black ink only:

¥ Paper Type - Plain Paper
¥ Print Quality - Normal
¥ Document Type - Black Only

Setting Other Utilities Using the SF4500 Series
Control Program

The SF4500 Series Control Program contains setup options that define the
operation of your machine.

It includes:

¥ Status - Displays the current status

¥ Options - Sets up options

¥ Cartridge - Installs, cleans, or aligns the cartridge

¥ About - Displays the program version
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2.36 Printing

Starting the SF4500 Series Control Program

In Windows 95

1. Click the Start button and choose Programs.

2. Choose SAMSUNG SF4500 Series Printer from the Programs menu.

3. Choose Control Program on LPT1.

4. The SF4500 Series Control Program on LPT1 window appears.

3. The SF4500 Series Control Program on LPT1 window appears.

In Windows 3.x

1. From the Program Manager, double click the SAMSUNG SF4500
Series Printer icon.

2. In the SAMSUNG SF4500 Series Printer window, double click Control
Program on LPT1.
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SF4500 Series Control Program Window

When the SF4500 Series Control Program on LPT1 window appears, click
the appropriate tab for the options you want to display. On the appropriate
tab, specify your changes.

Status
Displays the printer status

and the ink level

Options
Controls program options

Cartridges
Installs or cleans the
cartridge

About
Displays information on
the program version

Status Tab

This tab shows the current printer status.
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2.38 Printing

Options Tab

This tab allows you to specify the control program setup options.

Displays the status monitor
as a button (Windows 95) or
icon (Windows 3.x) on the
Windows desktop.

Disables bidirectional
communication. (Check this
box for network printer)

Closes the status monitor
automatically at the end of job

Enables sound effects

Enables buffer mode

Cartridge Tab

This tab allows you to choose cartridge options.

To maintain the best possible print quality, you need to clean the cartridge
print head from time to time. Your machine is equipped with a print head
cleaning function. If you notice some degradation in the print quality, click
the Clean Print Nozzles tab to perform the print nozzle cleaning. Repeat
cleaning if necessary.

Displays the ink level
Use to install or replace the

cartridge

Allows you to clean the print
nozzles

Aligns the cartridge
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Scanning

Overview

The Presto! PageManager Scanning Operating System eliminates the need for
maintaining paper copies of photographs and documents. With Presto!
PageManager, you can easily scan documents and photographs into your
computer and maintain them as electronic documents. You can also use
Presto! PageManager to quickly transmit scanned documents by fax or
electronic mail, or to print a copy on your printer.

Before scanning documents or photographs, make sure that the Presto!
PageManager software and the image scan program MyScan, provided with
your SF4500 Series machine, have been installed in your computer. See
page 1.23.

This section gives a basic description of scanning using MyScan, the SF4500
Series Scanner Driver, and Presto! PageManager, the scanning application
program supplied with your machine.

Your SF4500 series provide a monochrome (black and white) scanner
function and a color scanner function respectively.
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2.40 Scanning

Scanning a Document or Photograph

1. Turn on your machine (or other scanner) and PC.

2. Start Windows if not already started.

3. Start Presto! PageManager. For Windows 95, select Programs from the
Start menu. Then select Presto! PageManager.

For Windows 3.x, double-click the Presto! PageManager from the
Program Manager. Then select Presto! PageManager.

Then Presto! PageManager -DeskTop window will appear.

4. Place the scan document in your machine. Place it top edge down, with
the printed side facing away from you. You want to use the carrier sheet
provided to protect fragile or damaged original documents or photos for
scanning. See page 2.9.

Adjust the guide to match the
width of the document.
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Resolution
Determine the amount of
information the scanner will
capture in a resulting scanned
image.

5. Choose Select Source from the File menu (from the Scan menu for
Windows 3.X). The Select Source dialogue box will appear.

6. From the Select Source dialogue box, click on the latest version of
MyScan from the Source dialogue box. (If you wish to use another scan
driver, select the appropriate driver.)

7. Select Acquire in the File menu. The MyScan window will then appear.

8. Choose the scan options for your document in the MyScan window.
For details on scan options, refer to the Scanner Control Window section
under MyScan in the UserÕs Guide for Presto! PageManager/MyScan/
Presto! PhotoAlbum.

Scan Mode
Select the mode that the image is
to be scanned in: True Color RGB*,
256 Color*, Gray 256 Scales,
Halftone B/W, Lineart B/W.Scaling Factor

Enlarge or reduce an image as it
is scanned.

Descreen
Minimize the appearance of
unsightly interference patterns
which may occur in your image
file when scanning graphic
images.

Filter
Soften or sharpen edges and
boundaries of an image.

Highlight, Shadow, Gamma Adjustment
Adjust the light and dark values within
the selection frame.

*These modes are available
on SF4500C only.

Scan Source
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2.42 Scanning

9. If you wish, select the Preview button to make a low-resolution scan of
the original document in the Preview window. You can use the tools in
the Preview window to enhance the image. For details on the Preview
Window, refer to the Preview Window section under MyScan in the UserÕs
Guide for Presto! PageManager/MyScan/Presto! PhotoAlbum/SmartFAX.

10. To start scan, click the Scan button. 

11. To close the MyScan window, click the Exit button. 

12. When the item has been completely scanned, it appears as the currently
selected thumbnail image in the Presto! PageManager Inbox folder.

Application bar
Quick access to

applications by using
drag-and-drop.

Image Enhancement Tools
Adjust the highlight, shadow, and
gamma setting.

Frame Tool
Defines the boundaries of
the area to be included in
your final scan.

Zoom Tool
Zoom in or out on an
image.

Highlight and Shadow Tools
Make comparisons with
different areas of the image.

Flip/Rotate
Flips and rotates an image.

Invert
Inverts all the tone values so that
each color in the original is
exchanged with its color
complement.
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13. To print the scanned image, drag it to the printer icon on the
application bar. Or, click the printer icon after choosing the desired
item.

14. The Print dialogue box will appear. Select the appropriate options.

15. After choosing options, click OK button. Presto! PageManager will send
the file to your printer. 

For information on how to use the Presto! PageManager, refer to the
UserÕs Guide for Presto! PageManager/MyScan/Presto!
PhotoAlbum/SmartFAX.
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2.44 Automatic Dialing

One-Touch Dialing 

One-Touch dialing lets you use any one of the 20 One-Touch buttons
located on the left side of the machineÕs control panel to automatically dial
a telephone or fax number. 

Storing a Number for One-Touch Dialing

1. Press and hold the One-Touch button (01 through 20) which you want
to assign for 2 seconds. The display shows `Txx:Õ, where `xxÕ is the
selected One-Touch button.

2. Enter the number you want to store by using the number keypad, then
press Enter. 

To insert a pause between numbers, press Redial/Pause; a ÔPÕ appears in
the display.

If you make a mistake while entering a number, use Ã or ¨ to move the
cursor under the wrong digit, then enter the correct digit, or press
Delete.

For your convenience, you can store frequently used telephone numbers in
the machineÕs memory.

Automatic
Dialing
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4. The display asks you to enter a name. Enter the desired name (up to 20
digits). For information on how to enter names, see page 2.4.

OR

If you donÕt want to assign a name, skip this step.

If you assign a name to the number, the name appears in the display
when you press the One-Touch button. 

5. Press Enter.

6. To set another One-Touch number, press the desired button and repeat
steps 2 through 5.

OR

To return to Standby Mode, press Stop.

Dialing a One-Touch Number 

1. Press the One-Touch button (01 through 20) at which you stored a
number. The number will be automatically dialed.

2. If you are making a phone call, pick up the handset when the other
person answers. 

OR

If a document is loaded in the document tray, the document begins to
transmit after the remote fax machine answers the phone.

Using Address Label

A One-Touch label sheet is included with your machine. As you store
numbers in One-Touch dial buttons, make a note of the numbers on the
label.

1. Remove the clear cover and
label using an instrument with
a pointed end, as shown at
right. 

2. Write information on the label
and replace the label and cover. 

You may want to use pencil in
case you wish to change these
numbers later.
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Speed Dialing

You can store up to 50 telephone or fax numbers in 2-digit Speed Dial
locations (01-50). 

Storing a Number for Speed Dialing

1. Press and hold Speed for 2 seconds. 

2. Enter a 2-digit location number (01 through 50) at which you want to
store a telephone or fax number, then press Enter.

If a number is already stored in the location you chose, the display shows
the number in the upper line and `1. RENEW 2. OTHERÕ in the bottom
line. Press 1 to renew the location and continue storing the desired
number, or 2 to start over with another Speed Dial button.

3. Enter the number you want to store, then press Enter.

4. To assign a name to the number, enter the desired name. For
information on how to enter names, see page 2.4.

OR

If you donÕt want to assign a name, skip this step. 

5. Press Enter. 

6. To store more telephone numbers, repeat steps 2 through 5. 

OR

To return to Standby, press Stop. 

Dialing a Speed Number 

1. Press Speed, then enter a 2-digit Speed Dial location number. 

2. Press Start, and the number will be automatically dialed.

3. If you are making a phone call, pick up the handset when the other
person answers.

OR

If a document is loaded in the document tray, the document begins to
be transmitted when the remote fax machine answers the phone.
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Group Dialing (for Multi-Address Transmission)

Numerous One-Touch and Speed Dial numbers can be registered as a
Group. By using the Group number, you can send a document to multiple
parties in a single operation. Your machine will dial the remote numbers in
stored sequence. If the number is busy, your machine will dial the next
stored number and after dialing all of the stored numbers, will
automatically redial any number previously busy. Before you can use this
feature, you must coordinate and store the Group numbers desired. 

Storing One-Touch or Speed Dial Numbers for Group
Dialing

1. Press Menu, then press Group Dial on the One-Touch keypad. 

2. Press the One-Touch button you want to use for group dial.

GROUP NO : TO1
1.YES  2.NO

Selected one-touch group button

3. Press Enter to confirm Ô1.YES.Õ The display asks you to press a One-
Touch button or enter the Speed Dial number you wish to include in the
group.

4. Press a One-Touch button to which the fax number you wish to include
in the Group is stored.

OR

Press Speed, enter a 2-digit Speed Dial location to which the fax
number you wish to include in the group is stored.

5. Press Enter. Repeat steps 4 and 5 to enter more destination numbers into
the selected group. 

6. Press Stop when you have entered all the desired destinations. The
display asks you to enter a name.

7. To assign a name to the Group, enter the desired name.

OR

If you donÕt want to assign a name, skip this procedure. 

8. Press Enter. If you want to store another Group dial number, repeat
steps 2 through 7.

OR

To return to Standby Mode, press Stop.
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Using Group Dialing (Multi-address transmission)

You can use Group Dialing for Memory Transmission, Delayed
Transmission, or Continuous Polling. 

Follow the procedure of the desired operation (Memory Transmission - 
p. 2.15; Delayed Transmission - p. 2.13; Continuous Polling - p. 2.24). When
you come to a step in which the display requests you to enter  the remote
fax number, press the One-Touch button to which you stored the Group
number. You can use only one Group number in one operation. Then
continue the procedure to complete the desired operation. 

Your machine automatically scans the document loaded in the document
tray into memory, and will dial each of the numbers included in the Group. 

Searching for a Number in Memory 
(Directory Dialing)

There are two ways to search for a number in memory. You can either scan
from A to Z sequentially, or you can search using the first letter of the name
associated with the number. 

Searching Sequentially through Memory

1. Press Search, then  or ¹ to move downward or upward through the
directory until you find the number you want. 

Pressing   allows you to search downward through the entire memory
in alphabetical order (from A to Z), and ¹ allows you to search upward
in reverse alphabetical order (from Z to A).

Each time you press   or ¹, the display shows the next number stored
in memory. 

While searching through the machineÕs memory, youÕll see that each
entry is preceded by one of three letters: ÔTÕ for One-Touch dial, ÔSÕ for
Speed, or ÔGÕ for Group dial number. These letters tell you where the
number is stored. 

2. When the number you want appears in the display, press Start to dial. 

If a document is loaded, the document begins to transmit when the
remote fax machine answers the phone. Otherwise, your machine makes
a phone call.
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2.49Automatic Dialing

Searching for a Particular First Letter

1. Press Search, then press the button labeled with the letter you want to
search for. A name beginning with the letter appears in the display.

For example, if you want to find the name ÔMOBILE,Õ press the Ô6Õ
button, which is labeled with ÔMNO.Õ

2. Press   to display the next name in the list, or ¹ to display the
previous name. 

3. When the name and number you want appear, press Start to dial. 



2.50 Other Features

Other Functions

Function Buttons

Redial 

TO REDIAL THE NUMBER LAST CALLED

Press Redial. If a document is loaded in the document tray, the machine
automatically redials.

TO SEARCH THROUGH REDIAL MEMORY

1. Press and hold Redial for 2 seconds. The Redial memory in your
machine retains the last 10 numbers called. If you have dialed the same
number multiple times, the machine does not count the duplicates. 

2. Press   or ¹ to search through memory until you find the number you
want.

3. When the number you want appears in the display, press Start to dial.
The machine automatically redials.
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Tone 

You may often need to use Touch-Tone dial signals to perform special
operations by phone. Bank-by-phone and voice mail are two examples of
systems that require these signals. If you have pulse service, you can still
send Touch-Tone signals by following these steps.

1. Dial the number using pulse dialing. 

2. When the remote phone answers, press . Any numbers you now
press will be sent as Touch tones for the remainder of the call. 

3. Dial the remaining numbers required by the service. The machine
returns to the pulse mode after you finish the call. 

Flash  

When a call comes in and you want to connect the caller to another party,
you can transfer the call by pressing Flash and dialing the number of that
other party. This may not be compatible with some phone systems. Contact
your phone supplier.

1. When you are on the phone and want the caller to be connected to
another party, press Flash.

2. Enter the number of the other party.

If you do not have a special service that uses the switch-hook signal, donÕt
press Flash during a call. If you do, you could disconnect the line.

Dual

Your machine can perform more than one of its many functions at the same
time. For example, you can simultaneously:

¥ Print a PC document while sending a fax.
¥ Receive a fax into memory while making a copy.
¥ Print an incoming fax document while scanning a document to the PC.
¥ Receive a fax into memory while printing a PC document.
¥ Store a fax document for later transmission while printing an incoming

fax.

When the machine performs dual tasks, Press Dual to toggle the display
between the current operation and new operation.
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Printing Reports

Your fax machine can print reports containing useful information -
Schedule Job, System Data, etc. The following reports are available: 

Help List
This list shows the machineÕs basic functions and commands to use as a
quick reference guide. 

Message Confirmation Report
This report shows the fax number, the number of pages, elapsed time of the
operation, the communication mode, and the communication results.

You can set up your machine to print the message confirmation report 
(see page 2.54):

¥ Automatically after each transmission [ON]
¥ Automatically only if an error occurs during transmission [ERR]
¥ No report printed at all [OFF]. You can print this report manually at any

time you want.

Schedule Information List
This list shows the document currently stored for delayed transmission ,
priority transmission, memory transmission, continuous polling, and TX
polling. The list shows the starting time, type of operation, etc. 

Telephone Numbers List 
This list shows all of the numbers currently stored in the fax machineÕs
memory as One-Touch Dial numbers, Speed Dial numbers, and Group Dial
numbers. 

System Data List
This list shows the status of the user-selectable options. After you change
any setting, print this list to confirm your changes. 

Transmission or Reception Journal
This report shows information concerning transmission or reception
activities. It can be printed on command, or if the machine is set to do so
(see page 2.54), it will automatically print after every 40 transmissions or
receptions. 

Multi-Communication Report 
This report is printed automatically after sending to or receiving from more
than one location. 

Call Back Message 
This report is printed out automatically when you do not respond to a
remote operatorÕs Voice Request.

Power Failure Report 
This report is printed out automatically when power is restored after a
power failure. This report shows data (if any) erased by the power failure. 
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TO PRINT LIST

1. Press Menu. 

2. Press the desired list button on the One-Touch keypad. 

On the One-Touch keypad, press Journal for transmission or reception
journal, Help List for Help list, TX Confirm for message confirmation
report, Schedule Job for schedule information list, Phone Book for
telephone numbers list, System List for system data list.

The selected list will print out.

User Options  

Your fax machine has various user-selectable features. These options are
preset at the factory, but you may need to change them. To find out how the
options are currently set, print the System Data List. For more information
on printing the list, see page 2.52. 

Setting an Option

1. Press Menu, then press System Data on the One-Touch keypad. The
display shows the first option menu. 

2. Scroll through the options by pressing   or ¹ repeatedly.

3. When the option you want appears in the display, enter the number for
the desired status. Or, You can use Ã or ¨ button to select the desired
status, then press Enter after choosing.

You can exit from Setup Mode at any time by pressing Stop. When you
press Stop, the machine stores the options youÕve already changed and
returns to Standby mode. 

Selectable Options   

These instructions assume youÕve followed the steps above under ÔSetting
an OptionÕ and the machine is prompting you to change one of the options
listed here. 

¥ FAX PAPER SIZEÑSelect the paper size you will use for the recording
paper. 

Press 1 for letter (LTR), 2 for A4 size, or 3 for (LGL) size paper. 
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¥ MESSAGE CONFIRM.ÑA message confirmation report shows whether the
transmission was successful or not, how many pages were sent, etc. 

Press 1 to print a confirmation report automatically each time you send a fax
(ON). 
Press 2 to turn this feature off (OFF).
Press 3 to print only when an error occurs and the transmission was not
successful (ERR). 

If you selected ON or ERROR in the previous message confirm. option, you
will be guided to its sub-option.

TCR shows the first page you sent, along with the Message Confirmation Report.
If you want to print TCR, press 1. If you do not want TCR, press 2.

¥ AUTO JOURNALÑA journal shows specific information concerning
transmission or reception activities, the time and dates of up to 40 of the most
recent transmissions or receptions.

Press 1 (ON) to print journal automatically after every 40 transmissions or
receptions.
Press 2 (OFF) to print journal manually.

¥ REMOTE RCV CODEÑThe Remote Receive Code allows you to initiate fax
receive from an extension phone plugged into the EXT jack. If you pick up the
extension phone and hear fax tones, enter the Remote Receive Code and the
fax will start receiving. The password is preset to 9 at factory. 

Enter the desired code (0 to 9) on the number keypad. 

¥ DIAL MODEÑSelect the type of dial system your fax machine is connected to. 

Press 1 if the fax machine is connected to a tone (Touch-Tone) dial line. 
Press 2 if the fax machine is connected to a pulse (rotary) dial line. 

¥ ECM MODE (Error Correction Mode)ÑThis mode compensates for poor line
quality and ensures accurate, error-free transmission with any other ECM-
equipped facsimile machine. If the line quality is poor, transmission time may
be increased when ECM is enabled. 

Press 1 to turn the Error Correction mode ON. 
Press 2 to turn the Error Correction mode OFF. 

¥ DIRECT COPYÑWith this feature set to ON, your machine makes only a
single copy at 100% of copy rate. In the direct copy mode, ÔCOPY PAGESÕ and
ÔCOPY RATEÕ options will not appear. You cannot activate EXPRESS mode
with this feature set to off. This feature is useful when you usually make a
copy that requires a lot of memory (i.e. photo).

Press 1 to turn this feature ON.
Press 2 to turn this feature OFF.
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¥ AUTO REDUCTIONÑWhen receiving a document as long as or longer
than the paper installed in your machine, the machine can reduce the
data in the document to fit your recording paper size. 

Turn ON this feature if you want to reduce an incoming page that may
otherwise need to be divided into two pages with only a few centimeters
on the second page. If the fax machine cannot reduce the data to fit into
one page with the feature enabled, the data is divided and printed in
actual size on two or more sheets, if needed.

Press 1 to turn this feature ON. 
Press 2 to turn this feature OFF. The overflow data will be printed out on
a second page.

Original Received data

Original Received data

- VERTICAL REDUC. (Reduction)ÑIf you turn the Automatic
Reduction feature on, you are allowed to select Vertical Reduction ON
or OFF. When you select Vertical Reduction to be ON, the machine
will reduce an incoming page containing overflow data only in
vertical, as shown below:

If you want to reduce both in vertical and horizontal at the same rate
in order to maintain height to width relationships, turn the Vertical
Reduction feature OFF. If you turn off this feature, the machine
reduces the data as shown below. 

Press 1 to turn this feature ON.
Press 2 to turn this feature OFF. 

¥ DISCARD SIZEÑWhen receiving a document as long as or longer than
the paper installed in your fax machine, you can set the fax machine to
discard any excess image at the bottom of the page to fit into the
recording paper size.  

If the received page is outside the margin you set, it will be printed on
two sheets of paper at the actual size.

If the data is within the margin, and the Auto Reduction feature is turned
on, it will be reduced to fit into the appropriate size paper (Discard does
not take place). If the Auto Reduction feature is turned OFF or fails, data
within the margin will be discarded.

Enter the desired discard size using the number keypad, and press Enter.  



¥ RETRY INTERVALÑYour machine can automatically redial a remote fax
machine if it was busy or does not answer the first call.

Enter the number of minutes (from 1 to 7) using the number keypad.

¥ RETRY COUNTÑEnter the number of attempts (from 0 to 2) to redial
the number before giving up.

If you enter 0, the machine will not redial.

¥ ANSWER ON RING ÑYou can select the number of times your machine
rings before answering an incoming call. If you are using your machine
as both a telephone and a fax machine, we suggest you set the ring count
to at least 4 to give you time to answer.

Enter a number shown on the display by using the number keypad.

¥ FORCE MEMORY TXÑIf you are annoyed that you have to wait until
documents in the feeder are sent out when you try to send or reserve
another fax, turn this feature on. This feature enables all transmission
documents to be automatically scanned into memory before transmission. 

Press 1 to turn this feature ON.
Press 2 to turn this feature OFF. 

¥ PRINT RTI (Receive Terminal Identification)ÑThis feature allows the
machine to automatically print the page number, the date and time of the
reception at the bottom of each page of a received document. 

Press 1 to turn this feature ON.
Press 2 to turn this feature OFF.

¥ CONT (Continuous) POLL REPORTÑEvery time continuous polling
ends, a multi-communication report will be printed to show the result for
each registered station.

Press 1 (ON) to print the report automatically each time continuous
polling ends.
Press 2 to turn the feature OFF. The report will not be printed.

¥ FAX PRINT QUALITYÑWhen you select LQ, the machine prints in low
speed with high quality. When you select DRAFT, the machine prints in
high speed with low quality.

Press 1 to select LQ.
Press 2 to select DRAFT.

2.56 Other Features
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3.2 Troubleshooting

Clearing Jams

Document Jams While Sending a Fax

If a document jams while you are sending it, ÔDOCUMENT JAMÕ appears
in the display. Do not pull the document out of the slot. If you do this, it
could harm your machine.

1. Open the control panel.

Troubleshooting

2. Carefully remove the jammed document. Then close the control panel
firmly until it clicks into place. 
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Paper Jams While the Machine is Printing 

If the paper jams while you are receiving, ÔPAPER JAMÕ appears in the
display. Do not pull it out. If you do, it could harm the machine. 

IF JAMMED IN THE RECEIVED PAPER OUTPUT AREA

Remove the jammed paper by hand, as shown. 

IF JAMMED IN THE PAPER FEED AREA

1. Remove the jammed paper as shown below.

2. After you have removed the jammed paper, load paper with the print
side facing you.

Squeeze the left paper guide and move it to the right to match the width
of the paper.
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3.4 Troubleshooting

IF JAMMED INSIDE THE MACHINE

1. Open the control panel ① and the cartridge compartment cover ②.

2. Carefully remove the jammed paper.

3. Replace the cover and the control panel.

➀

➁
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Error Messages

Display Meaning

CHECK CARTRIDGE
PLEASE INSTALL

Print cartridge is not installed properly. 

COLOR INSTALLED The print cartridge installed in your machine is a color
cartridge. 

DOCUMENT JAM

INK LOW

The document you are sending has jammed in the feeder.
Clear the document jam. See page 3.2. 

The print cartridge has run out of ink. Install a new print
cartridge.
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LOAD DOCUMENT You have tried to send a fax and there is no document loaded
into the machine. 

MEMORY FULL
The memory has become full. Either delete unnecessary
documents stored in memory. Send your document when the
memory is clear, or you can split the document into smaller
parts.

MONO INSTALLED The print cartridge installed in your machine is a black
cartridge. 

NO ANSWER The other machine has not answered after all your attempts
to redial. Or, the other machine does not press Start when
you are waiting to send or receive a fax.

NO. NOT ASSIGNED There is no number stored for the One-Touch button or 2-digit
Speed number you chose.

NO PAPER The printer is out of paper. If the paper runs out while
printing a fax, the machine restarts fax printing when you
load more paper. If paper runs out while printing a PC file,
you have to press the Form Feed button after loading more
paper, according to the instructions in the Windows driver.
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Display Meaning

POLLING ERROR
The machine you want to poll is not ready to answer your
poll. The person you are polling should have loaded their fax
machine with a document. 

Also, this message appears when you set up to poll another
fax machine with an incorrect Poll Code. 

SEND ERROR Your fax has not gone through successfully. Try again. 

RETRY REDIAL? The machine is waiting to automatically redial another fax
number that was busy. 

PAPER JAM Paper jammed during printing. Clear the paper jam (see page
3.3) and press the Stop button.
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Fixing Problems 

Your problem may be listed on page 3.5 in the ÔError MessagesÕ
section. Below are other problems you can solve yourself. If not,
call the service.

Fax Problems

Symptom

The machine is not working,
there is no display and the
buttons are not working. 

Cause and Solution

¥ Unplug the machine and plug it in again. 

¥ Check that your AC socket is live. 

No dial tone. 
¥ Check the handset is connected properly.

¥ Check the phone socket in the wall by plugging in a phone. 

The numbers stored in the
memory do not dial correctly. 

¥ Make sure that the numbers are stored in memory correctly.

¥ Print a Telephone Number List. See page 2.52.

The document does not feed
into the machine.

¥ Make sure that the document is not wrinkled and you are
putting it in correctly. Check that the document is the right
size, not too thick or thin. 

¥ Make sure that the cover is firmly closed.

You cannot receive faxes
automatically. 

¥ The Fax or Tel/Fax lamp should be on. 

¥ Make sure that the handset is hooked on properly. 

¥ Is there paper in the machine?

¥ Check if the display shows ÔMEMORY FULL.Õ

The machine will not send
anything. 

¥ Make sure that the document is loaded face down. 

¥ ÔTXÕ should show up in the display. 

¥ You may have hung up the handset before you pressed
Start. 

¥ Check the machine you are sending to, to see if it can
receive your fax.

The machine cannot receive
faxes manually. ¥ Did you hang up the handset before you pressed Start?
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Symptom

You cannot poll another
machine.

Cause and Solution

¥ The fax machine you are polling may be using a Poll Code. 

The fax you receive has got
blank spaces on it. 

¥ The machine sending you the fax may be faulty. 

¥ A noisy phone line can cause line errors. 

¥ Check your machine by making a copy. 

¥ The cartridge may be running out of ink.

Spots on or lines missing
from the fax you receive. 

¥ Check if your phone line is noisy.

¥ Check if the print head is clean by making a copy. 

You are receiving poor-
quality copies. 

¥ The fax machine sending you a fax may have a dirty scan
glass.

¥ Check for a noisy phone line. 

Are some of the words on the
fax you receive stretched?

¥ The machine sending you the fax had a temporary
document jam. 

There are lines on copies or
documents you send. 

¥ Check your scan glass for marks, and clean it. See page 3.17.

The machine dials a number,
but fails to make a connection
with another fax machine.

¥ The other fax machine may be turned off, out of paper, or
cannot answer incoming calls. Speak with the other
machine operator and ask them to sort out the problem.

You cannot store a document
in memory. 

¥ There may not be enough memory to hold the document
you want to store. If the display shows a ÔMEMORY FULLÕ
message, delete any documents you no longer need from
the memory, then reload the document.

Blank areas appear at the
bottom of each page or on
other pages, with only a small
strip of text printed at the top.

PC-FAX application, such as
WinFAX LITE, does not work
properly.

¥ You may have chosen the wrong paper settings in the user
options set up. See page 2.53 to choose the proper paper
size.

¥ The application might not work properly when you use
Windows 3.x on the computer equipped with DMA
pentium processor. In the case, use the application in
Windows 95 or later version..



3.9Troubleshooting

3
Tro

u
b
le

s
h

o
o
tin

g

Print Quality Problems

Symptom

Light or blurred characters

Smudged or dark characters

Characters with white lines

Color print quality is poor.

Cause and Solution

¥ You may be using ÔFast DraftÕ. See page 2.29.

¥ The print cartridge may be running out of ink. Replace the
print cartridge. See page 3.24. The Status monitor shows the
amount of ink left in the cartridge.

¥ Make sure that you are using the correct type of paper. Try
another type of paper.

¥ You may be printing on the wrong side of the paper.

¥ The print cartridge may need cleaning. See ÔPrint Cartridge
Nozzle TestÕ on page 3.19.

¥ Make sure that you are using the correct type of paper. Try
another type of paper. 

¥ Make sure that the paper is straight and unwrinkled.

¥ Let ink dry before handling the paper. You can use the ÔDry
Time DelayÕ check box in the print setting. See page 2.29.

¥ Change the ÔPrint QualityÕ setting to ÔFast Draft.Õ
See page 2.29.

¥ The print cartridge may need cleaning. 
See ÔPrint Cartridge Nozzle TestÕ on page 3.19.

¥ The print cartridge may be running out of ink. Replace the
print cartridge. The Status monitor shows the amount of
ink left in the cartridge.

¥ Remove and reinstall the print cartridge. See ÔReplacing the
Print CartridgeÕ on page 3.24.

¥ The print cartridge may need cleaning. See ÔPrint Cartridge
Nozzle TestÕ on page 3.19.

¥ If printing on transparencies, try changing the fill pattern in
your application software.

¥ Make sure that you are using the correct type of paper. Try
another type of paper.

¥ Make sure that the ÔPaper TypeÕ setting is appropriate for
the paper you loaded. See page 2.29

¥ Change the ÔPrint QualityÕ setting to ÔHighÕ or ÔNormalÕ.
See page 2.29.
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Cause and Solution

¥ The media is incorrectly loaded or is an unsupported size
or type. See page 2.31. For special media, it is recommended
that you feed one sheet at a time. 

¥ Make sure that you do not have hard-coded spaces at the
left margin in your application.

¥ The print cartridge may need cleaning. 
See ÔPrint Cartridge Nozzle TestÕ on page 3.19.

¥ The print cartridge may be misaligned. 
See ÔCartridge AlignmentÕ on page 3.27.

¥ The print cartridge may need cleaning. 
See ÔPrint Cartridge Nozzle TestÕ on page 3.19.

¥ The print cartridge may be misaligned. 
See ÔCartridge AlignmentÕ on page 3.27.

¥ Try changing the fill pattern in your application software.

¥ The color print cartridge has run out of one or more inks.
Install a new color cartridge. See page 3.24.

¥ The print cartridge may need cleaning. 
See ÔPrint Cartridge Nozzle TestÕ on page 3.19.

¥ The print settings may be incorrect. Check ÔDocument TypeÕ
setting in the Document/Quality dialogue box. 
See page 2.29.

¥ The black print cartridge may be installed. Replace with a
color cartridge. See page 3.24.

¥ When the machine prints a copy page or a received fax
document which contains data at a full page, if a color
cartridge is installed, the data on the bottom edge (about 10
mm) might be lost.

¥ You may reduce the image size before printing it, using
your application. Refer to your application manual.

Symptom

Characters improperly
formed or not aligned
correctly at left margin.

Vertical straight lines are not
smooth in tables, borders,
and graphs.

Solid black areas on
transparencies contain white
streaks.

Printed color does not match
screen colors.

Black and white is printing
instead of color.

Characters on the bottom
edge of a page seem to be
lost.

You receive a message that
says the photograph will
overflow the print area.

Print Quality Problems (continued)
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Printing Problems

Symptom Cause and Solution

Printer power is on, but
nothing prints.

Printer seems to be printing,
but no characters are
printing.

Expected characters are
printed or missing.

¥ The printer is improperly connected to the computer. Make
sure the printer cable is firmly connected to the printer and
the computer.

¥ Make sure that the printer cable is an IEEE 1284-compliant 
bi-directional parallel interface cable.

¥ Bad printer cable or computer port. Try another cable.

¥ Make sure that your application has the SF4500 Series
selected as the default printer.

¥ Make sure that there is paper in the paper bin.

¥ Check Print Manager.

¥ Try changing ports.

¥ Make sure that your selected port is not being used by
another device.

¥ Make sure that the paper path is not blocked.

¥ Check the print cartridge. Tape may be covering the ink
nozzles of the print cartridge.

¥ The print cartridge may be out of ink. Replace with a new
one. See page 3.24. The Status Monitor shows the amount of
ink left in the cartridge.

¥ Make sure that your application has the SF4500 Series
selected as the default printer.

¥ The printer cable may not be securely connected to the
machine and the computer, or the printer cable may not be
correct type. Check the printer cable.

¥ The print head may need cleaning. See ÔPrint Cartridge
Nozzle TestÕ, on page 3.19.



Symptom

Printer prints very slowly.

Page does not print.

Control panel of your
machine does not respond.

Cause and Solution

¥ You may be using ÔHighÕ print quality. Change the ÔPrint
QualityÕ setting to ÔFast Draft.Õ See page 2.29.

¥ Graphics print more slowly than text.

¥ Color prints more slowly than black.

¥ Special media prints more slowly than plain paper.

¥ Another application currently open affects print speed.
Close the running program if not required. 

¥ Unplug the power cord, then re-plug.

¥ Some extremely complicated page formats may not be
printable on the printer. If you are using too many fonts, or
if you are printing complex graphics, you can experience
this problem. Simplify your page or choose fewer fonts.

Printing Problems  (continued)

Symptom

Paper is jammed during
printing.

Paper sticks together.

Cause and Solution

Clear the paper jam. See page 3.3.

¥ Make sure that there is not too much paper in the bin.
Depending on the thickness of your paper, the bin can hold
up to 130 sheets.

¥ Make sure that you are using the correct type of paper.

¥ Remove paper from the bin, and flex or fan it.

¥ Humid conditions may cause some paper to stick together.

Paper Feeding Problems

3.12 Troubleshooting
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Symptom

Paper fails to feed.

Cause and Solution

¥ Make sure that there is not too much paper in the bin.
Depending on the thickness of your paper, the bin can hold
up to 130 sheets (20~24 lb).

¥ Make sure that the envelope guide is not in the envelope
position.

¥ Remove any obstructions inside the printer.

¥ Make sure that there is not too much paper in the bin.
Depending on the thickness of your paper, the bin can hold
up to 130 sheets (20~24 lb).

¥ Different types of paper may be stacked in the paper bin.
Load paper of only one type, size, and weight. 

¥ When loading paper, do not force the paper down into the
printer.

¥ If multiple sheets have caused a paper jam, clear the paper
jam.

¥ Make sure that there is not too much paper in the bin.
Depending on the thickness of your paper, the bin can hold
up to 130 sheets (20~24 lb).

¥ Make sure that the paper guide does not cause the paper to
bow.

¥ Make sure that you are using the correct type of paper.

¥ When loading paper, do not force the paper down into the
printer.

¥ Make sure that the right side of the paper is aligned with the
right edge of the feeder, and the left paper guide is set
against the left side of the paper.

¥ Make sure that the envelope guide is not in the envelope
position.

¥ Make sure that the envelope guide has been turned to the
envelope load position.

¥ Make sure that the paper guide is against the left side of the
envelopes.

¥ Use only transparencies specially designed for printer.

¥ Remove each transparency as it exits from the printer.

Paper Feeding Problems  (continued)

Multiple sheets of paper fed.

Paper skews or buckles in the
paper bin.

Transparencies stick together
in the paper exit.

Envelopes skew or fail to
feed correctly in the paper
bin.
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Scanning Problems

Symptom

You cannot scan a document
into memory.

There is no document or the
document is loaded
improperly. 

Scanner is busy receiving or
printing data. 

The unit scans very slowly.

Cause and Solution

¥ Make sure that you load the document to be scanned into
the document tray.

¥ There may not be enough available memory to store the
document you want to scan. 

¥ Print out any documents stored in memory.

¥ If there are any fax documents stored in memory waiting to
be sent, wait until they are dispaged of. See page 2.22.

¥ Graphics scan more slowly than text.

¥ Communication speed becomes slow in scan mode because
a lot of memory is required to analyze and reproduce the
scan image. Set your computer to ECP mode through the
BIOS setting it will help to increase the speed. For details on
how to set BIOS, refer to the documentation of your
computer.

Insert the document properly when ÔTRY AGAINÕ message
appears on the screen.

Insert the document properly and push it down until the
machine grips the document.

Your scanner may be currently used for copying or faxing.
When the current job is completed, try again.

There is not enough memory to save the scan image. Exit all
applications currently open, if not required, in order to save
memory.

Memory is not enough to
save the scan image. 
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Symptom

Scanning has failed. 

The selected port is currently
being used. 

The scanner driver is not
installed or an operation
environment is not set up
properly. 

Port is disabled. 

Port is disabled. 

Cause and Solution

Scan error occurs. Turn the printer off and back on. If you still
have the same problem, restart your computer.

Scan error occurred and the scanning has not been completed
properly. Reset your computer.

Re-install the scanner driver. See page 1.23. 
If you still have the same the problem, file setting required for
I/O may not be proper. Follow the instructions below:

1. Start Windows.
2. In Windows 95, select Run from Start menu.

Windows 3.x users should select Run from File menu
under Program Manager.

3. Type ÔsyseditÕ, then click OK.
4. Select system.ini file, and set the file as shown below.

[386 Enh]

device=vecp.386

LPT1TurnAroundDelay = 50

5. Restart Windows.

Check if the port is properly connected, or power is on. 

I/O error occurs during scanning. Check for bad cable, cable
connection. If you still have the same message, open the
system.ini file in the Windows directory as described above,
and increase time as much as required in increments of 10.

Check if the port is properly connected, power is on, scanner
is not busy. 

The printer cable may be improperly connected or the power
may be off. Turn the power on. If you still have the same
problem: turn the computer and printer off, and back on after
about 10 seconds, then try again.

..
..

..
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Clearing Memory

You can selectively clear information stored in your machineÕs memory.

1. Press Menu, then Memory Clear on the One-Touch keypad.
The display shows the options you can choose to clear:

1. SYSTEM ID: your System ID number and name are cleared from the
machineÕs memory.

2. SYSTEM DATA: restores user-selectable options to the default value.

3. DIAL/SCHEDULE: clears the One-Touch, Speed Dial, or Group dial
numbers stored in memory. In addition, all the
Schedule Job operations you have reserved are
canceled.

4. TX-RX JOURNAL: clears all records of transmissions & receptions.

3. Move to the options by pressing   or ¹ repeatedly, until you find the
one you want to clear.

4. Press Enter. The display asks you to confirm your selection.

5. Press 1 to confirm. Or use Ã or ¨ to choose ÔYESÕ, then press Enter. The
selected memory is cleared.

Maintenance
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Cleaning the Document Scanner  

To keep your machine working properly, occasionally clean the White
Roller, ADF rubber, and the scanning glass. If they are dirty, documents
sent to another fax machine will not be clear. 

Do not turn the power off to clean the scanner, as documents stored in
memory will be lost.

1. Open the control panel. 

2. Disassemble the White Roller as follows:
Both ends of the White Roller have plastic bushings that are snapped
shut with small tabs on them. Pull the bushing slightly inward (A) , then
rotate (B) until it reaches the slot. Then pull the roller upward. 

A
B

3. Wipe the roller surface with a soft cloth dampened with water. 

busing
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5. Carefully wipe the scanning glass with a soft, dry cloth. 

If the glass is very dirty, first wipe it with a slightly dampened cloth, then
with a dry one. Be careful not to scratch the glass surface. 

6. Replace the roller in reverse order, and then close the control panel
firmly until it clicks into place. 

4. Clean the ADF rubber piece also. 
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Printer Cartridge Maintenance 

To get maximum benefit from your print cartridges:

¥ Do not remove a print cartridge from its packaging until you are ready to
install it. 

¥ Do not refill print cartridge. The warranty will not cover damage caused
by using refilled cartridges. 

¥ Store the print cartridge in the same environment as the printer. 

¥ Do not remove a print cartridge from the printer except to replace it,
clean it, or switch between color and black. Immediately replace the print
cartridge or store it in the storage unit. The print cartridge will not print
correctly if removed from the machine and left exposed for an extended
period.

¥ When switching between color and black print cartridge, store the
unused cartridge in the print cartridge storage unit. 

¥ If you have an opened print cartridge you are not currently using and do
not have an available print cartridge storage unit, store it in an airtight
plastic bag. Do not leave it exposed for an extended period. 

Print Cartridge Nozzle Test

You should test the print cartridge when the print is not clear or dots are
missing. The problem may be caused by blocked nozzles on the print
cartridge.

The nozzle test cleans the print cartridge by clearing (purging) the nozzles.
Then it prints a test so you can see the results. Use the nozzle test:

¥ Anytime you suspect the nozzles are clogged.

¥ When characters are not printing completely.

To run the nozzle test:

1. From the Programs menu, select the SAMSUNG SF4500 Series
Printer.

For Windows 3.x, double-click the SAMSUNG SF4500 Series Printer icon
from the Program Manager.
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3. Select Control Program on LPT1. The SAMSUNG SF4500 Series Control
Program on LPT1 dialogue box will appear.

4. Click the Cartridge tab, then click Clean Print Nozzles. The printer
feeds a sheet of paper and prints the nozzle test pattern.

5. Examine the test pattern.
This example shows a test pattern of all nozzles functioning correctly on
the black print cartridge:

Before purge

After purge

Purge process

This example shows a test pattern of all nozzles functioning correctly on
a color print cartridge:

Compare the diagonal line at the top and bottom of the test pattern and
look for a break, A broken line shows any clogged nozzles.

If the bottom line shows improvement, rerun this test. If improvement
continues, rerun the test. If all nozzles are not printing after running the
test three times, continue with step 4.

Before purge

After purge

Purge process
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3. Allow the copper-colored area to dry, then reinstall the print cartridge
and repeat the nozzle test.

If the line is still broken, clean the print cartridge carrier contacts in your
machine. See page 3.22.

Nozzles

Contact Area

6. If print quality does not improve, remove and reinstall the print
cartridge. Repeat the nozzle test.

If the line is still broken, wipe the nozzles and contacts. See ÒWiping the
Print Cartridge Nozzles and ContactsÓ, below

Wiping the Print Cartridge Nozzles and Contacts

If print quality does not improve after repeating the nozzle test, the
problem may be caused by dried ink on the:

¥ Print cartridge nozzles.

¥ Print cartridge contacts.

¥ Print cartridge carrier contacts in the printer.

1. Remove the print cartridge. See ÒReplacing the Print CartridgeÓ 
on page 3.24.

2. Use a clean cloth, dampened with water only, to gently clean the entire
copper colored area, including the nozzles and contacts. To dissolve any
dried ink, hold the damp cloth against the nozzles for about three
seconds. Gently blot and wipe dry.

If you are cleaning a color print cartridge, be careful to wipe the nozzles
in only one direction so the colors do not mix.
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Cleaning the Cartridge Carrier Contacts and Deflector 

1. Press the Cartridge button to move the print cartridge carrier to the
load position. 

2. Unplug the power cord from the electrical outlet or the rear of the
machine. 

00000000
0000

0000
00

00000
00000

3. Open the control panel and the cartridge compartment cover. Then,
remove the print cartridge. 

4. Use a CLEAN, DRY CLOTH to clean the print cartridge carrier contacts
inside the printer. 

cartridge carrier
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5. Clean the carrier deflector inside the printer. 

carrier
deflector

00000000
0000

0000
00

00000
00000

6. Plug the power cord in. 

7. Press the Cartridge button, and install the print cartridge.
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Replacing the Print Cartridge

The print cartridge includes the ink supply and the printhead. Each time
you replace the print cartridge, you are replacing the printhead as well. 

When you notice that the print becomes light or ÔINK LOWÕ appears in the
display, replace your cartridge. 

¥ A black print cartridge is provided with your machine. For color printing,
you must purchase a color cartridge.

¥ Your machine knows which print cartridge is installed and keeps separate
ink supply counts for the color and black print cartridges. 

¥ When you install a new print cartridge, you must select Ô1.NEWÕ in the
display to reset the Ink Low counter. (See ÔInstalling Print CartridgeÕ on
page 1.8.)

¥ If you are switching between color and black print cartridges, be sure to
store the unused print cartridge in the print cartridge storage unit. 

¥ If you change a cartridge from color to black before a PC file is
completely printed, the remaining page on the file may not print. 

¥ If you are interrupted and leave the print carrier in the load position for
more than 30 seconds, the print cartridge carrier moves to the Standby
position. 

¥ When ÔINK LOWÕ appears during PC printing, the machine continues to
print. After printing is completed, replace the print cartridge. 

To replace the print cartridge, perform the following steps:

1. Press Cartridge on the control panel. The display shows ÔCARTRIDGE
IS 1.NEW  2.USEDÕ and the print cartridge moves to the load position. 

If you install a color cartridge, use ÔInstall CartridgeÕ tab in the
SAMSUNG SF4500 Series Control Program on your PC. 

2. Open the Control Panel ➀ and the Cartridge Compartment Cover ➁.

Cartridge Compartment Cover

➀

➁

Control Panel
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3. Pull the print cartridge handle toward you until it clicks. Remove the
print cartridge. 

4. Remove a new print cartridge from its packaging and carefully remove
the tape covering the print head. Hold the print cartridge by the colored
tab or black areas only. Do not touch the copper area. 

5. Insert the print cartridge in the cartridge holder, then push the print
cartridge firmly away from you, until it clicks into place. 

If the print cartridge moves loosely in the carrier, it has not clicked into
place. Repeat this step. 
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6. Replace the Cover and the Control Panel.

7. Select Ô1.NEWÕ by pressing 1.

The display briefly shows ÔMONO INSTALLEDÕ, then the machine
returns to Standby mode. 

¥ When you install a new cartridge, you must select Ô1.NEW.Õ When you
install a used cartridge, select Ô2.USEDÕ, which helps you monitor the 
amount of ink remaining. If you mix up several used cartridges, it will be
difficult to check the amount of ink remaining. Once a new print cartridge
is installed, use it until it has run out completely. 

¥ If the new cartridge does not give excellent printing quality, run ÔPrinter
Self-TestÕ on page 1.12. 

¥ If you want to install a color cartridge (option) to print a PC file, you
should use the ÔInstall CartridgeÕ tab in the SAMSUNG SF4500 Series
Control Program on your PC.
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Cartridge Alignment 

You should print the alignment pattern if vertical lines or characters appear
crooked. The alignment printing lets you straighten the vertical lines.

On Your SF4500 Series Machine Control Panel:

1. Press Menu, then press System Setup on the One-Touch keypad.

2. Press   or ¹ repeatedly, until the display shows ÔARRANGE
ALIGNMENT?.Õ

3. Press Enter. Alignment pattern is printed.

4. Examine the printed pattern, and select the closest straight line for Draft
Mode and Normal Mode.

5. Press the straight (or the closest) line number for Draft mode when the
display prompts you to enter number for DRAFT ALIGNMENT.

6. The display prompts you to enter number for NORMAL ALIGNMENT.
Press the straight (or the closest) line number for Normal Mode.

7. The display asks if you want to repeat alignment. If there are no lines
straight, press 1 to select YES, and repeat the procedure until you get a
straight line.

8. When alignment is complete, press 2 to select NO when the display
shows ÔREPEAT ALIGNMENT.Õ The machine returns to Standby mode.
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On the Control Program in the Printer Driver:

1. From the Programs menu, select the SAMSUNG SF4500 Series
Printer.

For Windows 3.x, double-click the SAMSUNG SF4500 Series Printer icon
from the Program Manager.

2. Select Control Program on LPT1. The SAMSUNG SF4500 Series Control
Program on LPT1 dialogue box will appear.

3. Click the Cartridge tab, then click Align Cartridge.

4. The printer feeds a sheet of paper and prints the alignment test
pattern.

Examine the test print. Select the number of the straightest lines, and
click OK.

5. Repeat the test until the alignment is correct. When alignment is
complete, click Cancel.
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Specifications

Printer

Printing area for paper
The shaded portion in the figure
shows the printing area.

Printing area for envelopes
The shaded portion in the figure
shows the printing area for
envelopes.

Printing method
Plain paper drop-on-demand thermal inkjet printing

Print speed
Black 7 ppm (draft),  5 ppm (LQ)
Color 3 ppm (draft),  2 ppm (LQ)

Printing resolution
Draft 300 x 600 dpi
Normal 600 x 600 dpi
High 1200 x 1200 dpi

Emulation
Windows GDI

Printer Drivers
Windows 3.1/95/98

Interface
IEEE 1284-compatible, bi-directional parallel interface

Printer memory
512 kbyte RAM

6.3mm (0.25 Inch) 6.3mm (0.25 Inch)

3.4mm (0.13 Inch)

12.7mm (0.5 Inch)

Feeding

6.3mm (0.25 Inch)

6.3mm (0.25 Inch)

3.4mm (0.13 Inch) 12.7mm (0.5 Inch)

Feeding
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Paper type
Plain paper
Glossy photo paper
Coated paper
Transparency
Iron-on transfer
Envelope

Paper size
Letter 216 mm x 279.4 mm (8.50 Inch x 11.00 Inch)
Legal 216 mm x 355.6 mm (8.50 Inch x 14.00 Inch)
A4 210 mm x 297 mm (8.27 Inch x 11.69 Inch)
A5 148 x 210 mm (5.83 Inch x 8.27 Inch)
B5 182 x 257 mm (7.17 Inch x 10.12 Inch)
Executive 184.2 mm x 266.7 mm (7.25 Inch x 10.50 Inch)
A6 card 105 mm x 148.5 mm (4.13 Inch x 5.85 Inch)
Index card 76 mm x 127 mm (3.00 Inch x 5.00 Inch)
Japanese Hagaki Postcard 100 mm x 148 mm (3.94 Inch x 5.83 Inch)
Index card 101.6 mm x 152.4 mm (4.00 Inch x 6.00 Inch)
#6  3/4 envelope 92.1 mm x 165.1 mm (3.63 Inch x 6.50 Inch)
#7  3/4 envelope 98.6 mm x 190.5 mm (3.88 Inch x 7.50 Inch)
#9 envelope 98.6 mm x 225.6 mm (3.88 Inch x 8.88 Inch)
#10 envelope 104.8 mm x 241.3 mm (4.13 Inch x 9.50 Inch)
DL envelope 110 mm x 220 mm (4.33 Inch x 8.66 Inch)
C5 envelope 162 mm x 229 mm (6.38 Inch x 9.02 Inch)
C6 envelope 114 mm x 162 mm (4.49 Inch x 6.38 Inch)
B5 envelope 176 mm x 250 mm (6.93 Inch x 9.84 Inch)
Baronial 143 mm x 111.3 mm (5.63 Inch x 4.38 Inch)

Cartridge life
Black About 600 sheets (4% print density on A4)
Color About 200 sheets (15% print density on A4)

Paper feeder capacity
Plain paper (20 lb) approx. 130 sheets (13.5 mm Dummy)
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Scanner

Scan resolution
300 x 300 dpi

Scan mode
SF4500 : 256 Gray, B/W
SF4500C : 256 Gray, B/W, Full color (24 bit)

Interface
IEEE 1284-compatible, bi-directional parallel interface

Communication method
ECP/Nibble mode (IEEE 1284 recommended) 

Facsimile

Applicable line
Public Switched Telephone Network (PSTN); PABX

Compatibility
ITU Group 3, ECM

Effective scanning width
210 mm

Modem speed
14400/12000/9600/7200/4800/2400 bps

Reception memory
SF4500: 1M byte (about 80 pages)
SF4500C: 2.5M byte (about 200 pages)

Memory backup time
30 minutes (min.)

Data compression system
MH/MR/MMR (ECM)

Scanning method
Sheet-feed scanning using CIS

Input document size
8.5 inch (216mm)

ADF capacity
30 sheets (0.004 in/20 lb)
20 sheets (0.003~0.0039 in/12.5~19.9 lb, 0.0041~0.005 in/21-28 lb)



Acceptable Documents for Faxing, Scanning, or Copying

Single Sheet

8.3 in. (210 mm)Effective Scanning Width

Uncoated on both sidesPaper Quality

Document Size

8.5 in. (W) ✕ 14 in. (L)
(216 mm ✕ 356 mm)

- Up to 30
Number of sheets which can

be loaded at a time

8.5 in. (W) ✕ 11.7 in. (L)
(216 mm ✕ 297 mm)Max

2 or More Sheets

5.8 in. (W) ✕ 5.0 in. (L)
(148 mm ✕ 128 mm)Min

0.003 to 0.006 in. 
(0.07 to 0.15 mm)

0.003 to 0.0047 in. 
(0.07 to 0.12 mm)

Thickness of document 
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General

Power source
220- 240V AC, 50-60 Hz

Power consumption
12 W (max.) in idle mode
32 W (max.) in print mode

Dimension (W x D x H)
365 mm x 355 mm x 193 mm 

Weight
Approx. 5.7 kg 

Environmental conditions
Temperature 16 - 32 degrees C (10 - 40 degrees C)
Humidity 8 - 80 % RH

Print cartridge life
Approximately 200 color pages at 15% coverage
Approximately 600 black pages at 4% coverage

Print head nozzle
208 nozzles for black
64 nozzles for each color (cyan, magenta, yellow)
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Index

A
address label       2.45
answer on ring      2.56
automatic redial     2.12
auto journal      2.54
automatic receive mode      2.20, 2.21
auto reduction      2.55

B
broadcasting      2.15

C
call back message      2.52
carrier sheet      2.9
cartridge      (see print cartridge)
cleaning

cartridge nozzle    3.19
document scanner      3.17

connection
extension phone      1.6
handset      1.4
phone line      1.6
power cord      1.7
printer cable      1.7

continuous polling      2.24
contrast      

button and lamp      2.2
home mode setting      1.13
mode change      2.8

control panel      2.2
control program

starting      2.36
using      2.37

copy      2.26

D
date and time, setting      1.15
delayed transmission      2.13
discard      2.55

document
exit tray, install     1.5
jam, clearing      3.2
loading      2.10   
preparing      2.7
printing      2.27
tray, install     1.5
type, setting      2.29

driver, install      1.17
dual      2.51

E
ECM      2.54
edit number or name      2.6
envelope

loading      2.33
size, setting      2.29

error message      3.5
express mode      2.9
extension phone, setup      1.6

F
fax

mode      2.19
paper size      2.54
print quality      2.56
problems      3.7
receiving      2.38
sending      2.11
specification      4.4

Flash      2.51
force memory transmission      2.56

G
group dial      2.47
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H
halftone      2.30
handset, install      1.4
help list       2.52

J
jam, clearing

document      3.2
paper      3.3

journal      2.52

L
loading

document      2.10
envelope      2.33
paper      1.11

M
manual receive (TEL mode)      2.21
memory clear      3.16
memory transmission      2.15
message confirmation report    2.52, 2.54
multi-communication report      2.52
Myscan      2.39

N
name, setting      2.4

O
One-Touch dial      2.44
options

answer on ring      2.56
auto journal      2.54
auto reduction      2.55
continuous poll report      2.56
dial mode      2.54
discard size     2.55
ECM      2.54
fax paper size      2.54

fax print quality     2.56
force memory transmission      2.56
message confirm. report      2.54
print RTI      2.56
remote receiving code      2.54
retry count      2.56
retry interval      2.56
vertical reduction      2.55

P
page 

collation      2.29
sequence      2.29

paper
feeding problems     3.12
jam, clearing      3.3
loading      1.11
size, setting      2.29
special      2.32
type, setting      2.29, 2.31

parallel printer cable      1.7
pause      2.6
pc-fax      1.18
polling

reception      2.23
transmission     2.17

power, connection      1.7
Presto! PageManager      1.18, 1.23
Presto! PhotoAlbum      1.18, 1.23
print cartridge

alignment      2.38, 3.26
cleaning      2.38, 3.21
install      1.8, 2.38
nozzle test      3.19
replacing      3.24
storing      1.10
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printer
cable, connection      1.7
driver, install      1.20
settings      2.28
test pattern      1.12

printing      2.27
problems      3.12
speed      2.34

print quality
problems      3.9
setting      2.29

priority transmission      2.16

R
receiving

ans/fax mode      2.21
fax mode       2.20
memory       2.22
mode       2.19
tel/fax mode      2.20
tel mode      2.21
using extension phone      2.22

redial      2.50
report, print      2.52
resolution      

button and lamp      2.2
home mode setting      1.13
mode change      2.8

ringer volume, adjust      1.13

S
scan

driver install      1.23
options      2.41
problems      3.14
procedure      2.40
specifications      4.4

schedule information list      2.52
search numbers in memory      2.48
self test      1.12
sending fax      2.11  (see transmission also)

canceling      2.12, 2.18
setup

machine      1.4
system      1.13

SF4500 Series
control program      2.35
manager      1.18, 1.23
printer driver      1.17, 1.20
scanner driver      1.18, 1.23

Smart Soft, install      1.17
speaker volume, adjust      1.14
speed dial      2.46
standby operation      

add documents to      2.18
cancel      2.18

status, printer      2.37
system data list      2.52
system ID, setting      1.16
system requirement      1.19

T
telephone line, connection      1.6
telephone numbers list      2.52
tone      2.51
transmission

after talking      2.11
automatic      2.11
cancel      2.12, 2.18
delayed      2.13
memory      2.15
polling      2.17
priority      2.16

TWAIN compliant      1.18

U
uninstall      1.24

V
voice request      2.13
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MySScan

MyScan, SF4500 Series scanner, is an
image-scanning program that operates
under various image-editing and OCR
applications. MyScan includes drivers
which may be used with any TWAIN-
compliant application software (e.g.
Presto! PageManager, Adobe Photoshop). 
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Presto!
PhotoAllbbuum

Presto! PhotoAlbum helps you create
personalized photo albums that organize
and preserve your photos forever...
electronically. 
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The SmartFAX application enables
you to set up phonebook and
download to the your machine. It
also allows you to control fax
operation on SmartFAX window.
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Presto! PageManager
(for Windows 95)

With Presto! PageManager, you can easily scan documents and
images into your computer and maintain them electronically.

1



1.2

The Presto! PageManager Scanning Operating System eliminates the need for
maintaining paper copies of photographs and documents. With Presto!
PageManager, you can easily scan documents and photographs into your
computer and maintain them as electronic documents. You can also use
Presto! PageManager to quickly transmit scanned documents by fax or
electronic mail, or to print a copy on your printer.

If you need information about a procedure, you can obtain that information
in the Presto! PageManager online help system.

There are two ways to obtain online help about a feature:

- Choose Contents from the Help menu.

- Use the Context Help command          to point to an object in Presto!
PageManager and show a brief description of that object.

Before scanning documents or photographs, make sure that Presto!
PageManager software and the image scan program MyScan, provided with
your SF4500 Series, have been installed in your computer.

Refer to the SF4500 Series Setup and Operation UserÕs Guide.

Presto! PageManager

Overview
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The following instructions give a general description of scanning using
Presto! PageManager.

1. Turn on the scanner (e.g. Samsung SF4500 Series) and start 
Presto! PageManager in Windows 95 (Start ➝ Programs ➝ Presto!
PageManager ➝ Presto! PageManager).

2. Position the document or photograph in your scanner.

3. From the File menu, choose the Select Source option.

4. Select the appropriate driver (e.g. MyScan).

5. Open the File menu, select the Acquire option. The particular scanning
interface will be invoked for scanning.

6. When the item has been completely scanned, it appears as the currently
selected thumbnail image in the Inbox folder.

7. You can now begin to use Presto! PageManager to work with the scanned
item.

Scan a Document or Photograph
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1.4

Treeview
Lets you see the
hierarchy of folders and
its contents. Click on a
folder or the plus (+)
signs  to display its
contents.

Menu
page 1.11.

Toolbar
page 1.7.

Application Bar
Gives you quick access to applications by using
drag-and-drop. For details, see the next page.

Trash Can

Before you begin using Presto! PageManager, please take a moment to look
at all the Presto! PageManager tools and icons described in this section.
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Application bar

Application Bar

After a document is scanned or imported, it is placed in the Inbox folder
and shown in the desktop as a thumbnail view.

The application bar gives you quick access to many other applications
which interface with Presto! PageManager. To add more applications, refer to
the Application Preferences in the Customizing Presto! PageManager section
on page 1.15. 

To use an application on the application bar, select the image(s) and click on
the target application. Or drag the image(s) over the target application,
release the mouse button, and the selected item will automatically be
opened by that application or device.
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Printing the Scanned Image

1. Drag the scanned image to the Printer icon on the application bar. 
Or, click the Printer icon after choosing the desired item.

2. The Print dialog box will appear. Select the appropriate options.

3. After choosing options, click OK. Presto! PageManager will send the file to
your printer.

Copying the Scanned Image

1. Drag the item from the Presto! PageManager Window to the Copier icon
on the application bar.

2. The Presto! Copier dialog box will appear. Select the appropriate options.

3. Click           to start copying. The copies will print out on your printer.

Enlarge (up to 200%) or
reduce (up to 1%) the size of

the copies.

Enter the number of copies (up to
99) using the number keys. If you
press the C button, the number
will reset to 1. 
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Tools and Icons

Sending Fax or E-Mail

1. Drag the item from the Presto! PageManager Window to the Fax or E-Mail
icon on the application bar. Presto! PageManager will then start the
selected application.

2. Create the message you want to send.

For instructions on creating a fax or E-mail message, see the documentation
for your application.

New Folder
Creates a new folder.

Save As
Saves the existing file under a different name, and places it in the Inbox
folder.

Import
Opens an existing file and places it in the Inbox folder.

Acquire
Scans the image from the source you selected.

Find File
Searches the files. See page 1.12.
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Perform OCR
OCR (Optical Character Recognition) is a software mechanism with
the ability to recognize most character formats. this permits a
scanned document to be read and edited on your word processor.
Click this button to perform OCR on the selected documents without
the need for them being opened. Clicking the OCR button again,
even if the image has been recognized, will OCR the document again.

In order for OCR to work, the image must be scanned in black and white.

Rotate
Image rotation by 90, 180, 270 degrees.

Image View/Text View Toggle Switches
The image view shows the image as a graphic. Text view shows the
text of image or OCRs the image-if not already OCRed.

Preferences
Customizes the settings that the Presto! PageManager uses.

Information
Displays a message box of a folder, document or image.

Help
Displays the Context Help topic.

Allows you to directly access the Presto! PageManager site on the
World Wide Web.
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Scan Buttons palette
Sends data directly
from the scanner to the
application you select.
You can add or delete
applications from the
scan buttons palette.
See page 1.16.

Status Bar
Displays the current activity.

Enable Scan Buttons palette
When the dot in the graphic is green, click once on the
graphic to display the Scan Buttons palette. The color of the
dot switches to red. Click again to close the Scan Buttons
Palette.

Show Graphic Tool
Shows the graphic tool being used. For details on the graphic
tools you can use, see the next page.

System Information
Click this area to display the amount of free memory, disk
space, date, or time.

Magnification Ratio
The magnification of the image compared to the actual size.
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Image Selection
Lets you select an area to cut or
copy for pasting.

Selection
Lets you select, move, and
resize annotations on an image.

Zoom
Enlarges or reduces the view of
the image.

Move
Moves the position to view a
different portion of the image.

Crop
Selects an area and discards the
rest.

Text
Adds text to the image.

Highlighter
Highlights any rectangular
portion of the image with a
colored pen.

Freehand Line
Lets you freely draw,
underline, circle, scribble, and
mark on the image with a
colored pen.

Straight Line
Draws a straight line.

Sticky Note
Lets you add messages or
comments to the image.

Stamp
Lets you select the stamp
styles.

1.10

Double-click the desired thumbnail image on the PageManager screen. The
following graphic tools will be shown on the right side of the desktop when
the image is opened, allowing you can add comments to the image before
faxing, E-mailing, or editing the image.

When you edit the image using these graphic tools, you must save using    .PFC
format. If you choose other file formats (i.e, .BMP, .JPG, .TIF), text or line you
have added to the image will not be saved.

*
***
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New Folder
Creates a new folder.

Import
Opens an existing file and places it
in the Inbox folder.

Save As
Saves a copy of the document in a
separate file.

Acquire
Begins scanning the image from the
source selected.

Select Source
Selects the scanning source for
acquisition.

Scan Setting
Changes the Scan Settings. 
See page 1.15.

Print
Prints the active document.

Print Setup
Changes the Printer Settings.

Scan Buttons setting
Changes the settings of the Scan
Buttons. See page 1.16.

Preferences
Opens the Preferences dialog boxes
and lets you customize Presto!
PageManager.
See pages 1.15 through 1.23.

Exit
Closes Presto! PageManager
application.

Menus

File Menu P
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Undo
Lets you undo your last action.

Clear
Deletes an annotation or a selected
area of the image.

Delete Page
Deletes the active document.

Crop
Take away the area outside the
selected area; leaves only the area
within the selection.

Rotate
Rotates the image by an angle of
90O, 180O, 270O, or an arbitrary
amount.

Find
Finds the specified data.

Find Next
Finds the next matched data.

Edit Menu

Finding Files

1. Select Find from the Edit menu. The Find dialog box will appear.

2. From the Find dialog box, type in specified folder, document name, date,
annotation, or contents. As soon as an entry is made, the Find First and
Find All buttons are enabled.

3. From the Find dialog box, click Find First to find the first data match.
Click Find All to find all data matches.

You may select Find Next in the Edit menu or press F3 to find the next
data match.

Click the Match Case check
box to find files which

exactly match the case.
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4. After you find a file, you can edit, mail, fax, or print it. 

To open the E-mail, fax, and printer applications, first select the file
thumbnail, and then click on the Application button at the side.

Application Button

Fit Page To Window
Fits the entire image in the window.

Fit Width To Window
Fits the entire width of the image in
the window.

Actual Size
Views a 1:1 ratio.

Image View/Text View
The Image View shows the images
as a graphic. Text View shows the
text of the image or OCRs the
image - if not already OCRed.

Information
Displays current document
information.

Toolbars
Shows or hides toolbars and
tooltips, and Enlarge View/Reduce
View button sizes.

Application Bar
Shows or Hides the Application
bar.

Treeview
Shows or hides the Treeview.

Scan Buttons
Enables or displays the Scan
Buttons palette.

View Menu
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Lets you select the line, font, color and stamp styles for graphic editing.

Annotation Menu

Contents
Gets Online Help.

About PageManager
Displays programÕs information.

Help Menu
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Customizing 
Presto! PageManager

The Scan Setting allows you to set contrast, brightness, and other options.

1. Choose Scan Setting from the File menu. The dialog box will appear.

You can customize the settings that Presto! PageManager uses.

Scan Setting

To adjust the brightness of the scanned image, drag
the Brightness bar in the appropriate direction.

To adjust the contrast of the scanned image, drag the
Contrast bar in the appropriate direction.
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Name Gives the Scan Button associated with the device or
application a title.

Scan to App Select the destination application to which you wish
to scan the document or image.

Scan Mode Choose a Black-and-White, Gray, or Color format.

Scan Size Select the size to be scanned by the scanner.

Resolution Choose a resolution.

Suppress TWAIN Enable or Disable the TWAIN scanning interface 
user interface during scanning.

1.16

Suppress TWAIN Check this box to enable the Default Scan Options, 
user interface and make the TWAIN scanning interface invisible

during image acquisition. The settings made in the
Default Scan Options section will be used for
scanning the image(s).

Default Scan Chooses the appropriate setting: Scan Mode, Size,
Options and Resolution.

2. Click OK to save the settings and close the dialog box.

The Scan Buttons Setting lets you add or delete applications from the Scan
Buttons palette. You can send data directly from the scanner to any
application with the Scan Buttons.

1. Select the Scan Buttons Setting from the File menu. The dialog box will
appear.

Scan Buttons Setting
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To adjust the brightness of the scanned image, drag
the Brightness bar in the appropriate direction.

To adjust the contrast of the scanned image, drag
the Contrast bar in the appropriate direction.

Add Click to add an application.

Remove Click to remove the selected application.

2. When you have changed all the necessary settings, click OK to save the
settings and close the dialog box.

1. Choose Preferences from the File menu, or click on the Preferences icon
from the Toolbar. The Preferences dialog boxes will then appear.

2. Click on the Compression tab and the Compression dialog box will
appear.

Method Select the compression method for gray and color
images.

Image Quality High Compression will greatly reduce the image size
and cause some degradation to the image quality.
High Quality will preserve the image quality better,
but the image wonÕt be compressed as much.

3. When you have changed all the necessary settings, click OK to save the
settings and close the dialog box.

Compression Preferences
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1. Choose Preferences from the File menu, or click on the Preferences icon
from the Toolbar. The Preferences dialog boxes will then appear.

2. Click on the Fax tab and the Fax dialog box will appear.

Fax Driver Shows the driver name.

Fax with Indicates if you want the notes faxed together with 
Annotations the document.

Setup Allows you to change the fax setup.

Scaling Options Select the faxed image size: fit to page, or keep the
original size.

Halftone Image Choose Use Fax Driver Default or Diffuse. Diffuse
sends a higher grade image to the receiving party.

3. When youÕve changed all the necessary settings, click OK to save the
settings and close the dialog box.

Fax Preferences
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1. Choose Preferences from the File menu, or click on the Preferences icon
from the Toolbar. The Preferences dialog boxes will then appear.

2. Click on the Printer tab and the Printer dialog box will appear.

Printer Shows the printer name.

Print Annotations Indicates if you want to print the annotations with
the document.

Display Print Displays the Print dialog box before sending the
Dialog before files to the printer.
Printing

Setup This button allows you to change the printer setup.

Scaling Options Select the printed image size: fit the page, or keep
the original size.

Halftone Image Choose Use Printer Default to use the standard
printer defaults. Choose Diffuse to print a higher
grade image.

3. When youÕve changed all the necessary settings, click OK to save the
settings and close the dialog box.

Printer Preferences
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1. Choose Preferences from the File menu, or click on the Preferences icon
from the Toolbar. The Preferences dialog boxes will then appear.

2. Click on the Mail tab and the Mail dialog box will appear.

Mail System Lets you select one of the following mailing
systems: Microsoft Exchange or Lotus cc:Mail.

Attached File Format Specifies the file format for the E-mail.

3. When youÕve changed all the necessary settings, click OK to save the
settings and close the dialog box.

Mail Preferences
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1. Choose Preferences from the File menu, or click on the Preferences icon
from the Toolbar. The Preferences dialog boxes will then appear.

2. Click on the Notes tab to display the Notes dialog box.

Attached File Format Specify the file format for the Notes.

3. When youÕve changed all the necessary settings, click OK to save the
settings and close the dialog box.

Notes Preferences
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1. Choose Preferences from the File menu, or click on the Preferences icon
from the Toolbar. The Preferences dialog boxes will then appear.

2. Click on the OCR tab to display the OCR dialog box.

Auto Detect Detects and maintains the original placement of the
text.

Force Single Treats everything on a scanned page as a single
Column column.

Language Choose a language from the Languages drop-down
list.

Draft-Mode If the image youÕre recognizing was created on a
Dot Matrix dot-matrix printer, choose this option.

Straighten Image If the image youÕre OCRing was scanned into
before OCR your computer at a skewed angle, choose this option.

3. When youÕve changed all the necessary settings, click OK to save the
settings and close the dialog box.

OCR Preferences
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The application bar presents you with a palette consisting of icons
representing various applications. Application Preferences is used to
modify the application presented on the application bar.

1. Choose Preferences from the File menu, or click on the Preferences icon
from the Toolbar. The Preferences dialog boxes will then appear.

2. Click on the Applications tab to display the Applications dialog box.

Add Displays the Add Application dialog box and adds a
new application.

Remove Removes an application from the application bar.

Application Setting Displays and changes an applicationÕs information.

Change Icon Use this button to select an icon to be associated
with the application.

3. When youÕve made all the necessary changes, click OK to save the
changes and close the dialog box.

Application Preferences
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Memo
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Presto! PageManager
(for Windows 3.x)

With Presto! PageManager, you can easily scan documents and
images into your computer and maintain them electronically.
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Presto! PageManager

The Presto! PageManager Scanning Operating System eliminates the need for
maintaining paper copies of photographs and documents. With Presto!
PageManager, you can easily scan documents and photographs into your
computer and maintain them as electronic documents. You can also use
Presto! PageManager to quickly transmit scanned documents by fax or
electronic mail, or to print a copy on your printer.

If you need information about a procedure, you can obtain that information
in the Presto! PageManager online help system.

There are two ways to obtain online help about a feature:

- Choose Contents from the Help menu.

- Use the Context Help command          to point to an object in the 
Presto! PageManager, and show a brief description of that object.

Before scanning documents or photographs, make sure that the 
Presto! PageManager software and the image scan programme MyScan,
provided with your SF4500 Series, have been installed in your computer.

Refer to the SF4500 Series Setup and Operation UserÕs Guide.

Overview
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The following instructions give a general description of scanning using
Presto! PageManager.

1. Turn on the scanner (e.g. Samsung SF4500 Series) and start
Presto! PageManager in Windows 3.x (Program Manager ➝ Presto!
PageManager ➝ Presto! PageManager).

2. Position the document or photograph in your scanner.

3. From the Scan menu, choose the Select Source option.

4. Select the appropriate driver (e.g. MyScan).

5. Open the Scan menu, select the Acquire option. The proper scanning
interface will be invoked for scanning.

6. When the item has been completely scanned, it appears as the currently
selected thumbnail image in the Inbox folder.

7. You can now begin to use Presto! PageManager to work with the scanned
item.

Scan a Document or Photograph
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Treeview
Lets you see the
hierarchy of folders and
its contents. Click on a
folder to display its
contents.

Menu
page 1.33.

Toolbar
page 1.31.

Application Bar
Gives you quick access to applications by using
drag-and-drop. For details, see the next page.

Trash Can

Before you begin using Presto! PageManager, please take a moment to look
at all the Presto! PageManager tools and icons described in this section.
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Application Bar

After a document is scanned or imported, it is placed in the Inbox folder,
and shown in the desktop as a thumbnail view.

The application bar gives you quick access to many other applications
which interface with Presto! PageManager. To add more applications, refer to
the Application Preferences in the Customizing Presto! PageManager section,
page 1.37. 

To use any application on the application bar, select the image(s) and click
on the target application. Or drag the image(s) over the target application,
release the mouse button, and the selected item will automatically be
opened by that application or device.

Application bar
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3. After choosing options, click OK. Presto! PageManager will send the file to
your printer.

Sending Fax or E-Mail

1. Drag the item from the Presto! PageManager Window to the Fax or E-Mail
icon on the application bar. The Presto! PageManager will then start the
selected application.

2. Create the message you want to send.

For instructions on creating a fax or E-mail message, see the documentation
for your application.

Printing the Scanned Image

1. Drag the scanned image to the Printer icon on the application bar. 
Or, click the Printer icon after choosing the desired item.

2. The Print dialogue box will appear. Select the appropriate options.
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Tools and Icons

Double-click the desired thumbnail image on the Presto! PageManager
screen. The following graphic tools will be shown.

Image View/OCR Toggle Switches
The image view shows the image as
a graphic. OCR (Optical Character
Recognition) shows the text of
image or OCRs the image-if not
already OCRed. Use OCR feature to
convert the image to editable text.
Clicking the OCR button again, even
if the image has been recognized,
will OCR the document again.

In order for OCR to work, the image
must be scanned in black and white.

Selection
Lets you select, move, and resize
annotations on an image.

Crop
Selects an area and discards the rest.

Move
Moves the position to view a
different portion of the image.

Zoom in

Zoom out

Freehand Line
Lets you freely draw, underline,
circle, scribble, and mark on the
image with a colored pen.

Text
Adds text to the image.

Deskew
Lets you deskew an image.

Rotate
Image rotation by 90, 180, 270
degrees.

Preferences
Customizes the settings that the
Presto! PageManager uses.

Information
Displays the message box of a
folder, document or image.

Help
Displays the Context Help topic.
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Scan Buttons palette
Sends data directly
from the scanner to the
application you select.
You can add or delete
applications from the
Scan Buttons palette.
See page 1.38.

Status Bar
Displays the current activity.

Enable Scan Buttons palette
When the dot in the graphic is green, click once on the
graphic to display the Scan Buttons palette. The color of the
dot switches to red. Click again to close the Scan Buttons
palette.

Show Graphic Tool
Shows the graphic tool being used.

System Information
Click this area to display the amount of free memory, disk
space, date, or time.

Magnification Ratio
The magnification of the image compared to the actual size.
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Open
Opens an existing file and places it
in the Inbox folder.

Save As
Saves a copy of the document in a
separate file.

Print
Prints the active document.

Print Setup
Changes the printer settings.

Fax
Fax the active document.

Fax Setup
Changes the fax settings.

Find
Finds the specified data.

Find Next
Finds the next matched data.

Preferences
Opens the Preferences dialogue
boxes and lets you customize
Presto! PageManager. 
See pages 1.37 through 1.40.

Exit
Closes Presto! PageManager
application.

Menus

File Menu
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Finding Files

1. Select Find from the File menu. The Find dialogue box will appear.

2. From the Find dialogue box, type in specified folder, document name,
date, annotation, or contents. As soon as an entry is made, the Find First
and Find All buttons are enabled.

3. From the Find dialogue box, click Find First to find the first data match.
Click Find All to find all data matches.

You may select Find Next in the File menu or press F3 to find the next
data match.

4. After you find a file, you can mail, fax, or print the file. 

To open the E-mail, fax, and printer applications, first select the file
thumbnail and then click on the application button at the side.

Click the Match Case check box to find files which
exactly match the case.

Application Button
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Fit Page To Window
Fits the entire image in the window.

Fit Width To Window
Fits the entire width of the image in
the window.

Actual Size
Views a 1:1 ratio.

Image View/Text View
The Image View shows the images
as a graphic. Text View shows the
text of the image or OCRs the
image - if not already OCRed.

Information
Displays current document
information.

View Menu

Undo
Lets you undo your last action.

Clear
Deletes an annotation or a selected
area of the image.

Delete Document
Deletes the active document.

Crop
Take away the area outside the
selected area; leaves only the area
within the selection.

Rotate
Rotates the image by an angle 90O,
180O, 270O, or an arbitrary amount.

Edit Menu
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You can select the font and the font style.

Text Menu

Acquire
Begins scanning the image from the
source selected.

Select Source
Selects the scanning source for
acquisition.

Contents
Get Online Help.

Tooltips
Displays the currently selected
toolÕs information.

About PageManager
Displays programmeÕs information.

Scan Menu

Help Menu
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Customizing 
Presto! PageManager

You can customize the settings that Presto! PageManager uses.

The Scanner Preferences allows you to set the contrast, brightness, and
other options.

1. Choose Preferences from the File menu or click on the Preferences icon
from the Toolbar. The Preferences dialogue box will appear.

Scanner Preferences

To adjust the brightness of the scanned image, drag
the Brightness bar in the appropriate direction.

To adjust the contrast of the scanned image, drag the
contrast bar in the appropriate direction.
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Show Twain Check this box to make the TWAIN scanning interface
U/I visible during image acquisition.

Background Sets PageManager to run in the background while
Scan you use other applications.

2. Click OK to save the settings and close the dialogue box.

The Scan Buttons Preferences lets you add or delete applications from the
Scan Buttons palette. You can send data directly from the scanner to any
application with the Scan Buttons.

1. Choose Preferences from the File menu or click on the Preferences icon
from the Toolbar. The Preferences dialogue box will appear.

2. Click on the Scan Buttons tab and the Scan Buttons dialogue box will
appear.

Name Gives the Scan Button associated with the device or
application a title.

Scan to App Select the destination application where you wish to
scan the document or image to.

Scan Mode Choose a Black-and-White, Gray, or Color format.

Scan Size Select the size to be scanned by the scanner.

Resolution Choose a resolution.

Scan Buttons Preferences
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Set Click to set an application.

Remove Click to remove a selected application.

2. When you have changed all the necessary settings, click OK to save the
settings and close the dialogue box.

1. Choose Preferences from the File menu or click on the Preferences icon
from the Toolbar. The Preferences dialogue box will appear.

2. Click on the OCR tab and the OCR dialogue box will appear.

Auto Detect Detects and maintains the original placement of the
text.

Force Single Treats everything on a scanned page as a single
Column column.

Language Choose a language from the Languages drop-down
list.

Draft-Mode If the image youÕre recognizing was created on a
Dot Matrix dot-matrix printer, choose this option.

Auto Deskew If the image youÕre OCRing was scanned into
your computer at a skewed angle, choose this option.

3. When youÕve changed all the necessary settings, click OK to save the
settings and close the dialogue box.

OCR Preferences
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The application bar presents you with a palette consisting of icons
representing application. Application Preferences is used to modify the
application presented on the application bar.

1. Choose Preferences from the File menu or click on the Preferences icon
from the Toolbar. The Preferences dialogue box will appear.

2. Click on the Applications tab and the Application dialogue box will
appear.

Add Displays the Add Application dialogue box and add a
new application.

Remove Removes an application from the application bar.

Modify Displays and changes an applicationÕs information.

3. When youÕve made all the necessary changes, click Close to save the
changes and close the dialogue box.

Application Preferences
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MyScan
(The SF4500 Series Scanner)

MyScan, the SF4500 Series Scanner, is an
image-scanning program that operates under
various image-editing and OCR applications.
MyScan includes drivers which may be used with
any TWAIN-compliant application software.

2
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Overview

The MyScan Program

MyScan, the SF4500 Series scanner, is an image-scanning program that
operates under various image-editing and OCR applications. MyScan
includes drivers which may be used with any TWAIN-compliant
application software. 

The TWAIN standard is an image data transfer protocol developed to allow
one software package to use many devices. Some examples of TWAIN
compliant devices are: Flat-bed scanners, Drum Scanners, Digital Cameras,
and Video Frame Grabbers. The TWAIN standard also allows many
software packages access to the same image input device. Examples of
some TWAIN-compliant software packages are: Presto! PageManager, Adobe
Photoshop, and so on. Presto! PageManager is provided with your SF4500
Series.

MyScan provides an impressive array of scanning controls and previewing
options:

¥ Monitor rendering capabilities
¥ Descreen
¥ Flip and Rotate
¥ Inversion of images
¥ A variety of filters
¥ Control brightness
¥ Gamma correction
¥ Reduction or magnification of images, and more.

The fact that these are image previewing functions as well as scanning
functions, means that you can see the results before you save the images
you create.
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Starting MyScan

The MyScan window will be displayed when you choose the MyScan
driver for scanning documents or photographs.

The following scanning instructions are only intended to introduce you to
scanning an image. This chapter explains how to start the MyScan software
and prepare to scan. 
To start the MyScan program:

1. Turn on your scanner (e.g. Samsung SF4500 Series) and PC.

2. Start Windows if not already started.

3. Start Presto! PageManager. You can also use any other TWAIN-compliant
image-editing application (e.g. Adobe Photoshop).

4. From the File menu, choose the Select Source option.

5. Select the latest version of MyScan from the Select Source dialog box.

6. Open the File menu, select the Acquire option. MyScan window will
appear.

MyScan Help

You can refer to MyScanÕs online help function for assistance. To access the
online help, open the Info menu on the MyScan window and choose Help.

On-line Help contains information about using the menus and commands
of MyScan. Use Help anytime you need information on how to use a
particular menu or command.

If you should encounter problems while using MyScan, consult your local
dealer or the nearest technical support for assistance.
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MyScan Window

When the MyScan window appears, you can select the appropriate scan
options for your scan document or photograph.

After adjusting the settings in the Scanner Control window, you may want
to preview the scanned image before saving the image. You can enhance the
image using tools in the Preview window.

Preview window
For details on the tools
in the Preview window,
see page 2.14.

Scanner Control window
For details on scan options in the
Scanner Control window, see page 2.5.

Menu
For details on sub menus,
see page 2.24.

Scan options

Image Enhancement Tools
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Scanner Control
Window

Obtains a low-
resolution copy of the
original document.

You can adjust the settings for the scanner to capture the image.

Scan Mode

Lets you select the mode that the
image is to be scanned in; True
Color RGB*, 256 Color*, Gray 256
Scales, Halftone B/W, Lineart
B/W. See page 2.6.

Resolution

Determine the amount of
information the scanner will
capture in a scanned image.
See page 2.7.

Scaling Factor

Enlarge or Reduce an
image as it is scanned. See
page 2.8.

Descreen

Minimize the transfer of
moir� patterns into your
image file. See page 2.11.

Filter

You can soften or sharpen
edges and boundaries of an
image. See page 2.10.

Highlight, Shadow, Gamma
Adjustment

Lets you adjust the light and
dark values within the selection
frame. See page 2.12.

Closes MyScan window, and
returns immediately to the
image editing application.

*These modes are available on
SF4500C only.

Scan Source
See page 2.6.

Scans the chosen area in the
Preview window. The image
will be transferred to your
application and will appear
on your screen.
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Scan Source

Displays your type of scanner: SheetFeed & Line, Shuttle, Flatbed. You do
not have to specify this menu. MyScan can automatically detect the scanner
type, and displays the type in this box.

The following pictures show some examples of the scan mode:

Gray 256 scales Halftone, B/W Lineart, B/W

Scan Mode

This menu specifies the mode that the image is to be scanned in.

True Color RGB*

Specifies 24 bit true color. In this scan mode, your scanner captures 24 bits
of color image information for every dot (pixel) in your resulting scanned
image. Therefore over 16 million colors are possible.

This image type uses the same color synthesis scheme used in computer
monitors and television. RGB simply stands for Red-Green-Blue; these are
the additive primary colors. Additive here refers to the addition, or mixing,
of light of different colors: mixing equal proportions of fully saturated red,
green, and blue light produces white light. This is the way that your color
television or color monitor produces white. Disk space required for saving
24-bit true color image is considerable. For instance, an A4-size 300-dpi true
color image may require 24 Megabytes (MB) of storage space.

256 Colors*

In this mode, only 256 colors are used to show the scanned color image. If
color is necessary, but high quality is not desired, choose this mode. Disk
space required is approximately 1/3 of that required to save 24-bit true
color images.

* These modes are available on SF4500C only.
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Gray 256 scales

8-bit grayscale. Images scanned in 8-bit grayscale will show up to 256
shades of gray. If high quality copies of photographs or other continuous
tone originals are desired, grayscale mode is a good choice.

256 Grayscales provides accurate representation of black and white, and
shades intermediate between black and white, for each individual pixel. It
actually provides just 256 shades, representing white by the value 255 and
black by the value zero, and representing the 254 progressively lighter
intermediate shades of gray by the 254 values from 1 through 254.

Halftone B/W

This image type uses different combinations of 1-bit black and white pixels
to fool the eye into seeing simulated gray scales. Because this image type is
only 1-bit (like B/W Document, lineart), the file size is smaller than gray
scale. The size of the image will be about the same as images scanned in the
B/W Document image type.

Lineart B/W

Single bit black and white images scanned in 1-bit Lineart show only black
or white. Lineart mode is generally the best choice for printed text or pen-
and-ink drawings. Since only 1-bit of black or white information is required
for each pixel, disk space required for saving lineart images is only about
1/8 of that required to save 8-bit grayscale images.

In both Halftone and Lineart modes, the resolution can only be set to 150, 200
or 300 dpi.
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The resolution can be measured in dpi (dots per inch). The higher the
resolution is, the finer the image detail and the bigger the image file.

Resolution

The resolution setting determines the amount of information the scanner
will capture in a resulting scanned image.
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If you are scanning a printed image for screen display only, you might want
to scale the image down to increase processing speed and decrease the file
size.

Scaling Factor

Allows you to automatically Enlarge or Reduce an image as it is scanned.
The default scale factor is 100%. Your selected scale factor, whose range is
dependent on your selected image type, affects the printed scan output. 

Scaling 100% Scaling 50%

300 dpi 75 dpi

You can select any one of the resolutions shown on the sub-menu according
to the scanner connected to your computer, or specify your own resolution
by selecting the Custom option which invokes the Custom Scan Resolution
dialog box.

MyScan allows you to set three more resolution settings by yourself.  Type
the desired resolution (in dpi) and click OK. These three settings will be
displayed below the Custom settings in the Resolution pull down menu, 
so you can choose these settings whenever you need.
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Common scaling options are given in percentages. The width and height
are scaled proportionally when the common scaling factors are used. In
order to scale to size other than the fixed sizes, select the Custom option in
the Scaling menu. The Custom Scaling dialog box will appear.
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The height or width can be entered separately by clicking on the link
graphic to break the link between the Height and Width fields.
Alternatively, you can change these values by directly adjusting the
selection frame. The default values initially shown in these text boxes are
the height and width of the default selection frame.

To change Height or Width text box values:

1. Insert the desired height and width values into the Height and Width
edit boxes.

2. The units of measurement may be changed to inches, centimeters,
millimeters, pixels, picas or percentages of the original image dimensions
by selecting the desired unit of measurement from the Units drop-down
list boxes, to the right of the Height and Width text boxes.

Output image file size is proportional to both Height and Width. Thus, if both
Height and Width values are exactly doubled, then the image area and image
file size will increase four-fold.

Maximum allowable image size settings are dependent on the amount of
space the software determines that you have to store the resulting image,
and the capabilities of your scanner hardware and software. 

Once you have confirmed or changed the size, resolution, and final scan
boundary settings, the scanning software determines the size of the resulting
scanned image and displays this information along with available hard disk
space.
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No Filter

This is the default filter option. No filtering will take place when using this
option.

Sharpen

Emphasizes the edges of an image. This option sharpens the image
boundaries by increasing the relative contrast between adjacent pixels. In
general, Sharpen Filters should only be used when you want to accentuate
the differences between one area and another.

Sharpen More

Futher emphasizes the edges of an image. This option produces a much
stronger contrast between two adjacent pixels than the Sharpen option.

Blur
Softens the image. This option smoothes out any sharp transitions in hue
between two adjacent pixels.

Blur More

Futher softens the image. Exactly the same function as the Blur option, but
even stronger. If you blur the image too much, you will risk losing texture
and depth.

Filter

Filter is typically useful for high-contrast images which soften or sharpen
edges and boundaries of an image.
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Descreen

If you choose halftone-printed graphic material as your object for scanning,
its halftone printing dot pattern may result in interference patterns
occurring in the resulting scanned image. The image may appear to have a
checkered, banded, or dotted appearance. These interference patterns are
called moire patterns, and Descreen preprocessing can minimize the
transfer of them into your image file.

Besides a default setting of None (no descreening), the Descreen selector
provides three grades of descreen preprocessing.

No Descreen
No descreening.

Art print (175 lpi)
Smoothes the fine dot pattern found in high quality art prints, and
magazines.

Magazine (133 dpi)
Smoothes the fine dot pattern found in glossy magazines made using
resolution higher than 200dpi.

Newspaper (85 lpi)
Smoothes the coarse grain pattern commonly found in newspaper images.

The preview display is not affected by the Descreen option. In order to see the
results of Descreen preprocessing, it is always necessary to choose Scan, and
then examine the output image after it has been passed to your imaging
application.
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Highlight, Shadow, Gamma Adjustment

You can adjust the highlight, brightness, shadow and gamma.

Highlight tool

Shadow tool

Scanner Gamma

Auto Adjustment

Auto Adjustment

In Grayscale image types, the Auto Adjustment facility provides a simple
control to adjust the light and dark values within the selection frame.

If the Auto Adj. box is checked, MyScan will automatically calculate the
optimal Highlight and Shadow values for the image inside the selection
frame. When this box is checked, the preview is immediately repainted to
show you the effect of the automatic highlight and shadow levels
preprocessing.

Highlight Control

The Highlight value represents the lightest value in an image. All pixels
above this point will be rendered as pure white. If you subsequently
broaden the highlight points on the Level Adjustment graph, the pixels will
be remapped within the new range, thus allowing you to see more detail in
the image.

The Highlight scroll bar allows you to manually and independently set a
highlight level. The default for the Highlight is 255, this is the maximum
range of brightness levels allowed within any given image. You can
increase or decrease the highlights in a particular image as needed by
adjusting this scroll bar. The value in the adjacent box will change in the
range 1 to 255 as the slider moves.
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Shadow Control

The Shadow value represents the darkest value in an image. All pixels
below this point will be rendered as pure black. If you subsequently
broaden the shadow points on the Level Adjustment graph, the pixels will
be remapped within the new range thus allowing you to see more detail in
image.

The default value for Shadow is 0, this is the maximum range of darkness
level allowed within any given image. You can increase or decrease the
shadows in a particular image as needed by adjusting this scroll bar.

Scanner Gamma Control

All optical devices such as monitors and scanners have some non-linearities
in their light sensitivity characteristics. MyScan provides Gamma
adjustment for you to compensate for these non-linearities in your scanner,
and produce better scanned images.

To change the gamma value, simply move the Slider to the left or right to
change the values in the adjacent text boxes. The value in the adjacent box
will change in the range  0.1 to 10.0 as the slider moves.

Ordinarily, good results can be obtained from your machine by leaving the
slider at its default value of 1.00.
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Preview Window

Frame Tool

Defines the boundaries
of the area to be
included in your final
scan. See page 2.15.

After adjusting the settings in the Scanner Control window, you may want to
enhance your image. You can choose any one of the enhancement tools in
the Preview Window. Following are the details about the tools used for
Preview Window.

Image Enhancement Tools

Use to adjust the Highlight,
Shadow, and Gamma settings.
See page 2.17.

Zoom Tool

Zoom in or out on an
image. See page 2.16.

Highlight and 
Shadow Tools

Make comparisons
between different areas
of the image. 
See page 2.17.

Flip/Rotate

Flips and rotates an image.
See page 2.22.

Invert

Inverts all the tone values so
that the original is exchanged
with its color complement.
See page 2.23.
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Preview
Starts a low resolution scan without committing the image to memory.
Refer to the Preview button, in the Scanner Control window, page 2.5.

Scan
Starts scanning the document into memory. Refer to the Scan button in the
Scanner Control window, page 2.5.

Show/Hide Scanner Control
A toggle switch which Displays or Hides the Scanner Control Panel.

The Shortcut Menu

This menu appears when you click on any point within the Preview
window using the right mouse button.

Frame Tool

After a preview image has been created, you can define the boundaries of
the area to be included in your final scan by using the Frame tool. 

Use the Frame tool to select a rectangular portion (selection frame) of  the
preview screen, or the entire preview screen, for the final scan boundaries.
When you choose the Scan button, only the area within the selection frame
will be included in the final scan.

To use the Frame tool:

1. Select the Frame tool by clicking the Frame tool icon.

2. Drag the cursor to the preview area and release the mouse button when
the selection frame is in position.

3. To adjust the selection frame size or shape, drag any edge or corner of the
frame in or out. Alternatively, hold down the Shift key and the mouse
key on one of the sides of the frame and then move the cursor
accordingly. This action will contract or expand the entire frame.
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4. To move the selection frame without changing its size or shape, place the
cursor within the selection frame and drag it to the desired location.

5. To create an entirely new selection frame, place the cursor outside the
existing selection frame and drag diagonally. The first selection frame
will disappear, while a new one is drawn. 

Further, if you hold down the Shift key and drag the mouse diagonally, the
sides of the selection frame resize proportionally. Therefore, a square
shaped frame is formed if a selection frame is created for the first time; or
the frame sides are kept in proportion while being resized. 

Zoom Tool

The Zoom tool allows you to zoom IN or OUT on an image within the
Preview window;  zooming in ( + sign appears on the zoom cursor)
enlarges the view of the active image so that you can work on small details.
Zooming out (- sign appears on the zoom cursor) reduces the view of the
active image when, for example, you want to compare several images.

To use the Zoom tool:

1. Select the Zoom tool by clicking the Zoom tool icon.

2. Drag the cursor to the preview area. The cursor will change to a
magnifying glass whenever it is in the preview space.

3. Zoom in (magnify an area) by positioning the cursor on an area of
interest in the preview area and clicking the left mouse button. The
preview area will be doubled in size. Click again and the area will again
be enlarged by a factor of 100%. By repeating this process, you can
enlarge the preview display of the image up to 800% of its original size.

As an alternative to the method stated above, select the Zoom tool and
then, while holding the mouse key down, drag the cursor over the area
you want to enlarge. A solid frame, defining the area of enlargement, will
appear while the mouse key is being held down. Upon release of the
mouse key,  the defined area will be enlarged.

4. Use the scroll bars to view hidden areas of the displayed preview image.

5. Zoom out by positioning the cursor  in the preview area and clicking the
right mouse button (or SHIFT + Left mouse button).

6. Double click with the Zoom tool to revert the image back to normal
viewing size (100%).

The Zoom tool does not affect the image produced by the Scan control. It only
affects the Preview Display.
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Highlight and Shadow Tools

The Highlight and Shadow tools allow you to make comparisons with
different areas of the image. These tools work in unison with the Highlight
and Shadow slider bars in the Scanner Control Panel. Therefore, using the
tools to make a change in contrast will result in the slider bars being
automatically adjusted to reflect these changes and vice-verse. 

To use either of tools, click on its respective icon. When the cursor is in the
Preview area, it assumes the form of the tool selected. When the Highlight
tool is selected, and you click on any point in the preview area, the
highlight level is set equal to the brightness level of the particular pixel
which makes up that point of the image. The preview image will be
repainted to show you the effect.

When the Shadow tool is selected, and you click on any point in the
preview image, the shadow level is set equal to the brightness level of the
particular pixel at the cursor position. The preview image will be repainted
to show you the effect.

To make a comparison between two points, letÕs take the Highlight tool as
an example:

1. Drag the dropper, while holding down the mouse key, to the point that
you wish to compare. The entire image will be repainted in such a way
that different pixel areas contrast more sharply. 

2. By successive  pixel selection, you can gradually find the brightest area of
the image. Upon releasing the mouse key, the image will be repainted to
show the total effect. 

Similarly, if you want to find the darkest area of your image,  use the
Shadow  tool to select successively darker pixels.

To activate one of the above functions, click on that icon and the dialog box
appears. At the top of each dialog box there are thumbnail representations
of the original and enhanced images (Samples 1& 2).

You can see the effects of  changes to a previewed image through the
Sample thumbnails, without committing yourself to full image processing.

Image Enhancement  Tools 

Level Adjustment Tonal Map
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Original is the thumbnail view for the previewed image, and Samples 1 & 2
are the thumbnail views for the images after they have been enhanced.
Samples 1 & 2 give you a means of comparing two enhanced images. Click
on the desired Sample to choose the required image and click OK to
finalize the selection.

Level Adjustment

The Level Adjustment dialog box shows the distribution of brightness
levels in your image. To adjust this histogram plot, drag the triangular
handles, located below the horizontal bar, to desired values. The left (black)
handle controls changes to the shadow levels. The right (white) handle
controls changes to the highlight levels. The middle (gray) handle controls
changes to the midtone levels.

By varying the Shadow points and Highlight points you can change the
relative shades and highlights of the image. The Shadow point represents
the darkest value and the Highlight point is the brightest value. The
Midtone point represents the Gamma setting for your particular screen. On
the histogram, the Shadow and Highlight scales are divided into 255 units.

Therefore, all pixels in the original that are darker than the current shadow
point are now completely black in the enhanced image. Conversely, all
pixels in the original that are brighter than the current highlight point are
now completely white in the processed image. 

Setting the highlight point to 200 renders all pixels greater than or equal to
200, on the original, completely white in the processed image. Similarly
setting the Shadow point to 200 renders all points less than or equal to 200,
on the original, completely black in the enhanced image.

Highlight control

Shadow control

Level Adjustment tab

Midtone (Gamma)
control
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The Midtone is a relative measure of the gamma of your monitor. The scale
for Midtone ranges from 0 to 255. The gamma curve is on a geometric
series. That means at a value of 255 it tends to infinity. The Midtone is
bound by the Shadow and Highlight terms and cannot exceed them at any
time. So, a gamma of 1 is equivalent to a Midtone of 128 providing the
Shadow is set to 0 and the Highlight is set to 255. Similarly, if the Shadow is
set at 200 (lower bound) and the Highlight is set at 220 (upper bound), a
gamma of 1 is equivalent to a Midtone of 210.

Operation:

1. Open the Level Adjustment dialog box.

2. On the histogram, use the mouse key to click on the Black, Gray or White
triangular indicators to make changes to the Shadow, Midtone and
Highlight respectively.

3. To see the changes and compare them to the original previewed image,
click on the Sample 1 thumbnail to see the enhanced image. 

4. To make a second enhancement for further comparison, click on the
Sample 2 thumbnail to see new enhancements to the original and thus
see a comparison between the thumbnails of Sample 1 and Sample 2. 

5. Click OK to accept the changes and leave the Enhancement dialog box.
Click Cancel to abandon any changes, and leave the dialog box. Click
Auto to allow the software to make appropriate highlight and shadow
adjustments.
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Tonal Map

If you select the Tonal Map, the following dialog box will be displayed.

The Tonal Map is yet another way to adjust Highlight, Midtone, or Shadow
levels in your images. When you open the Tonal Map dialog box, a Tonal
Map consisting of a diagonally straight line appears. Notice that at every
point on the default Tonal Map, the output shadow, midtone, and highlight
brightness levels are equal to the input shadow, midtone, and highlight
brightness levels.

The shape and slant of the Tonal Map represent brightness level ratios
between the input of the original image and the output image data. By
clicking on the Tonal Map line, a hand-shaped cursor will appear which can
be dragged in such a way as to alter the shape of the tonal map line. The
horizontal axis represents the original input brightness and the vertical axis
represents the enhanced brightness. Values of either scale range from 0 to
255.

If you deform the curve into a convex shape (above the original diagonal),
the enhanced image will be brighter than the original.

Tonal Map tab

Normal Image Lightened Image
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Conversely, if you deform the curve into a concave shape (below the
original diagonal), the enhanced image will be darker than the original.

Operation:

1. Click on the Tonal Map icon in the Preview window or the Tonal Map
tab in the Enhancement dialog box. The Tonal Map dialog box will
appear.

2. Click on the Tonal Map curve, a handle appears which can then be
dragged to alter the shape of the curve, as described above.

3. Click Save to save the changes as a customized setting.  A Save As dialog
box will appear upon selection of this button. Enter the name for the
customized curve and click OK. 

4. Or, select the Load button to load a previously saved Tonal Map. An
Open dialog box appears for you to open the desired files.

5. Or, click the Reset button to return the Tonal Map to the default diagonal,
as in the original.

6. Select the Histogram button to see a histogram of the changes made.

7. Select OK to accept all the changes, or Cancel to abandon all unsaved
changes. 

Normal Image Darkened Image
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Flip/Rotate

This button flips and rotates an image. The flipping mechanism flips an
image about the horizontal or vertical axis. The rotation mechanism rotates
an image clockwise in 90O increments.

Click this icon to activate the Flip/Rotate dialog box, which illustrates the
effects of rotation and flipping.
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Invert

This function inverts all the tone values. This effect is similar to using the
Tonal Map to tonally invert the image.

Normal Image Inverted Image

Preview Image Size

By clicking and dragging the horizontal and vertical boundaries of the
Preview frame you can adjust the preview size of the scanned image.
You can change the units of the rulers bordering the Preview area by
opening the Settings menu and choosing Unit. A pop-up list of 6 units of
measurement will then be displayed, from which you can select a preferred
choice.
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Menus

Setting

The Setting menu in the MyScan window handles all the loading, saving,
resetting, defining preferences, etc.

Information menu

Setting menu

Restore the saved settings

Save the current settings

Save the current settings under another
file name

Reset to the original default settings

Save the current settings as default

Reset to the factory settings

Controls the monitor’s Gamma value

Conducts a connectivity test with the
scanner

Set the size of the preview area

Select the units of measure

Sets MyScan’s preferences

Choose Setting in the MyScan window. A pull-down sub menu will appear.
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Load Settings

The Load Settings option allows you to load previously saved scan
settings. The Load Settings dialog box will appear asking you to select the
appropriate file. Select the desired file from the filename list, then click OK.

Save Settings

If you have loaded settings from a previously saved file and you make
changes to those settings during the course of your scanning, use the Save
Settings option in the Settings menu to save the changes. The settings will
be updated with your changes.

Save Settings As...

This option allows you to save changes to the current settings under a new
file name. 

If you have not selected any settings file through the Load Settings option,
you will be prompted to save the current settings under a new file name.

Default Settings

This option automatically reloads and implements the default settings. 
The Default Settings will automatically be implemented, overwriting  any
changes you have made. 

It is advised that you save any changes under a settings file before you
select the Default Settings.

Save As Default

Choose Save As Default to create a settings file using current settings as a
custom default settings file. 

Reset Settings

To reset MyScan settings to the manufacturerÕs default settings, select Reset
Settings.

Monitor Gamma

Monitor Gamma calibration allows you to selectively adjust the brightness
in the midtone areas of your monitor display colors so that they will closely
approximate the color detail of your original images. For details on How to
Adjust the Monitor Gamma, see page 2.28.

Setup Scanner

This option resets the driver port addresses.
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Preview Size

Allows you to set the maximum area to be scanned.  Upon selection of this
option, a sub menu appears as shown below:

Select the desired size.

Unit

Select the units of measurement for the image from the Unit sub menu.
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Preferences

This option allows you to setup some pre-scanning conditions.

Setting the Preferences

Select Preferences from the Settings menu. The Preferences dialog box will
appear as follows: 

From the dialog box, confirm or change the following settings: 

Keep preview image

Selection of this check box causes the preview image which was created
from the last preview, to be re-displayed the next time MyScan is started.

Keep current settings

Selection of this check box causes all selections and control settings which
were in effect at the time of the last scan to be retained and re-established
the next time MyScan is opened. If Keep Current Settings is not checked,
then the factory preset selections and settings will appear the next time
MyScan is opened. (Factory preset selections and settings may also be
obtained at any time by choosing Reset Settings in the Settings menu.) 

Preview with current settings

Selection of this check box allows you to preview an image which shows
the effects of all of the MyScan pre-scan options you have selected for that
image.

Scan Quality feature is not available for SF4500 Series.
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How to Adjust the Monitor Gamma

Monitor Gamma calibration corrects for differences in monitors due to age
or manufacturing processes. It should be set periodically to compensate for
changes in a monitor during its lifetime. This command allows you to
selectively adjust the brightness of the midtone areas of your monitor
display so that it closely approximates the color detail of your original
images. 

1. Open the Setting menu and choose Monitor Gamma. The Monitor
Gamma dialog box will be displayed:

2. Ensure the Keep R, G, B gamma values the same check box is checked
(default), in order to keep the value in each channel the same. Therefore,
adjusting the Red value will automatically make the Green and Blue
values equal to the Red. 

3. Click the Keep R, G, B gamma values the same check box to remove the
check mark, this will allow you to adjust each channel individually. 

4. Shift the sliders to adjust the gray level. You must try to match the
banded areas with the Gray box in order to achieve the best possible
gamma for your monitor.

Correcting Grayscale Gamma

The best approach for correcting grayscale gamma values is to eliminate, as
much as possible, any differences in the shading of the Gray sample by
using any or all of the scroll bars provided on the right of the color
samples. When the Gray sample has a uniform appearance, click OK to
complete grayscale Monitor Gamma correction. 
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Correcting Color Gamma

The best approach for correcting color gamma values is to eliminate, as
much as possible, any differences in the shading of the color sample by
using the slider bars provided on the right of each of the samples. ItÕs
important that you maintain the gray balance while adjusting the colors,
ensuring that the gray is not tinted. When the Gray sample has a uniform
appearance, click OK to complete Color Monitor Gamma correction. 

You can also experiment by changing gamma values for individual color
samples. Click Default to return to the Default Monitor Gamma settings.
Click the Cancel button to quit the Monitor Gamma dialog box without
making any changes.

You may observe alternating light and dark shaded or banded areas in the
Red, Green, Blue and Gray samples.

Info

The Info menu displays information about the scanner and software.

Activates the on-line help

Shows information about the scanner

Shows or Hides the ruler

Shows version information



2.30

Context Sensitive Help

This feature displays a rectangular call-out box describing a tool or function,
when the cursor is placed over a tool or function.

For example, if you place the cursor over the Resolution menu on the
Scanner Control Panel , a rectangular call-out box will appear, thus:
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Presto!
PhotoAlbum
Presto! PhotoAlbum helps you create personalized photo
albums that organize and preserve your photos
forever... electronically. Add your favorite photos from
digital cameras, scanners or the internet. Decorate
them with frames, shadows, ornaments, captions and
background textures. Photos can be shared with family
and friends via the Internet. You can create desktop
wallpaper or slide shows.

3
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Overview

Introduction

If you have a digital camera or color scanner, you can turn your computer
into an electronic photo album. Presto! PhotoAlbum can input photos from
your digital camera or scanner. And Presto! PhotoAlbumÕs user friendly
interface makes it easy for anyone to author an album.

With this software, you can save your memorable moments and even add
sounds or music to photos and albums. Full libraries of frames, textures,
and ornaments for decorating the album pages are provided. Several tools
for creating artwork and adding text to the photos are also included with
Presto! PhotoAlbum.

Presto! PhotoAlbum is a 32-bit native Windows 95 application that imports
color images in standard file formats such as .BMP, .JPG, .TIF, .PCX,
FlashPix, and Photo CD. Presto! PhotoAlbum also supports IntelÕs MMX
technology.



3.3

If you want to create a new album, click the Create button. If you want to
edit an existing album, click Edit. To view and enjoy an album, click View.
The functions of the three button commands below the Presto! PhotoAlbum
software title are:

EXIT: quits the software.

HELP: opens the Presto! PhotoAlbum online help system.

MUTE: turns the sound effects ON or OFF.

Starting Presto! PhotoAlbum

From the Windows 95 Start menu, select Programs and then Presto!
PhotoAlbum from the submenu that appears. The Presto! PhotoAlbum
opening screen will appear. Click on one of the three buttons at the top of
the screen to enter Presto! PhotoAlbum.
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Creating a 
New Album

PREVIOUS TEMPLATE CUSTOM

Creating a New Album

Click the Create button in the opening screen to create a new album. The
top of screen changes with the following buttons:

Using an Album Template

Presto! PhotoAlbum provides sample cards and albums for use as templates.
Or, you can use a previously created album as a template. The format of the
selected album will be the same, but new frames will appear for you to
enter photos.

To compose your own album, you may select one of the templates or
existing albums and change its content as you desire. Or you can customize
a new album by yourself. 
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To select a template or pre-existing album:

1. Click the Create button.

2. Click the Template button. The Select An Album dialog box will appear.

3. Select the type of album you want to create from the category icons to the
left of the dialog box (including Cards and Samples).

4. Select an album from the album thumbnails. The lower part of the dialog
box displays the number of pages, the date the album was last saved,
and an album description. Click the Play button to listen to any sound or
music files that may be attached to the album. To delete an album, drag
the album thumbnail to the trash can.

5. Click OK, or double click the album thumbnail.

The screen will now move on to the next editing step. Please refer to the
Editing the Album section before inserting photos into the album.

2. When the Book Style button in depressed, you may select a book style
for the new album.

Defining a New Album Format

1. If you want to create a new album without using a template or existing
album format, click Create, then the Custom button. The Select Book
Style dialog box will appear:
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3. Click the Ring Style button to select a ring style for fastening the pages
in the album.

4. Click Background to select a background pattern for the desktop around
the album.

5. Click Preview to display a preview, according to your selection in the
preview window.

6. Click OK.

Create Your Own Template

In addition to the sample and existing albums, you can create templates to
produce new albums. For example, you may use one of the pages you like
from an existing album to create a separate album template and use the
format of that page for the entire new album. Or you can make a new
album and use its format as a template.

To use one or several pages in an album as a new template, follow these
steps:

1. Double click the album icon that contains the page(s) youÕd like to use.

2. Choose Save As from the Album menu and rename the album.

3. On the editing screen, delete pages you donÕt need for the new template
with the Delete Page command in the Page menu. The original album
will remain unchanged.

4. Return to the opening screen by selecting the Restart command from the
Album menu.
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5. Click Create.

6. Click the Template button and locate the new album you saved in step 3.

7. After the album template is loaded into the editing screen, make any
necessary changes.

8. Use the commands in the Page menu to rearrange the pages in the
album. For example, you may duplicate pages with different formats,
change the sequence of pages with different formats, etc.

9. Save the album again.

If you want to generate a completely new album and use it as a template,
follow these steps:

1. Click Create in the opening screen.

2. Select Custom, and define the book and ring styles for the new album.

3. After the album is created in the editing screen, add all the elements you
want to the page, including frames, effects, ornaments, textures, etc.

4. Create as many pages of different formats as you want to use for the
album template.

5. Use the commands in the Page menu to rearrange the pages in the
album. For example, you may duplicate pages with different formats,
change the sequence of pages with different formats, etc.

6. Select the Save As command from the Album menu to save the album
with a new name.

The next time you want to use this album template, simply open this album
as a template by clicking Create, and then the Template button in the
opening screen.
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How to Share Albums on the Internet

If you want to share the album with others on the Internet, simply copy the
entire folder generated by the Deliver command of the Album menu.
Others can enjoy the album using the VIEWER.HTM file by using a
network browser such as Microsoft Internet Explorer v3.0 or Netscape
Navigator v3.0 (or later).

How to Save Disk Space Used for Albums

Any album that has been created is saved in a folder with the album name
under the \albums sub-directory of Presto! PhotoAlbumÕs program directory.
This folder contains more sub-folders for carrying the format and effects
you have defined and produced in the album. All these files may occupy a
lot of space on your disk.

If you are sure that an album will not be changed, and you will not have to
edit it anymore, follow the steps below to save disk space:

1. Load the album onto the editing screen in Presto! PhotoAlbum.

2. Choose Deliver from the Album menu.

3. When the Deliver dialog box appears, locate the drive you want the
album stored on, and enter a new name to create a new folder.

4. Click the OK button.

5. Use Windows Explorer or a similar application to locate the album folder
under the \albums sub-directory of Presto! PhotoAlbumÕs program
directory.

6. Delete the entire album folder.

Although this is a good way to save disk space, note that once you have
deleted the album folder under the \albums sub-directory, you can no
longer edit the album. Therefore, the safest way to store an album is to
make a backup copy of the album folder to floppy disks, or another storage
medium, before you delete it from the \album sub-directory.
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Use Your Own Pictures as Ornaments

If you want to use a picture youÕve made as an ornament object, follow
these steps:

1. Make sure the four pixels (arranged as a 2x2 pixel square) at the upper
left corner of your picture are the same color as the background.

2. Locate the picture in the Photo Browser.

3. Drag the picture thumbnail into the page and release the mouse button
outside the frame(s).

The background color in the picture will become transparent after you have
inserted the picture to the page. The clip art can then be edited as a general
ornament object.
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Editing Your Album

Opening an Album

To open an existing album for editing, click the Edit button in the opening
screen. When the Select An Album dialog box appears, locate the album
you want to edit. To open your photos in an image editing program before
inserting them into an album, double click the image thumbnail in the
Photo Browser. The image will open in the default image editing
application on your computer.

Overview of the Editing Screen

After youÕve specified a book style for creating a new album, or youÕve
selected an existing album for editing, the editing screen will appear.

Tool Box

Photo
Browser

Object Pool

Status Bar
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The editing screen can be opened by choosing the Presto! PhotoAlbum
Editor from the Presto! PhotoAlbum program folder. A blank album will be
loaded in default if you didnÕt select or create one from the opening screen.

Album Page

This is where you can inspect each page and perform any necessary
editing. If you select the Full Screen command from the View menu, the
album page will be enlarged to the entire screen for clear observation of the
editing effect. All other screen elements will be hidden. Press the Esc key to
restore the editing screen.

Toolbox

The Toolbox contains five editing tools. You may use these tools to select,
move, rotate and resize an object in the page, draw free-hand lines, add
text, or align the text along a specific path.

Photo Browser

The Photo Browser can display thumbnail copies of the photos that you
want to place into the album.

Commands

Change DirectoryLast Folder

Photo
Browser

Acquire

Scroll Buttons

P
re

s
to

! P
h

o
to

A
lb

u
m



3.12

Commands Click this button to bring up commands for inputting
photos, opening photos, setting the photo display
options, etc.

Recent Folders Click the down arrow to display a list of folders that
were recently used in the Photo Browser.

Photo Browser Displays the thumbnail copies of photos included in the
selected folder.

Change Directory Locate a new directory from which to load photos for
editing.

Acquire Input photos using a TWAIN hardware device.

Scroll Buttons Scroll through the Photo Browser to display the photo
thumbnails not currently visible.

Object Pool

The Object Pool allows you to select frame style, special effect, ornament
and texture to add to the pages. The buttons lined up horizontally are the
categories available for each item.

Status Bar

The status bar contains the message line, palette window ON/OFF control
and page control buttons.

The message line displays a message about the item the pointer is currently
on.

The button located at the left of the status bar can Hide or Display the Title
and Menu Bars on the screen. This function is the same as selecting the
Menu And Title command from the View menu.

Hide or Display the Photo Browser. This function is the same as
selecting the Photo Browser command from the View menu, or
pressing F5.

Hide or Display the Toolbox. This function is the same as selecting
the Toolbox command from the View menu, or pressing F6.

Hide or Display the Object Pool. This function is the same as selecting
the Object Pool command from the View menu, or pressing F7.
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The page control buttons can locate a page you want to edit in the album.
You can go to the first (Home), the previous, the next, the last (End) or any
page you specify (Goto). When you click the Goto button, you can select
the page number you want to locate by dragging the slider in the pop-up
dialog box. The illustration at the right end of the status bar displays the
current page number and the total number of pages in the album.

The functions of the Page control buttons are identical to several Page
menu commands: Next Page, Previous Page, Cover Page, Last Page and
Goto/Find Page. Clicking the right mouse button on any empty place on
the page (with no object selected) brings up a menu with these commands.

The status bar can be hidden or displayed by selecting Status Bar from the
View menu, or by pressing the F8 key. To hide all the palette windows on
the editing screen, including the Photo Browser, Object Pool, Toolbox and
Status Bar, choose Hide All from the View menu, or press the Tab key.

Selecting a Texture for the Page

Presto! PhotoAlbum can cover the page with a specified texture pattern. This
produces an interesting appearance, almost as if it were made of that
material.

Once you apply texture patterns to the pages, the texture patterns will not
be removed when you clear the objects on the pages. 
To apply a texture pattern:

1. Click the Texture button in the Object Pool.

2. Select the Texture category from the row of category buttons.
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3. Choose the texture pattern you want to use.

4. Drag the Texture icon inside the page, and release the mouse button
within the page.

If you drag the texture icon to the desktop area outside the album page, the
texture will be applied to the entire desktop as the background of the
album.

You can also apply the texture to an object generated by Paintbrush, Text,
and Text Along Path tools. All you need to do is to select the object and
drag the desired Texture icon into it.

Adding Frames to the Album

Presto! PhotoAlbum provides various frame styles with different colors and
shapes.

Once you have inserted a frame onto the page, you can move, resize, and
rotate it with the tools in the Toolbox. Read Using the Tools, page 3.20, for
details.

Frame Dimension Adjustment

To adjust the frame dimensions to fit the photo size, first select the photo,
then click the right mouse button and select the Make Matching Frame
command from the pop-up menu.

If you have selected a predefined album format, you may change the frame
style for an individual page. If you have defined a new album, you can
create a frame and insert a photo into it, however, you donÕt have to create
a frame to insert a photo into your album. 
To add frames to the pages:

1. Click the Frame button in the Object Pool.
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2. Select the frame category from the row of category buttons.

3. Choose a frame style.

4. Drag the Frame icon inside the page, and release the mouse button where
you want to place the frame.

Adding Photos to the Album

The instructions in this section will help you input photos from a TWAIN
hardware device, load existing photo files from disks, and place photos into
an album.

Loading Existing Photo Files

If you have all the photos you want in a specific folder or directory, you can
load them into the Photo Browser. Then you can view their thumbnails and
insert them into the album.

If the folder or directory has recently been located in the Photo Browser,
click the down arrow from the Recent Folders pull-down list to recall it. If
not, click the Change Directory button to browse for it.

Presto! PhotoAlbum can recall a maximum of nine files. You can adjust this
setting (between one and nine) in the Number of Recently Visited
Directories option in the Option box invoked from the Commands menu.

If you want to use a photo as an ornament object, hold down the Ctrl key
and drag the photo thumbnail into the page. The background color will
become transparent.

Some of the clipart photos included with Presto! PhotoAlbum can be
modified with a transparent background. Hold down the Ctrl key while
dragging an image from the Photo Browser to create your own clipart.
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Acquiring Photos

Presto! PhotoAlbum supports the TWAIN driver interface. This gives you
access to images from any A TWAIN device, such as scanners. As long as
the input device provides a TWAIN driver, it will work with Presto!
PhotoAlbum.

You may input photos from a digital camera or scanner supporting TWAIN
interface thatÕs been installed on your system. If your TWAIN device is
capable enough, you can input multiple photos at one time.

Before you input photos with a digital camera or scanner, you should
install its drivers by referring to the manual that came with the device. To
input photos to Presto! PhotoAlbum:

1. Use the Change Directory button to locate the directory used to hold the
new input photos.

2. Click Commands and choose the Option command from the pop-up
menu. The Option dialog box appears.

3. In the Default File Name for TWAIN Acquire option, type in the first
five characters for the file names of the new input photos and select the
file format from the pull-down list.

The file names will automatically be assigned sequential 3-digit numbers
after the first five characters.

For some file formats, you may click the Option button to further specify
their format options.

4. If you want the software to correct the color of the input photos, enable
the Apply Auto-tuning Before Saving option.

5. Click OK to close the dialog box.

6. Open the Commands menu and choose the Select TWAIN Source
command. A dialog box appears that lists all the TWAIN sources
installed on your system.

7. From the list of TWAIN devices, select the one you want to use, and click
the Select button. You can select MyScan provided with your SF4500.

8. Choose Acquire from the Commands menu again, or click the Acquire
button on the Photo Browser.

A dialog box will appear.

After the input process is done, thumbnail copies of the new photos appear
in the Photo Browser area for further editing.
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Opening a Photo

A photo loaded in the Photo Browser can be opened in an image
processing application for further editing. You can specify the software you
want to use for editing the photos, or the system will choose an appropriate
option for you. To specify an application for editing photos:

1. Click the Commands button.

2. Select Option from the pop-up command list. The option dialog box
appears.

3. In the Editing Program option, type in the path and filename of the
software, or click Browse to select it from a dialog box.

4. Click OK.

To open a photo, you may double click its thumbnail, or click Commands
and then select the Open option from the Photo command.

The Photo command also provides options for deleting the selected photo
(Delete) and displaying information about the photo (Properties).

Adding Photos to the Pages

The only way to add photos to the pages is to drag the thumbnail copies of
the photos in the Photo Browser into frames or onto the pages. The photo
in a frame can be changed at any time as long as you drag another photo
from the Photo Browser into the frame. 
To add a photo into the frame:

1. Click on the frame you want to use.

2. Locate the photo you want to insert from the Photo Browser.

3. Drag the thumbnail of the photo into the frame.

4. Release the mouse button.

You can also add all the photos, in alphabetical order of their file names, in
the Photo Browser into the album at one time with one simple step. After
you have defined the frame style(s) for all the pages, open the Album
menu and select the Put All Photos command. The photos will be inserted
automatically. You can add as many pages as you desire.
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Adding Ornaments to the Pages

Presto! PhotoAlbum provides plenty of ornament objects to make page
decoration easier for you. An ornament object can be placed anywhere on
the page, and may be resized or rotated. Please refer to Using the Tools
section for details on moving, resizing, and rotating an object. 
To add an ornament object to the page:

1. Click the Ornament button in the Object Pool.

2. Select the ornament category from the row of category buttons.

3. Choose the ornament you want to use.

4. Drag the ornament object icon onto the page, and release the mouse
button where you want to place the object.

Adding Shadows to an Object

In Presto! PhotoAlbum, you may create shadows on a photo or ornament
object. Once the shadow is generated, it is attached to the object. Any
change to the object effects the shadow. 
To create shadows for an object:

1. Select the object you want shadows added to.

2. Click the Effect button in the Object Pool.

3. Select the Shadow icon with the depth you want to use for the object.

4. Drag the Shadow icon onto the selected object and release the mouse
button.
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To remove the shadow from an object:

1. Select the object whose shadow you want to remove.

2. Click the Effect button in the Object Pool.

3. Select the first Shadow icon (the one without shadow depth).

4. Drag the Shadow icon onto the selected object, and release the mouse
button.

Setting Object Transparency

To apply transparency to the photos, ornaments or drawn objects on the
album pages, follow these steps:

1. Select the object you want to apply transparency to with the Selection
Arrow tool.

2. In the Object Pool, click on the Effect button and select the Transparency
category button.

3. Decide the transparency percentage needed for the object.

4. Drag the icon of chosen transparent percentage to the object and release
the mouse button.

Defining Linking Feature for Objects

You may define the linking feature for photos, ornaments and drawn
objects, so the specified page will be displayed when the object is clicked
during the playback process.

1. Select the object you want to assign a linking page to.

2. Click the right mouse button and select Properties from the pop-up
menu.

3. Enable the Link Page option.

4. Drag the slider to set the page number, or click on a page control button
to choose the first, previous, next or last page for linking.

5. Click OK.

P
re

s
to

! P
h

o
to

A
lb

u
m



3.20

The tools in the Toolbox enable you to create simple artwork to decorate
your album.

Selecting and Moving an Object

The Selection Arrow allows you to select an object and move the object to
another location on the pages. Select an object when you want to edit or
move it.

To select an object, click the Selection Arrow icon in the Toolbox, move the
mouse pointer to the object you want to select, and click. A dotted outline
will appear around the object. Click on any empty space on the page to
deselect an object.

To move an object, place the mouse pointer onto a selected object and drag
it to the desired position.

Resizing and Rotating an Object

The Object tool allows you to resize and rotate an object on the page.
Whenever an object is selected, the changes made will be applied to the
object and anything attached to it, such as a frame or shadow.

You can also move the selected object by dragging it inside the object while
using the Object tool. 
To use the Object tool:

1. Select the object you want to resize or rotate with the Selection Arrow.

2. Select the Object tool in the Toolbox. A rectangle with a right handle
surrounded by nine small square nodes appears around the object.

3. To resize the object, place the mouse pointer on any of the nodes and
drag it in the direction you want to expand the object.

4. If you want to rotate the object, drag the node on the right handle in the
direction you want to rotate the object. Press and hold the Shift key
while dragging the mouse to rotate it in 45 degree increments.

5. After you select another object or tool, the rectangle and rotating handle
will be removed.

Using the Tools
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Using the Paintbrush

This tool allows you to draw lines as if you were drawing with a real
paintbrush. 
To use the paintbrush:

1. Click the Paintbrush tool.

2. Double-click the tool icon to open a dialog box for setting Paintbrush
options.

Specify the size and color of the paintbrush. Drag the Size slider to set
the brush size. Click inside the color block to change the color in the pop-
up dialog box.

3. Place the mouse pointer at the point you want to start tracing your line.

4. Press and hold the left mouse button.

5. Drag the mouse pointer along the line path you want. The line appears
along the cursor path as you drag.

6. Release the mouse button where you want the line to end.

Adding Text to the Pages

You can enter text anywhere on a page with the Text tool. Presto!
PhotoAlbum supports all the fonts installed in Windows 95, and supplies
several additional fonts suitable for producing artwork.

The Text tool provides options for selecting fonts, font styles, and character
sizes. You may apply text envelopes to create variations on the text shape.
After inputting text, you can reshape it by changing its dimensions. 
To enter the text:

1. Click the Text tool.

2. Click the cursor where you want to place the text. A Font dialog box
appears.
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3. Select the font, the font style, and the character size. The Sample box will
display an example of the selection you made.

4. In the Effects window, select the text color from the Color option. Click
inside the color block to open a dialog box for selecting color.

5. Click the down arrow in the Envelope pull-down list to display a list of
envelope shapes.

6. If you want the text character to be placed vertically, enable the Upright
option.

7. Enter the text in the Text box.

8. Click OK. to input the text.

9. The text will appear on the page in the shape of the envelope you
selected. A rectangle with eight square nodes surrounds the text. Drag
the nodes to change the shape and size of the text.

10. Double-click the mouse button to fix the text shape.

The text will automatically be selected for further editing, and can be
considered an object for all editing actions.

Hold the Shift key while dragging the nodes on the corners to resize the
rectangle as square.



3.23

Adding Text Along a Path

The Text Along Path tool allows you to insert text on the page and place
the text along a defined curved path. To complete this effect, you must
define a curved path and adjust the text position along the path. 
To generate text along a path:

1. Select the Text Along Path tool.

2. Click the cursor where you want the text to start.

3. When the Font dialog box appears, enter the text as you would when
using the Text tool.

4. Select the text to be placed vertically (upright) or rotated according to the
curve path in the Effect option.

5. Click OK to close the dialog box.

6. Place the mouse pointer where you want to start drawing your path.

7. Press and hold the left mouse button to set the beginning of the path. Do
not release the mouse button.

8. Drag the mouse pointer in the direction you want the curve drawn. As
you drag, two control points appear and move in opposite directions
from the node. The distance between the control points and the node
determines the height or depth of the curve. The angle of the control
points determines the curveÕs slope.

9. When the control points are in the desired position, release the mouse
button.

10. Repeat step 7 to set the other end of the first curve segment you want to
create. A second node will be connected to the first node.

11. Drag your mouse to generate two control points for this node.
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12. Release the mouse button. You may drag the nodes and control points
to adjust the shape of your curve segment.

If you did not drag from the nodes to generate control points in
previous steps, you may hold the Shift key and drag from the
nodes to create control points at any time.

13. Click and drag the pointer outside the nodes and control points to form
another adjacent curve segment to link with the first one. Repeat steps
10 through 12 to complete all the segments in the curve which you want
to create.

Before fixing the curve segments, click on any node to activate the
control points of the connected curve segment and adjust the curve.

To remove the last node generated, hold the Ctrl key and click the left
mouse button.

To create a closed area with the curve segments, hold the Shift key and
click the right mouse button to generate a new segment.

14. When you are satisfied with the shape of your curve, double click the
mouse button to fix the curve.

The text will automatically be selected along the path you defined. It can be
considered as an object for all further editing.

If you do not drag to generate control points for the nodes, the drawing
will become a straight line.
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Editing Pages and Photos

The Page and Photo menus provide editing functions such as copy, cut, and
paste. These commands are often used when you need to rearrange the
content of the album. You can add, remove, copy, and clear pages or photos
with these commands.

Editing the Pages

The editing commands under the Page menu are used for changing the pages.

New Blank Page

The New Blank Page command allows you to insert a blank page after the
current page. To add a new page after the current page, choose New Blank
Page from the Page menu.

Repeat Current Page

The Repeat Current Page function enables you to reproduce the content of
the current page onto a new page. When you execute the Repeat Current
Page command, a new page appears on screen containing the same content
as the page before.

Copy Page

The Copy Page function enables you to make a copy of the current page
and place it on the Windows clipboard. The original page is unaffected by
the Copy Page command. Then you could use the Insert Page command to
move the clipboard contents to another page. Only the last copied content
resides in the clipboard. 
To copy a page:

1. Turn to the page you want to copy.

2. Choose Copy Page from the Page menu. A copy of the current page then
resides in the clipboard.

Insert Page

The Insert Page command inserts a new page before the current page, and
places the contents of a page on the Windows clipboard. The command
works only when there is already content on the clipboard. To insert a new
page with clipboard content, open the Page menu and select Insert Page.
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Delete Page

The Delete Page command permanently removes the current page and all
of its content. After executing the Delete Page command, the current page
is removed, and the next page appears on your screen.

Clear Page

The Clear Page command removes the contents of the current page,
including the ornament objects and the photos with their frames and
shadows, but the page itself still remains.

Editing the Photos

The Editing commands under the Photo menu are used to make changes to
the photos or objects.

Cut

The Cut command removes a photo or object and places it on the Windows
clipboard. You can use the Paste command to place the clipboard contents
back onto the album, or paste it into another application. Only the last cut
content resides in the clipboard. 
To cut an object, follow these steps:

1. Select the object you want to remove.

2. Choose Cut from the Photo menu.

Copy

The Copy function enables you to make a copy of the selected object and
place it on the Windows clipboard. The original object is unaffected by the
Copy command. You could use the Paste command to move the object last
copied on the clipboard to the same or another page. Only the last copied
object resides on the clipboard. 
To copy a page:

1. Select the object you want to copy.

2. Choose Copy from the Photo menu.
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Paste

The Paste command pastes the clipboard contents onto the current page.
The command works only when there is already something on the clipboard.
To paste, follow these steps:

1. Choose Paste from the Photo menu. A selection outline appears
containing the content of the clipboard.

2. Move the mouse pointer into the selection outline.

3. Drag the pasted object to the location on the page where you want to
place the object.

4. Click the left mouse button outside of the selection outline to paste the
object.

Duplicate

The Duplicate function enables you to reproduce the selected object on the
current page. To execute the Duplicate command, first select the object you
want to duplicate, and then choose Duplicate from the Photo menu.

Delete

The Delete command permanently removes the selected object. To execute
the Delete command, first select the object you want to remove, and then
choose Delete from the Photo menu.

Clear Photo

The Clear Photo command removes the photo from the current selected
frame.
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Arranging Overlapping Photos

When two or more photos or objects are overlapped on a page, you can
change their overlapping sequence with commands in the Photo menu.

Bring to Top moves the selected photo to the very top of all the
overlapping photos. Send to Back moves the selected photo to the very
bottom of all the overlapping photos. Move Forward places the selected
photo over the one that is currently on top of it. Move Backward places the
selected photo under the one that is currently beneath it.

Click the right mouse button on a photo to bring up a submenu listing
these commands, as well as the Delete, Photo Tuning, and Properties
commands.

The Photo Tuning dialog box provides you with a preview mode to adjust
dark, midtone and light areas of a photo in hue or brightness/contrast. It
enables you to compare the original colours and any changes youÕve made. 
To fine tune the colours of a photo:

1. Select the Photo Tuning command from the Photo menu. The Photo
Tuning dialog box appears.

Tuning Colours of a Photo

There are eight photo previews in the left portion of the Photo Tuning
window, each showing the different effects of hue and brightness
adjustments. The photo thumbnail in the middle is the original photo.
When you click on any of the surrounding thumbnails, it mouse to the
middle and becomes the currently selected photo.
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The six previews at the top and bottom rows of the sample image reflect
the hue adjustments to the middle photo. The two previews at the left
and right of the sample photo show brightness adjustments.

2. To define the adjustment level as slight or more pronounced, drag the
vertical slider at the lower right of the dialog box. Your settings will be
immediately reflected in the previews.

3. Click on any preview that best matches your needs. The selected preview
will move into the middle position, and the surrounding previews will
change accordingly.

4. The default setting for the area to be changed in the photo is Full. To
change only the light, midtone, or dark areas of the photo, select the
Highlights, Midtones, or Shadows options, respectively.

5. To change the photoÕs brightness and contrast, click the
Brightness/Contrast option. The three top previews reflect enhanced
contrast. The three bottom previews reflect reduced contrast. The three
left previews reflect decreasing brightness. The three right previews
reflect increasing brightness. Use the same procedure to adjust the
brightness and contrast of the photo.

To return to the original photo as the sample image, click the Reset
button at the bottom of the dialog box.

6. After you obtain a satisfying image, click OK to start the process of
adjustment, or click Cancel to abandon the process.
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1. To add background music to the album, click the button.

A dialog box appears for selecting a wave or midi file to attach to the album.
Locate the file, and click OK to attach the music.

2. To record some sound effects or a narration about the album, click the
button. When the Audio Format dialog box appears, set the sound
elements for the format of your sound file.

After you click OK, you may start to record with your microphone.

When you finish recording, click the button again to stop recording.

Click the button to listen to the recording.

Adding Sounds and Music

In the editing screen of Presto! PhotoAlbum, you may add sounds or music
to an album, a page or a photo. In the Properties option under the Album
menu, you can insert sounds or music for the album. In the Properties
dialog box under the Photo menu, you can insert for the current selected
photo. And with the Background Music command under the Page menu,
you can insert for the current page.

Adding Sounds and Music to an Album

To assign a background music and record a sound effect or narration for an
album, open the Album menu and select the Properties command, The
Album Information dialog box appears.

3. Click OK to save the settings.
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Adding Sounds and Music to a Page

When you want to assign music to the current page, select the Background
Music command from the Page menu. When a dialog box pops up, select a
music file to attach to the page.

Adding Sounds and Music to a Photo

To add sounds or music to an individual photo, select Properties from the
Photo menu. When the Photo Information dialog box appears, add sounds
or music with the or  button.

Assigning the Photo Properties

Besides adding sounds and music to a photo, you may enter text about the
photo, or assign a linking action for the photo in the Properties dialog box
invoked from the Photo menu.

In the Photo Information option, type in the content you want to specify
about the photo, such as the time you took the picture, the year, or any
other notes about the image.

In the Link section, you may define an action (such as a page that turns
when the photo is double clicked by the user). If the photo is double clicked
when the album is played back, it can be set to turn the page to the first,
last, next, previous, or a specific page. Enable the Link Page option and
select the page control button to define the action, or drag the slider at the
right to set the page number.
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1. Enter a name for the album in the Album Name text box.

2. Select a category that the album should belong to in the Album Category
pull-down list, or type in a new category name directly.

The default category for holding your album is My Album. You may
name a new category according to the content of your album.

3. In the Information text box, type in any information that will help
describe the album.

4. Click OK to save the album information.

Identifying the Album

After you have finished editing the album, you should name the album and
make a description about its content for identification. The Properties
dialog box contains several options for this purpose.

Saving the Album

After an album has been created or edited, it should be stored for later use.
Choose Save from the Album menu. The album is saved with its name and
category specified in the Album Information (Properties) dialog box.

If you have not specified a name and category for the album, or you want
to save the album with another name or category, you may choose the Save
As command in the Album menu. The Album Information dialog box will
be opened, and the album will be saved after you enter a name and click
OK.
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Specifying an Album as WallPaper

When you want to utilize an album page as the wallpaper for Windows
desktop background, open the Page menu and select the WallPaper
command. After you shut down or restart your computer, your original
wallpaper will be loaded back into the system.

Playing the Album

Select the View button from the opening screen to play an album. After you
select an album in the Select an Album dialog box, the playback screen will
appear.

If you have chosen the Deliver for Playback command from the Album
menu, you may run the .EXE file directly in the delivered folder to bring up
the playback program.

The Control Bar will be displayed when you move the mouse pointer to
the bottom of the screen. Click Preferences button or press Enter to open a
dialog box for setting the playback options.

The Page Control buttons can locate the page you want. If you press and
hold the left mouse button on the Previous Page or Next Page button for a
while, the page number field at the right will keep on counting until you
release the mouse button. Click the Play/Stop button to start or stop
playing the pages.

The Print button allows you to print the current page immediately, with
normal resolution. Clicking the Set WallPaper button sets the current page
as the Windows desktop background.
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The Quit button allows you to exit the playback program. When you place
the mouse pointer on a photo in the album page, if it changes to the shape
of a speaker, it means there is a wave file attached to the photo. Click the
right mouse button to play it. If the pointer changes to the shape of linking
rings, that means the photo is linked to a specific page. Click the left mouse
button to go to the specific page. If the pointer contains both the speaker
and the linking rings, you may click the left or right mouse button, as
desired.

The information for each photo will be displayed in a pop-up balloon if you
move the mouse pointer onto the photo.

1. In the opening screen, click on the View button.

2. When the Select an Album dialog box appears, locate the album you
want to play.

3. Click OK.

The album will be played back in a self-running slide show that will
combine all your images and audio.

Delivering the Album for Playback

After an album is edited completely, you may share the album with others
or deliver it by diskettes to playback with Presto! PhotoAlbumÕs playback
program on another computer.

1. Select the Deliver for Playback command from the Album menu.

2. When the Choose Directory dialog box appears, locate the directory to
which you want to send the album, or enter a new folder name to hold
all the files needed for playing back.

3. Click OK to proceed.

All the files needed for playing back will be sent to the location of the new
folder you specified. You may execute the .EXE file directly to playback the
album.
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Preferences Options

When you click the Preferences button or press the Enter key, the
Preferences dialog box will appear. This allows you to set up the playback
options.

Full Screen Display
This option can enlarge the display of the album page to the screen size.

Mute
Enabling this option disables two options in the Slide Show section: Enable
Background Music Playback and Enable Wave Files Playback. All sound
effects will be disabled while playing back the album.

Auto Play on Opening
If this option is enabled, the selected album will automatically be played
back the next time you open the playback program.

Display Tooltips for Buttons
This option turns on or off the display of on-screen tool tips for illustrating
the button functions.

Display Photo Annotation
This option turns the tooltips on or off.

Enable Background Music 
This option determines whether to play any background music assigned to
the album pages.

Enable photo audio
This option determines whether to play any wave file attached to the
photos.

Auto Replay
When this option is on, the playback program will continue to play from
the beginning, after reaching the last page.

Page Flipping Every
This option sets the interval between pages in seconds, while playing back
the album.

Save as Default
Click this button to save the current settings as the default settings. The
specified options will be loaded when you open the Preferences dialog box
again. If you have changed the settings and select OK, the altered settings
will take effect temporarily. The default settings will be in charge next time
you open the playback program.
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2. Enter the number of copies you want to print in the Copies text box.

3. Select the orientation of the page as portrait or landscape.

4. Set the top and left margins in the Set Margin section. You may print the
page horizontally or vertically in the middle of page. You can also change
the album measurements from the Unit pull down list.

5. To rescale the page while printing, select the Rescale tab to change the
settings.

6. Click the Fit In Page check box to rescale the page so that it fits on the
paper size. If you need to change the size of the paper, select the correct
size from the Paper Size list box.

7. You can set the scaling ratio by entering its size in the Target Image
section or by entering the X (horizontal ratio) and Y (vertical ratio) values
in the Rescale Factor section. You can also specify the scaling ratio by
dragging the slider between 10% and the maximum proportion
indicated.

8. Enter the horizontal and vertical printing resolutions in the Resolution
text boxes.

9. Click OK to print.

Printing the Pages

1. Choose Print from the Album menu. The Print dialog box appears.
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Selecting Printing Resolutions

When printing an album page, you can select three different levels of
printing resolutions: Normal, Medium and High. The resolution for
Normal printing is 640x480 pixels printed with album rings, or 600x400
pixels without rings. The printing resolution for Medium quality is
1200x800 without album rings, and the High quality resolution is 2400x1600.
To select the printing resolution:

1. Choose Print from the Album menu.

2. When the Print dialog box appears, click the Printer tab.

3. In the Quality section, select either Normal, Medium or High. Higher
printing qualities take longer to print.

4. If you have selected Normal resolution, you may decide whether to print
the album rings by Enabling or Disabling the Ring option.
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SmartFAX
SmartFAX enables you to set up phonebook and
download to the SF4500 Series machine. It also
allows you to control fax operations on SmartFAX
window.

4



4.2

Starting SmartFAX

Before using SmartFAX, you must install the SmartFAX program in your
computer. Refer to the SF4500 Series Setup and Operation UserÕs Guide.

In Windows 95

1. Start Windows.

2. Click the Start button on the taskbar, and select Programs from the Start
menu.

3. Select the SAMSUNG SF4500 Series SmartFAX on the Programs menu,
and select SmartFAX from the SAMSUNG SF4500 Series SmartFax
menu. The SmartFAX window appears.

In Windows 3.x

1. Start Windows.

2. From the Program Manager, double-click the SAMSUNG SF4500 Series
SmartFAX icon. The SAMSUNG SmartJet SmartFAX window appears.

3. Double-click the SmartFAX icon. The SmartFAX window appears.
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Understanding the SmartFAX Window

When you start SmartFAX, you see the screen shown below:

Closes the SmartFAX
window.

Phonebook keys

BOOK
Access Phonebook mode to
edit or delete numbers.

If you click here, the minimized SmartFAX
displays as a button (Windows 95) or icon
(Windows 3.x) on the Windows desktop. To
restore the minimized SmartFAX window, click
the left mouse button on the SmartFAX icon or
button.

Menu
Access Menu Mode.

MEM TX
Activates Memory Transmission.

COPY
Opens the Copy dialogue box.

REFRESH
Refreshes the SmartFAX screen, and
displays the current status of SmartFAX.

SEND/START
Activates Direct Transmission.

Receive mode
FAX, TEL, TEL/FAX, ANS/FAX

Resolution
STANDARD/FINE/SUPER FINE

Contrast
NORMAL/LIGHTER/DARKER

Document type
TEXT/PHOTO

Display
Shows information.

Number Keypad
Use to dial number, on
SmartFAX.
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Making a Copy

Your SmartFAX only supports Black & White copying. To make a copy in
color, please use ÔPresto CopierÕ under ÔPresto! PageManager.Õ To start Presto!
PageManager, select Programs from the Windows 95 Start menu.

1. Insert your document into the document tray, with the printed side
facing away from you, until it is gripped by the machine. You can insert
up to 30 pages at a time.

2. Start SmartFAX if not already started. The SmartFAX window will
appear.

Press to open the Copy
dialogue box.

Adjust this guide to
match the width of
the document.
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4. Click Start to begin copying. The machine scans the document into
memory, and copying will start.

3. Click the COPY button. The Copy dialogue box will appear. You change
any of these settings before beginning to copy.

To reduce the document,
specify the reduction rate
(25~200%).

Select the original document
mode.

If you want your copies to be
darker or lighter than the

original, select the desired
brightness.

Enter the number of copies 
(1-99).

¥ To cancel a copy in progress, click Cancel button.
¥ If you choose PHOTO mode in the SmartFAX window, or if you activate

the ÔDirect CopyÕ option on your SF4500 machine, the copy dialogue box
will not appear, and copying will start immediately after you click the
COPY button.
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Sending a Fax

1. Insert your document into the document tray, with the printed side
facing away from you, until it is gripped by the machine. You can insert
up to 30 pages at a time.

2. Start SmartFAX if not already started. The SmartFAX window will
appear.

3. Select the fax options, if necessary. The options may affect sending speed.

Resolution

Change to increase sharpness and clarity.

FINE is good for documents containing small characters or thin lines, or
print from a dot-matrix printer.

SUPER FINE works well for documents containing extremely fine detail.
SUPER FINE works only if you start sending using
SEND/START button and if the remote machine also has
the SUPER FINE feature.

Contrast

Change the contrast if you want the faxed document to be lighter or
darker than the original document.

Document Type

Select the document type: TEXT or PHOTO.

Resolution

Contrast

Document type

Adjust this guide to
match the width of
the document.
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4. Enter the phone number using the computer keyboard, the number
keypad in the SmartFAX window, or click the desired phonebook
number if you have already stored a number in phonebook memory. 
See page 4.9. The number appears in the display.
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Click the desired
phonebook number.

Click MEM TX to send after
scanning all documents
into memory.

Click SEND/START to send
immediately.

Display

Number
Keypad

If you make a mistake while entering a number, correct the number using
your computer keyboard.

5. If you want to send more than one page, click the MEM TX button. The
document will be scanned into memory and the machine will eject the
original, freeing the document tray.

Sending begins after the entire document is scanned into memory.

To send a document directly from the tray without scanning it into
memory, use SEND/START. Sending begins immediately.

If memory gets full while scanning documents, the memory full dialogue box
appears. If you select ÔContinueÕ the pages already scanned will be sent and
you should send the remaining pages in a separate operation. To cancel the
job, select ÔCancelÕ.
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Receiving Automatically in FAX mode

1. Make sure that FAX is selected in the SmartFAX window.

2. When you get a call, the machine answers the call after the number of
rings specified in the Ring Before Answer option (see page 4.13).

3. The machine begins receiving a fax.

Receiving Manually in TEL mode

You will want to set your SmartJet machine to receive a fax manually when
you want to personally check each incoming call to see if it is from a fax or
a person.

1. Make sure that TEL is selected in the SmartFAX window.

2. When the machine rings, pick up the handset and answer it.

3. If you hear a fax tone, or if the person on the other end asks you to
receive a fax, press Start/Enter, then hang up the phone.

Receiving a Fax

Selects the receiving mode.: 
FAX, TEL, TEL/FAX, ANS/FAX.

¥ If memory gets full while receiving a fax, reception is automatically
cancelled.

¥ You can change some receiving features, for example, ring count, automatic
reduction, and discard, using the SmartFAX program on your PC. See page
4.13.

¥ You can replace the cartridge while receiving a fax. The data will be
temporarily stored in the machine memory, and printed after you replace
the cartridge.
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Receiving Automatically in TEL/FAX mode

1. Make sure that TEL/FAX is selected in the SmartFAX window.

2. When you get a call, the machine answers the call on the second ring and
receives a fax signal automatically. You can change the number of rings.
See page 4.14.

3. If the machine does not sense a fax signal, your machine will give
another ringing tone to tell you it is a phone call.

4. Lift the handset to answer the call. If you do not pick up the handset
within a specified time, the machine will switch to automatic fax
reception mode.

Receiving Automatically in ANS/FAX mode

To Use this mode, you must attach an answering machine to the EXT jack
on your SF4500 Serise machine.

1. Make sure that ANS/FAX is selected in the SmartFAX window.

2. When you get a call, the answering machine answers its. If the caller
leaves a message, the answering machine stores stores the message
normally.

If your machine hears a fax tone on the line, the fax receive mode is
activated.
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Using Phonebook

On the SmartFAX, you can store up to 70 frequently used fax numbers in
the phonebook. The numbers are easily accessed by clicking the BOOK
button on SmartFAX.

Storing Numbers in and Deleting Numbers from
Phonebook

1. Start SmartFAX, if not already started. The SmartFAX window will
appear.

2. Click the BOOK button. The Phonebook dialogue box will appear.

Phonebook number keys

Closes the Phonebook
dialogue box.

Delete all information in
the selected phonebook
number.

The selected number will be
displayed in the SmartFAX
window. Use the number to
send a fax.

Store or edit the selected
phonebook number.You can get phonebook

numbers from the SF4500
Series machine.

Access Phonebook mode

Download the phonebook
numbers to the SF4500

Series machine.
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3. Select the desired phonebook number in the phonebook list and click the
Edit button. The Edit dialogue box will appear.

4. Click the Edit button. The Edit dialog box will appear.

5. Enter any name and number, and click OK to save the information you
just entered.

The name includes all capital letters, numbers, space, and special
symbols (,, ., /, +, ∗ , & , −, #)

6. Repeat steps 3 through 5 to store more numbers.

7. When you finish, click Close.

The one-touch dial phonebook keys in which fax numbers are stored
appear in blue on the SmartFAX window.



4.12

Sending Phonebook Numbers from SmartFAX to the
SF4500 Series Machine

After you store numbers in the SmartFAX phonebook, you can send the
numbers to your SF4500 Series machine. Press the Send Phone book button
in the Phone book dialogue box. All numbers in the SmartFAX phonebook
will be downloaded to your machine, and One-Touch Dial Numbers 1
through 20 will substitute for One-Touch Dial numbers on the machine, and
Speed Dial Numbers 1 through 50 will substitute for Speed Dial locations
01 through 50 on the machine.

Getting Phonebook Numbers from the SF4500 Series
Machine to SmartFAX

You can get the numbers currently stored in your SF4500 Series machine.
Press the Get Phone book button in the SmartFAX Phone book dialog box.
The numbers will be uploaded to SmartFAX, and the One-Touch Dial
numbers 1 through 20 will substitute for SmartFAX One-Touch Dial
Numbers 1 through 20, and the Speed Dial numbers 01 through 50 will
substitute for SmartFAX Speed Dial Numbers 1 through 70.

Using Phonebook Numbers

Click the desired One-Touch Dial phonebook key in SmartFAX or click
BOOK to access the Phone book dialog box and select the desird number..

The number stored appears in the display area on the SmartFAX window.
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Setting User Options

SmartFAX allows you to specify user-selectable features for faxing and
copying.

Selectable Options

Terminal ID
Your number and name. The terminal ID will be printed at the top of each
page faxed from your machine.

Receive Mode
You can select manual or automatic receiving mode. For automatic
receiving, select FAX, TEL/FAX, ANS/FAX. For manual receiving, select
TEL.

Paper Size
Select the paper size to use for printing a fax or copy. Select A4, Letter, or
Legal.

Print Quality
Select LQ to print a fax in low speed with high quality. If you select Draft,
the machine prints in high speed with low quality. To maintain the best
possible print quality in Draft mode, you need to align the cartridge from
the Control Program on your printer driver.

Discard Size
When receiving a document as long as or longer than the paper installed
in your machine, you can set the machine to discard any excess image at
the bottom of the page to fit into the recording paper size.

If the received page is outside the margin you set, it will be printed on
two sheets of paper at the actual size.

If the Auto Reduction feature is turned ON, it will be reduced to fit into
the appropriate size paper (Discard does not take place). If the Auto
Reduction feature is turned OFF or fails, the data within the margin will
be discarded.

Enter the desired discard size (0 to 30 mm).

ECM
This mode compensates for poor line quality and ensures accurate, error-
free transmission with any ECM-equipped facsimile machine. If line
quality is poor, transmission time may be increased when ECM is
enabled. 

To turn this feature on, select ON.
To turn this feature off, select OFF.
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Remote RCV Code
The remote receive MF code allows you to initiate fax receive from an
extension phone plugged into the EXT jack of your SF4500 Series
machine. If you pick up the extension phone and hear fax tones, enter the
remote receive code and the fax will start receiving. The password is
preset to      9      at factory.

Enter the desired code (0 to 9) on the number keypad.

Dial Mode
Select the type of dial mode: Tone or Pulse.

Ring Before Answer
Select the number of times your machine rings before answering an
incoming call. If you use an answering machine which is connected to the
Ext. Tel jack on your SmartJet, set this option less than the setting on the
answering machine.

Enter the desired ring number (from 1 to 7).

Auto Reduction
When receiving a document as long as or longer than the paper installed
in your machine, the machine can reduce the data in the document to fit
into your recording paper size

Turn on this feature if you want to reduce an incoming page that may
otherwise need to be divided into two pages with only a few centimeters
on the second page. If the fax machine cannot reduce the data to fit into
one page with the feature enabled, the data is divided and printed in
actual size on two or more sheets if needed.

Select On to turn this feature on.
Select Off to turn this feature off. The overflow data will be printed on a
second page.

The auto reduction feature does not apply to the copy mode.
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Setting Options

1. Start SmartFAX, if not already started. The SmartFAX window will
appear.

2. Click the MENU button, and select Settings from the menu. The Settings
dialogue box will appear.

If you click the Default button, all the settings
return to the factory default status.

3. Specify the options you need.

4. Click OK to save the information entered. 

When you change the settings on SmartFAX, or when you start the
SmartFAX, the user options setting on both the SF4500 Series machine and
the SmartFAX program will be updated to the latest settings you have made
either on the machine or on SmartFAX.
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Printing Out Lists

SmartFAX allows you to check lists containing useful information and print
them, if needed. The following lists are available:

TX (Transmission) or RX (Reception) Journal
This report shows information concerning transmission or reception
activities.

Phone Number
This list shows all the numbers currently stored in the Phone book
memory.

Settings
This list shows the status of the user-selectable options.

To monitor and print a list:

1. Start SmartFAX, if not already started. The SmartFAX window will
appear.

2. Click MENU, and select List Out from the menu. The List Out dialogue
box will appear.

3. Select the desired list, and click OK.

4. The selected list dialogue box will appear. Click the Print button.
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Changing the SmartFAX RCP Port

If you install the SmartFAX Remote Control Program, SmartFAX is installed
on LPT1. To change the port, do the following:

In Windows 95

1. Start Windows.

2. Click Start on the taskbar, and
select the Programs from the Start
menu.

3. Select SAMSUNG SF4500 Series
SmartFAX on the Programs menu,
and select Change Fax Port from
the SAMSUNG SF4500 Series
SmartFAX menu. The Change Fax
Port window appears.

4.  Select the desired port, and 
click OK.

In Windows 3.x

1. Start Windows.

2. From the Program Manager, double-click the SAMSUNG SF4500 Series
SmartFAX icon. The SAMSUNG SmartJet SF4500 Series window appears.

3. Double-click the Change Fax Port icon. The Change Fax Port window
appears.

4.  Select the desired port, and click OK.


